


XACTLY 366 DAYS AGO, while celebrating
Digit’s third anniversary, I hazarded to write
in this column about how India is on the
verge of that crucial inflexion point where
we could take off into the next era of
technology innovation and progress. At that
point in time, to be honest, we could have
gone either way.

I am happy to report that we have indeed
broken the sound barrier, and are now
zooming ahead into a new dimension, so to
speak. Technology is fast being accepted as an
integral part of our lives—both personal and
professional—more than ever before.

Over the last four years, with each issue of
Digit, the team here bet on how technology
will change our lives; on how it will help us
communicate better, utilise limited resources
better, and even cut transaction costs to an
affordable level.

We believe that, in our very small way, we
helped India reach a stage where its citizens (or
at least a certain section) are no longer
technologically challenged. We are a nation of
technology- and knowledge-hungry people,
waiting to burst into the international scene.
Digit recognises that, and this philosophy is
reflected in each article we write, each product
we review, and each column we opine in.

The sceptics would say that India is still an
elephant, and that it cannot dance. That India
is a nation of poor people, with little or
insignificant demand for technology, despite

its billion-plus population. This may be true to
a certain extent. No one can deny that more
than half our population is poor, and can
barely afford two meals a day.

However, if any one aspect of life can take
them towards self-reliance, and later
prosperity, it is technology. NIIT’s Hole-in-the-
Wall innovation, ITC’s ambitious e-Chaupal
project, and HP’s Project Muskaan, are all
examples of how our lives can be enriched by
leveraging technology to generate employment,
and create educational opportunities.

As Digit enters its fifth year, we reinforce
our belief that technology adaptation is here to
stay and to accelerate.  The coming year would
see greater emphasis on Digit’s part to break
new ground in technology communication. We
have always innovated for our readers, and this
year would no different. It is no coincidence
that the year of India’s technological inflexion
point was also the year Digit saw the most
growth in readership and mass acceptance. 

We are proud and privileged to be a small
part of The Great Indian Technology Journey,
together with you.

Publisher’s
Note

The Great Indian Tech Journey
Maulik Jasubhai Publisher
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“YAHAN PAR HAMARI kahani offbeat ho jaati hai,” said
Rajesh Khanna to budding director Asrani while
describing a melodramatic movie story in the ever-
green comedy Bawarchi. It loosely translates into:
“Here is where we have a twist in the tale.”

Any discussion on broadband penetration in
India reminds one of this dialogue. Was Rajesh
Khanna prescient? 

Consider the evidence. First, we had the joke
played upon consumers by Internet service providers
by categorising 128 Kbps speeds as “lightning speed
broadband”. The government finally put paid to
these claims by defining broadband as “minimum
256 Kbps of download speed”. Then, the same ISPs
began defining their rate cards based on per MB of
download, and priced 1 MB at Rs 1.50 if you ever
dared to go beyond the specified limit. What they
conveniently hide from customers is that they will
charge fees based on data transfer—so technically,
both uploads and downloads will be charged. Be that
as it may, consumers in India still welcomed the
“broadband revolution”.

But it is at this juncture that the story turns off-
beat. The success of broadband in India does not
depend on the government opening up bandwidth.
Nor does it depend upon the investments and mar-
keting campaigns by Internet Service Providers. And
it certainly does not depend upon consumers (those
measly, low-life scum). 

It all depends, ladies and gentlemen, on your local
cable operator. Only if the mighty Multi-System Oper-
ator (or MSO; an MSO is a super cable operator like
InCable, or Hathway) deems fit, will you get a broad-
band connection. This is because the MSO itself has an
interest in the lucrative broadband business.

Here is how it works: Most broadband Internet con-
nections are given using the cables already laid by the
cable operator. The cable operator cannot provide any
broadband connection if the ISP does not have a
signed agreement with the MSO. So, suppose your
MSO has no infrastructure to provide you a broadband
connection, but intends to give it in, say, six months’
time, we wish you the very best of luck. He will not
allow any other ISP to use his cables to give you a
broadband connection. For instance, if you stay in an
InCable “territory”, and you want a Hathway, Sify, or

an Iqara connection, you will have to wait until InCa-
ble builds its own broadband infrastructure. 

The options are to a) wait; or b) work with your
56 Kbps modem.

Evidently, the trouble with technology penetra-
tion in India is not that people don’t want to spend—
it is that there are too many hurdles to spend that
money. The sooner the authorities realise this, the
faster we can progress. And yes, we sure don’t need
another twist in the tale, do we?

Broadband, Narrow Minds

Editorial

“Only if the mighty MSO
deems fit, will you get a
broadband connection. ”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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22 
Bharat
Dabholkar
talks about
what tech
means to him

22
Apple’s Tiger
has serious
issues

28
Samsung and
MS will partner
on next Xbox

30
Are the DVD
format wars
finally going to
come to an end?

Contents Magazine

50 Hello, Convergence!
In this special issue, we look at convergence
from every possible angle. We’ve got a
battery of guest columnists lined up, and
we also present Digit’s take on convergence

Hello, Convergence! Guest Columns

80 Whither Mankind?
Will we converge with
machines at some point in
our future? Is it inevitable? 

91 Applied Convergence
‘Convergence’ is not a hyped
word—far from it. We take a
look at practical applications

96 Secure Your Home Now!
Home security is big, and
poised to become bigger. A
look at the gadgets that are
helping secure our homes

105 The Top Five 
Wired Nations
A look at the most-wired,
most tech-savvy countries
on the face of the earth

58 One World, One Home
The first place you interact
with converged devices could
be your home. So what will
your home look like?

68 The Ultimate
Converged Accessories
Calling all geeks! Convergence
promises to deliver the stuff
that geek dreams are made of 

72 Crash Landing
We take a look at products that
were driven by convergence
but weren’t well-received by
the world

75 The Name Is Connected.
Dr Connected
The gadgets in James Bond
movies exemplify convergence.
Here’s a sampler 

64 Of Bits, Atoms, And
Softwear
Nicholas Negroponte on the bit
switch and wearable computers

94 Convergence Is Not
Congruence
Anil K Gupta on convergence
in the Indian context

99 Technologies On 
The Verge...
Punya Mishra on three types
of convergence  

107 The Inevitability Of
Technology-Led
Transformation
Ganesh Natarajan on change

86 Human-Machine
Convergence
Kevin Warwick on the need to
converge with machines 
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Test Centre

June 2005

38 Let There Be Space!
External hard drives are the gadgets of
choice for frequent backups. A comprehen-
sive shootout, ranging from tiny pocket
drives to the seriously capacious ones

161 Tips And Tricks
Included here are several software we use
on a daily basis: the Microsoft Office suite,
Dreamweaver, Publisher, and FrontPage.
We also tell you how to do home videos,
and create your own RSS feed!

170 Q&A
Your questions answered. There’s also
the usual ‘How To’ section, this time on
cataloguing your burnt CDs and DVDs
using XBaseCatalog

175 Agent 001
It’s the height of
summer, and Agent
001’s quest this
month is to find the
perfect cooling
solution for his rig.

He also answers a
few burning
questions...

34 New and Notable 
Some of the best products to have entered
the market—most notably the Apple 30-inch
cinema HD display, the HCL Beanstalk Neo
Media Centre PC, and the Treo 650

The Digital World

Escape

179
Dr Niklaus
Wirth created
the Pascal
family of
languages 

180
So, did Al Gore
actually invent
the Internet like
he claimed he
did? Well, he’s
got a lifetime
achievement
award for his
contributions,
anyway

137 Adding Effects To
Your Home Videos
So you thought only the pros
could make professional-
looking videos? Here’s how to
add effects and make your
home-shot videos look pro

133 Wall-Mounting
An LCD Panel
For those of you lucky
enough to own an
LCD panel, here’s how
to mount it

141 Back Up Using A
Portable Drive
Portable hard drives are ideal
for backups. We tell you how
to use these nifty devices to
always keep a backup of your
precious data

129 Print Photos
Using Your
Inkjet MFD
Your home inkjet MFD
can, of course, be put to
a variety of uses—photo
printing included

114 Remote Control
Your PC
Applications
Using your TV tuner
card’s remote, you can
control many PC
applications wirelessly

145 Understanding
Manual Camera
Configurations
Get to know about the
manual settings on your
camera to get the most
out of it
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on www.
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Digit Reader Poll

This Month’s Question

How much of a
difference do you think
convergence will make in
your daily lives?

None
Make life easier
Make life harder
Revolutionise it
Don’t care

Log on to www.thinkdigit.com
and vote

taste technology at www.thinkdigit.com

June 2005

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

How much spam mail do you receive in a
month?

None

Less than 10

11 - 50

51 - 100

101 - 200

Above 200
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■ AutoRuns 7.01
■ Autostart and Process Viewer 1.1
■ BySoft Network Monitor 1.2
■ Central Brain Identifier 7.5.0.0 Build 0409 R1
■ Clipboard Recorder 2.1.1
■ clone maxx 1.0
■ CPUMon 1.30
■ Delete Doctor 2.1
■ Desktop UI Renamer 1.0
■ FastSum 1.9
■ Folder Size Explorer Extension
■ Foxy SQL Free 1.0
■ Fresh UI 7.33
■ Game XP 1.5.2.2
■ GCPUID 1.9.0133
■ Google Desktop Search 1.0 final

■ HDDlife 2.0.50
■ Headline Viewer 0.9.9
■ IBM - Hitachi Drive Fitness Test 4.02
■ Intel Chipset Software Installation Utility

6.3.0.1008
■ IrfanView 3.97 ALL plugins
■ Kerio Personal Firewall 4.2.0 Build 664

Beta 6
■ LanSpy 2.0.0.155
■ MemSpy 3.6
■ Microsoft USB Flash Drive Manager

(Standard)
■ MountVD 4.0.30
■ MSConfig Cleanup 1.1
■ MyBackup 1.01
■ NetStumbler 0.4.0
■ Partition saving 2.90
■ Power Defragmenter 1.82
■ ProcessTamer 2.00.15 beta
■ Renamer 1.4
■ SC-DiskInfo 1.11
■ Skype 1.2.0.48
■ SmartFTP 1.1.985
■ SpeedFan 4.23
■ SplitFile 1.2
■ Spybot - Search & Destroy 1.3
■ SpywareBlaster 3.3
■ System Spec 1.18
■ TaskSwitchXP 2.05
■ TitleFix 1.0
■ Tweak FX 8.0 Beta
■ TypeAndRun 4.6.1
■ Unstoppable Copier 1.9
■ Urfin 1.2 beta
■ Yahoo! Desktop Search 1.1 beta

■ 11view 2.6
■ AC3Filter 1.01a RC5
■ ac3fix 0.3

■ ACE Mega CoDecS Pack 6.03
■ Anvil Studio 2004.10.01
■ AOL Media Player Beta 3
■ Ashampoo Media Player 2.03

■ AVdrum 0.2
■ AVI Preview 0.26 alpha
■ Avi2Dvd 0.2.4 beta
■ AVIcodec 1.2 b108
■ Batch AutoCorrector 0.8
■ cam2pc - Freeware 4.5.4
■ Canopus DV File Converter 1.1
■ DivXRepair 1.0.1
■ Easydivx 0.8.2.0
■ Evil Player 1.00
■ FastStone Photo Resizer 1.4
■ FastStone Screen Capture 1.5
■ FirePaint 2005 1
■ FLAC for Windows 1.1.1a
■ Fmod 3.74
■ foobar2000 0.8.3
■ GDS Screen Capture 1.0
■ GrabCaptureScreen 2.0.5.3
■ Guitar and Drum Trainer 2.0
■ Juke 3.8.6
■ KaraFun 0.80
■ LameXP 1.01
■ MPEG2Schnitt 0.6l-b
■ Photo Sorter 3.0.0
■ QuickPlayer 1.00 beta 36
■ Riva FLV Encoder 1.20
■ Screenshot Pilot 1.40
■ Scrolling LED Bitmap Generator 3.1.0
■ SimplyCapture 1.0
■ Sonique 2.0 Beta 1.03
■ Turbine Video Encoder 1.0
■ VSO DivXtoDVD Converter 0.5.2
■ xraster 0.9
■ Winamp Full 5.08

■ AbiWord 2.2.7
■ Aethera 1.2.0
■ AMaViS Virus Scanner 0.3.12
■ aMule 2.0.0-rc8
■ Analog 5.24
■ Apache HTTP Server for Linux 1.3.33
■ Apollo 1.4.2
■ Axel 1.0a
■ Bluefish 0.11
■ BWMon 0.9.1
■ Cajun 4.0
■ CaMail Modular Webmail 0.21
■ CDRecord (cdrtools) 2.0
■ Ethereal 0.10.0
■ Ezail 0.1.2
■ Galeon 1.2.11
■ glFTPd 1.26 Beta 2
■ GMailWatch 1.2
■ Gnome Toaster 1.0 Beta 6

■ gShield 2.7.1
■ GuardDog 2.0.0
■ IAn Webmail 1.0
■ KBear 2.0
■ KDE Multimedia 3.1.4
■ Kino 0.7.0
■ kmail 1.0.29.2
■ Lynx 2.8.3
■ Mozilla 1.8b1
■ Mozilla Thunderbird 1.0.2

■ mpg123 0.59s
■ MPlayer 1.0 pre 7
■ Pine 4.62
■ Pure FTP server 1.0.7
■ rsync 2.5.0
■ Scintilla 1.62
■ Sylpheed 1.9.6
■ The Circle 0.16
■ W3Perl 2.8.8
■ WU-FTPD 2.6.2
■ X MPEG Player System 2.0
■ X-CD-Roast 0.98 Alpha 15
■ XChat 2.0.2

■ 200+ wallpapers

■ Animal Fun 
■ Bird Hunter
■ Bombermania

■ GeneRally
■ Hangman
■ Helicopter Escape
■ Hot Air 2
■ Infection
■ J-Ball
■ Jetz Fusion
■ Jetz Rampage 2
■ Jumper + Level Editor
■ Jumper Two
■ Liquisity
■ Martyrdom Dungeon
■ Mummy's Curse
■ Nikki the Ninja
■ Onslaught
■ Ore No Ryomi 2
■ Pac-Manic Worlds 3D
■ Penguin Panic
■ Ping - The Sequel to Pong
■ Prisms of Light 2
■ Shooter 4.0
■ Sketch
■ Sky Fire
■ Spid the Spider
■ Squarez
■ Star Ball
■ Tank Assault
■ Dungeon

18 DIGIT MAY 2005 NNoottee  11:: Grey areas show content available on the CD. The DVD also contains all that is on the CD
NNoottee  22::  If you do not want to boot from the CD, remove it from the drive at startup
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Bharat Dabholkar
Film Actor And Director

Alawyer, advertising
professional, actor, fitness

enthusiast and now a film
director—Bharat Dabholkar’s
roles in real life are as
interesting and varied as those
in reel life. Here’s his take on
technology.

What does technology
mean to you?

I think technology is
essential to make life
easier. The new tools
are giving a new
perspective to life.

What role does
technology play in

your life?
I read about all the latest
developments in the market. 

How often do you surf
the Net?
Everyday—I check my mails
regularly, and get my daily dose
of technology updates by
reading online.

What gadgets do you own?
I do not own anything beyond
my cell phone and Tablet PC.

What do you feel about
convergence of devices?
Convergence is very futuristic,
but is beneficial to the
consumer. However, people
usually end up buying things
impulsively, and later realise
that they do not use these hi-
tech products.

You have been a lawyer, actor,
and advertising professional.
Where has technology has
evolved the most?
The entertainment industry has
been the largest beneficiary.
Today, it is possible to make and
transfer films digitally, saving
huge amounts of money.
Besides, it also reaches a wider
audience. Technology can also
help improve the quality of films
and help curb piracy.

New Windows For Fake 
Microsoft is offering Americans compensation if they bought
a dodgy copy of Windows in exchange for information on its
source. The compensation will be in the form of a handy
little product activation key by e-mail, followed by a nice
new legit copy of Windows XP in the post.

Hacking Ported 
Developers have figured how to extract files from the
Universal Media Discs used in Sony’s PlayStation Portable,
though there is no way to play the extracted games. Movie
studios will release some of their films on the UMD format,
but it’s not clear if the technique would work for films. 

The Tiger is on the prowl
and everyone raving
about its new features

and considering the initial
sales figures it may surpass
the Panther’s first quarter
sales figure very soon. 

But is everything sunny
in Tiger land? Bugs and
errors are being reported
daily, and the present
trickle could turn into a
torrent if Apple and their
associates don’t take
remedial measures. 

Programmers have
detected a security hole in
Dashboard, a suite of
programs called widgets
that often access
information on the
Internet, which could
expose users of Tiger to
attack, and may put
personal information like
passwords and credit
card data at risk. 

Tiger comes
preloaded with 14
widgets, including a
world clock, a
dictionary and a
weather station. For
the convenience of
users, most widgets
automatically install
themselves. Experts
fear that any program
that auto-installs is
ripe for exploitation. 

A growing number
of Mac experts are
sounding the alarm
over the dangers of
widgets—which can
carry Unix commands
that could be run
invisibly from within.

A few of the other widely
reported flaws are SMB file
sharing and authentication
problems with Microsoft’s
Active Directory. Although
Apple’s Tiger increases
support for Server Message
Block file sharing and Active
Directory, several sources say
that the Finder fails to log
on to Windows and Linux
Samba file servers. 

Some installations are
also finding that Windows
workstations can’t log on to
the Mac after upgrading to
Mac OS X 10.4. 

Another niggling
problem is a compatibility
issue with enterprise
software. Adobe said
Acrobat 7 has a problem
with QuickTime 7, which
ships with Tiger. 

“We are aware of an
issue that prevents the
playback of QuickTime
content embedded in PDF
files when using QuickTime
7 Player on all supported
versions of Mac OS X,” said
an Adobe representative.
Adobe said that it would
issue a fix in an upcoming
maintenance release, but
did not say when. 

Five of Symantec’s Mac
products are incompatible
with Tiger, but the company
said there was nothing
unusual about the Tiger
release due to the nature of
Symantec’s utility software. 

Tiger also has caused
some incompatibility with
driver-level software related
to hardware. The Radeon
X800 XT graphics card from
ATI Technologies has ROM

software that
is incompatible
with Tiger. 

The ROM software
can cause a kernel
panic, a type of crash
when the Mac screen
is covered with lines
of code.

Users can also see
kernel panics when
upgrading to Tiger with
Maxtor FireWire and USB
hard drives connected to
the Mac. Maxtor, in fact,
recommends that users
disconnect Maxtor external
drives before running
Apple’s Tiger installer. 

The company, though,
said it could not predict
when a fix for these holes

could be available. 

Enter
IS THE TIGER LIMPING?

Security Holes And Compatibility
Issues Could Plague Tiger
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WELL DONE, DELL!

Dell
Integrates
Windows
x64  

Dell will factory-install
Microsoft’s Windows

XP Professional x64
Edition and Windows
Server 2003 x64 editions
operating systems across
Dell Precision workstation
and PowerEdge server
lines. It has also reinforced
available professional
services that support faster
migration of the enhanced
features available in the
x64-bit operating systems.

“Dell hardware has
been 64-bit ready since
June 2004, and we have
worked extensively with
Intel, Microsoft and
applications vendor
partners to drive
development of standards-
based solutions,” said Jeff
Clarke, senior vice
president, Product Group,
Dell. “Dell is committed to
helping customers migrate
from costly, proprietary
platforms to cost-effective,
and standards-based
environments.

This is the same
strategy that has delivered
Dell workstation
customers up to 10 times
the performance at a tenth
of the cost.”

Dell PowerEdge servers
with integrated Windows
Server 2003 x64 Editions
will be available in June. 

YAHOO! GOES VIDEO 

Yahoo’s
Video Search
Is Out Of The
Beta Phase 

Yahoo! Inc. has shifted
its online video search

tool out of its test phase,
marking another step in
the Internet powerhouse’s
plan to use other media to
lure more visitors to its
Web site. The Sunnyvale-
based company created a
separate search channel
for online videos in
December. The product
had been running as a test
till recently. 

As part of the upgrade,
Yahoo! is indexing more
video from several new
media sources, including
MTV and The Discovery
Channel. Yahoo! touts its
search engine as the
Internet’s most
comprehensive source for
finding online video,
although the company won’t
disclose the index’s size. 

The push into online
video has been driven
largely by the growing
number of homes with high-
speed Internet connections,
said Bradley Horowitz,
Yahoo’s director of media
and desktop search. The
speedier connections make
it easier to watch video
online without the delays
and choppy delivery
commonly experienced on
dial-up connections.

Video clips available at

video.search.yahoo.com
include movie previews,
excerpts from previously
broadcast TV shows as well
as original content. Yahoo!
is counting on video
search to give it an
advantage over Google Inc.
Google processes about 47
percent of online searches
in the US, leaving Yahoo! a
distant second with 21
percent of the market,
according to Nielsen/
NetRatings.

“We want to be the place
to go whenever people are
trying to find online video,”
Horowitz said.

Google is testing an
online video guide that
relies on an index of
closed-caption text from
previously aired TV
programmes, and recently
began to encourage visitors
to submit personal videos
so they can be indexed.

Khyati Sanghvi, Gujarat
Gulshan Shetty, Mumbai 

Opera 8 
The latest
avatar of this
browser doesn’t
disappoint. It

has all the customisable
features and tweaks to keep
the advanced user happy,
while the neat interface
should suffice for all the
needs of the basic user.

Netscape 8 Beta 
Netscape 8,
though in beta
stage, comes with
a very crisp and
sharp-looking interface. This,
however, doesn’t translate into
excellent features. It’s based
on Firefox, and yet is bulkier,
and lacks features and
customisation options.

How about the ‘Bear’?
Maybe ‘Monster’?

Neel Parikh, Mumbai 

Satish Mudaliar, Mumbai ‘Leopard’ sounds good and will keep

it within the family! 

Subhanshu Gupta, Navi Mumbai 

Security Watch

GGooooggkkllee..ccoomm
The Problem
In April, a warning was issued
by Finnish anti-virus vendor F-
Secure Corp. about a
problematic site, googkle.com.
One can reach this site by
misspelling ‘google.com’—and
typing in ‘googkle.com’—in the
title bar of a Web browser.

The Damages
When googkle.com is opened in
a browser, two pop-up windows
are immediately launched, with
redirects to third-party sites
loaded with scripts. One of the
sites, ntsearch.com, downloads
and runs a ‘pop.chm’ file, and
the other, toolbarpartner.com,
downloads and runs a
‘ddfs.chm’ file, F-Secure said.
“Both files are downloaded
using exploits and they contain
exploits themselves to run
embedded executable files. One
of the Web pages of the
‘toolbarpartner.com’ website
downloads a file named
‘pic10.jpg’ using an exploit. This
JPG file is an executable that
replaces Windows Media
Player,” the warning reads.
Also launched are a steady
stream of pop-up Web pages
with different .exe files. One
batch of exploits loads a
malware package that includes
two backdoors, two Trojan
droppers, a proxy Trojan, a
spying Trojan and a Trojan
downloader.

Precautions
It’s mostly users of IE that
seem to be affected. Windows
XP users who have installed
SP2 are also safe. However, to
be on the safe side, just don’t
misspell ‘google’!

One Silly Question

I think ‘Lion’ is perfect.

Mac’s fourth OS was called Panther, fifth is Tiger, what should the sixth be?

‘Cheetah’-because it’s the fastest!

4 Years Of Tech
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Files, Freebies, Answers

SSOOFFTTPPEEDDIIAA
A deft download site with scores of free
software. The site claims to be the
encyclopedia of free software
categories such as Science and CAD to
the usual games, system, media
routine. The neatly arranged interface
is user-friendly with no download more
than a couple of clicks away. The site
also has links to the latest news from
the software and media world. 

DDLLLL--ffiilleess..ccoomm
What do you do when a program fails
to load because of a missing .dll file?
Go to www.dll-files.com. This site is
your one-stop shop for such problems
with over 400 common .dll files
available for free download. So the
next time your PC shows a “.dll file
missing” message, don’t wring your
hands in despair.

AAnnsswweerrss..ccoomm
If you have the questions, these guys
will give you the answers. That’s right.
Detailed answers culled from over a
hundred online encyclopedias and not
just links to those answers.
www.answers.com has a search engine-
like interface and throws up very
comprehensive results for your queries.

www.dll-files.com

www.answers.com

www.softpedia.com

TALK THE TALK

Cisco And
IBM To
Launch
Speech-
Enabled
Solutions

IBM and Cisco plan to
deliver to contact centres

speech-enabled self-service
solutions that combine
IBM’s WebSphere Voice
Server product and Cisco’s
Customer Voice Portal.

The solutions would
combine IBM’s integration
and application
infrastructure software
and speech technology
with Cisco’s Internet
Protocol (IP) communi-
cations and focus on self-
service speech
applications, which
together can enable easier
deployment of customised
speech applications that
enhance the customer
experience.

The IBM/Cisco offerings
will be designed to let
businesses extend
enterprise-class speech self-
service to remote locations
across both IP and non-IP
networks—including local
and branch offices. When

banking customers
make after-hours calls
to their local branch,
they won’t be limited
to voicemail, or be
asked to call another
phone number. The
Cisco and IBM
solutions can allow
customers to use
speech to interact with
centralised automated
applications that reflect
up-to-date transactions
and past history.

A Round-up Of Technology News From Across The GlobeThe Digital World
UNITED STATES

Three Incredibly Useful Sites

Border agents using gamma-imaging technology on an
incoming freight train apprehended two men trying to
enter the US illegally from Canada. Nilson Giusti, 41,
and Agiles Bezerra, 23, were found in two separate
cars on the Black Rock Rail Bridge May 14. Inspectors
use gamma radiation technology to scan rail cars,
trucks and cargo containers for people, weapons and
other contraband.

RUSSIA

Russian oligarchs are turning their attention to the
high-technology sector. As indicators, Russian
software exports will top $1 billion this year; SRISA, a
pilot IC sub-micron production facility, has put 0.21-
micron processing into experimental production; and
the two leading Russian chipmakers, Angstrem and
Mikron, are expanding their production capacity.

BANGLADESH

A new computer game
brought out by Sony and
developed by Zipper
Interactive, which portrays
Bangladesh as a terrorist
state, has led to widespread
resentment in the country.
The mission of the game is
to "protect America from
enemy forces … throughout
the world," and the main
locales for the game are
said to be Morocco, Poland
and Bangladesh.

UNITED KINGDOM

Four British members of the global 'DrinkorDie
network', an underground software piracy ring, were
sentenced May 6 at London's Central Criminal Court.
The men had formed part of a gang that communicated
across continents via a sophisticated online network,
which was also used to distribute pirated copies of
software packages.

SWEDEN

People who use
mobile phones in
rural areas are three
times more likely
than city dwellers to
suffer from brain
tumours, a study
has found. Professor
Lennart Hardell, a
cancer specialist at
the University
Hospital of Orebro in
Sweden, said the
results definitely
point to a link
between the dose of
microwave radiation
and the risk of
developing brain
tumours.

AUSTRALIA

The country should beef up competition in the telco
market or risk falling behind the world, an
international telco expert has said. Ewan Sutherland,
head of the international telecommunications users
group, said Australia ranks poorly among other OECD
(Organisation for Economic Cooperation and
Development) countries in terms of technology,
particularly broadband Internet services.
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OPPOSITES ATTRACT

Samsung,
Microsoft
Join Hands
On Next-Gen
Xbox 

Samsung Electronics and
Microsoft have allied to

elevate gaming to the next
level through high-
definition (HD) technology.
Microsoft has chosen

Samsung as the exclusive
High Definition Television
(HDTV) worldwide
marketing partner for the
next-generation Xbox HD
gaming platform.

The next-generation
Xbox and Samsung HDTV
combination is designed to
deliver the most advanced
and realistic high-definition
experience to gamers
worldwide. To promote the
HD Era, the companies plan
to place over 25,000 Samsung
HDTVs in Microsoft Xbox
retail kiosk locations across
the globe.

The new 23-inch
Samsung LCD TV

(LNR238W) to be
paired at retail with
the new Xbox
console offers a 12-

millisecond pixel
switching speed,
which will enable
intense action while
overcoming any
motion artefacts. In
addition, the Fixed
Pixel Device eliminates
scan lines, further
ensuring the game
play is smooth and
flicker-free. Picture
quality combines
with advanced audio

technology to create the
perfect gaming experience.
To leverage this Samsung’s
HDTV inbuilt speakers
would emulate the most
realistic surround sound
using SRS Tru-surround XT, 
so the action feels
even closer.

WORLD CUP VIRUS

Virus
Spreads By
Promising
Free Tickets 

Abilingual computer
virus spreading through

fake e-mails crashed the
computers of the World
Cup organising committee,
overloading the system
with millions of e-mails. 

The virus is contained in
attachments coming from
senders with addresses such
as ticket@fifa.de or
gewinn@fifa.de, telling fans
they have won tickets to
next year’s tournament.
Organisers were still unable
to send e-mails, spokesman
Gerd Graus said. 

Like earlier versions of
the ‘Sober’ worm, the virus
can travel in both English
and German-language e-
mails as a malicious
attached file. The worm
can use a variety of
different subject lines and
message bodies, said
Graham Cluley, senior
technology consultant for
London’s Sophos computer
security firm. 

If a user opens the
attached file, they’ll get
infected, and the worm
will mass-mail itself to
other e-mail addresses
found on the infected
computer. “Many people
will be eager to attend one
of the biggest sporting
events in the world next
year, and may think it is
worth the risk of opening
the e-mail attachment just
in case the prize is for
real,” Cluley said. 

Fans who got tickets
got an immediate e-mail
confirmation, without an
attachment. Organisers
already have foiled a
fraudulent attempt to
place more than two
million orders for World
Cup tickets from the
United States.

Photograph Jiten Gandhi

Last Month’s Winner!
Dr Vikas Malhotra 

“Kabad-E-walla.com”

Send your captions to
beatthat@thinkdigit.com
and win the 
Family UtilityCD 
from Numeric 
Power Systems Ltd

Every month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game!

Digit Caption
“No, sorry I don’t make
house calls!”
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FLOATING CLASSROOMS

XIMB
Launches PG
Course On A
Virtual
Platform 

Come July and 150
students enrolled into

the PCPBM programme
offered by the Xavier’s
Institute Of Management,
Bhubaneswar, will log into
the Reliance WebWorlds
closest to their homes for
their lecture. Part of a new
e-learning initiative, this
virtual classroom platform
will offer a real-time multi-
way audio and visual
presence of the professor
and the students. 

This one-year
programme will be divided
into three trimesters and
have 300 contact hours. Of
these, 240 would be via the
virtual classroom format
and 60 on campus with
direct classroom contact.
“This is the first time that
such a programme has been
taken via video-
conferencing to the entire
country,” said E Abraham,
Director, XIMB.

Reliance Infocomm
would be providing the
latest in broadband and
video-conferencing
technology with a dedicated
768 kbps line to enable video
communication in real-time.
This high bandwidth would
allow students to make
presentations, refer to
course materials online, and
interact with the professor
simultaneously. An added
feature would 
be the recording of 
every lecture. 

This database of
lectures would therefore be
useful for students for
future reference. “This sort
of technology provides
both the students and the
professors with a large
amount of flexibility,” says
Sarup Chowdhury, CEO,
Reliance WebWorld. “A
student will not miss a
class just because he is
another city. All he has to
do is patch in from the city
that he is in.” 

Currently targeted at
executive level students, the
total cost of the course is Rs
1.8 lakh. This programme
will be followed by another
in Rural Management,
which will employ the same
virtual classroom platform
and commence in Oct 2005.  

NEW AND IMPROVED

Autodesk
Combustion
4 Launched 

The Autodesk Media and
Entertainment Division

(earlier called Discreet) of
Autodesk Inc, a leading
design and digital media
creation, management, and
distribution company,
launched the Autodesk
Combustion 4 software, the
upgrade to its visual effects
desktop software solution.  

With Combustion 4,
artists will have access to
3D compositing,
comprehensive motion
graphics capabilities,
numerous filter and
particle effects, advanced
colour correction, tracking
and image stabilisation
technology, powerful
vector paint, warping and
morphing, text effects,
simple editing, advanced

animation and
expressions, Flash
output and more,
all from the
specially designed,
unified and easy-to-
use interface.

Version 4 also
provides enhanced
interoperability with
most 3D animation
products including
Discreet’s 3ds Max,
cleaner encoding
software, and its
systems products such
as Flint, Flame, Inferno,
Fire and Smoke.

Autodesk Combus-
tion 4 will sell for US
$995 (Rs 42,700
approx); an upgrade
from Combustion 3 to
Combustion 4 will cost
US$ 249 (Rs 11,000
approximately).

UNITY IS STRENGTH

Sony And
Toshiba
Want To End
Format War 

Japanese technology giants
Sony and Toshiba are

working towards an
agreement to develop a new
unified standard 
for next-generation 
DVDs, after battling three
years for separate 
rival standards.

Sony and Matsushita
Electric Industrial
introduced the Blu-Ray
standard in February 2002
and Toshiba and NEC
followed with the HD DVD
standard. Both camps were
also courting a number of
Hollywood studios for
support of their format.
However reports suggest

that the two camps are
working towards reaching
an agreement on their joint
development.

Nihon Keizai Shimbun, 
a Japanese daily, popularly
known as Nikkei, said Sony
and Toshiba stepped up
closed-door negotiations in
February to find a
resolution to their standoff.
After reaching a basic
agreement that a unified
standard would be
desirable, they were now
looking to develop a hybrid
standard that took
advantage of each
standard’s strengths, the
newspaper said.

Sony and Toshiba had
begun briefing Walt
Disney and AOL Time
Warner, as well as
Hollywood movie studios,
to receive their approval
for a unified standard and
to pave the way for the
signing of an official
agreement between the
rival camps, Nihon Keizai
Shimbun said.

First it was Yahoo!, offering their Yahoo! 360°
service—the regular Geocities-style free Web

hosting with the added feature of a blog. Next it
was Microsoft, christening the latest Xbox version
‘Xbox 360’. We preferred Xbox 2, but since when
did we have a say!

We did a Google search for the word ‘360’

and got 104 million results. Then we did a
search for ‘360 degrees’, and got almost 3
million results!

Although it’s nice that the biggies are trying to
offer ‘complete’ solutions (thus the term 360), we
think they could do with some new blood in their
creative departments!

360
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THE VISUAL PRISM 

SGI
Introduces
Linux-based
Visual
System 

Silicon Graphics Systems
India (SGI) launched the

Linux-based visual
computer product line, the
Silicon Graphics Prism
family of visualisation
systems in India. With the
Silicon Graphics Prism, SGI
becomes the only hardware
company in the world to
offer a visual computer
product line, based
completely on open
standards with Linux OS
and commercial off-the-
shelf components such as
Intel Itanium 2 processors
and graphics accelerators
from ATi. 

Scaling from one to 16
graphics pipelines and
from one to 256 processors,
the Silicon Graphics Prism
family offers many times
the visualisation capacity
of any currently available
computing system. For
users, this scalability
translates into the ability to
interactively visualise
terabytes of data in their
native form without
spending time culling it
beforehand.

PROTECT YOUR SYSTEM

HP Launches
Desktop
With
Security
Features

Designed to help protect
customers’ business

systems, the new HP
Compaq dc7600 Business
Desktop will be the first to
ship standard with the HP
ProtectTools embedded
security chip. Developed by

Broadcom, the chip
provides customers with
hardware-based encryption,
enhanced data protection
and system access. 

The new chip allows HP
to deliver the first business
desktop compatible with
the future security features
expected in Microsoft’s
Longhorn OS. 

The dc7600’s customised
thermal design also helps
enhance productivity and
minimises system
downtime by providing
customers more reliable
systems. The airflow design
is structured to help cool all
components of the desktop,
as increasing demands for
power are required. 

In addition, the dc7600
series is the first desktop
PC from HP to fully
meet the European
Union’s Restrictions on
Hazardous Substances
directive. All PCs sold in
EMEA must meet these
requirements by July 2006
and HP is moving quickly
to make it easy for
customers to plan their
desktop deployments.

NEW CHIP ON THE BLOCK

AMD
Launches
Multi-Core
Opteron
Processor

AMD has launched its
dual-core 64-bit

Opteron processor for
servers and workstation
PCs in India almost a
month after its launch in
America. According to
AMD the new processors
will improve performance
by almost 90 percent as
compared to single-core
Opteron processor. 

With the Direct
Connect Architecture AMD
has eliminated the Front
Side Bus Architecture, thus
eliminating the data
transfer bottlenecks. The
processors were designed
from ground up to directly

connect two cores on a
single die, along with
memory, I/O and dedicated
caches. Each of these CPU
core has it's own 1 MB L2
cache. An integrated DDR
DRAM memory controller
decreases the memory
latency and increases
performance power. With
support to upto three
coherent HyperTransport
Technology links each
processor provides a peak
I/O bandwidth of upto 24
Gbps. The company also
claims that the processor
provides the best
performance-per-watt ratio.
The non-disruptive upgrade
path of the Opteron is

another elegant feature
that will attract consumers,
says the company. The dual-
core processor will work
just as fine with the same
infrastructure as a single-
core AMD 64 processor. 

Speaking at the launch,
Ajay Marathe, President
AMD India said that the
simple out of the box
offering ensured that the
users would not have to
undertake huge
upgradation costs while
moving from a single-core
to a dual-core processor.
The new processor also
supports the present 64-bit
and 32-bit software
available in the market.

Offered in three series,
100, 200 and 800, the Dual-
Core AMD Opteron 800 and
200 series has been
available since May.

AMD also announced
that the AMD Athlon 64 X2
processor will be launched
in June this year.

Compiled by Aditya Kuber,
Mithun Kidambi, Preethi

Chamikutty, Ram Mohan Rao
and Renuka Rane

RSA

What is RSA?
RSA is an encryption
algorithm. It is widely used for
encrypting important
messages or digitally signing
documents for e-commerce,
and is included as part of the
Web browsers by Netscape and
Microsoft.
Who developed RSA?
The encryption algorithm was
developed by Ron Rivest, Adi
Shamir and Len Adleman (R, S
and A) at the Massachusetts
Institute of Technology (MIT)
in 1977. 
How does it work?
RSA encrypts on the principle
of a private key and a public
key. Users who wish to encrypt
data first encrypt the message
using a private key. This
encrypted message can only
be decrypted using a public
key, which has already been
distributed to the recipients of
the message. The primary
advantage of RSA comes from
the fact that, while it is
relatively easy to multiply two
huge prime numbers together
to obtain their product, it is
computationally difficult to do
the reverse. 
Where does RSA stand today?
RSA is still the most widely
used encryption algorithm.
However, while other
standards such as DES are
faster to decrypt, RSA remains
an industry favourite for
encrypting data, with many
believing that its 2048-bit key
encryption is virtually
unbreakable.
Why use an encryption
algorithm at all?
With so much electronic data
interchange (EDI) taking place
in the form of e-commerce, it’s
essential to secure critical
data. Several privacy laws
make it mandatory that
personal information of
customers and its integrity is
not compromised. 
When will RSA be cracked?
Although RSA securities claim
that the 2048-bit key
encryption cannot be cracked,
they offer bounties of up to
$200,000 (Rs 87 lakh) to
anyone who can crack
their algorithm.
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Bigger Is Better!

With a native resolution of 2560 x 1600—
or 4 million pixels—this top-of-the-line

display from Apple is currently the world’s
largest screen for a desktop computer.
Couple that with a thin bezel made of
anodised aluminium that feels divine to
the touch, and you have a product that
can truly be called awe-inspiring.

The display’s design reflects the
classic Apple style. There are just three
soft-touch buttons along the right side of
the bezel—a power/sleep button, and two
brightness controls. 

Since the LCD uses an all-digital interface
through a dual-link DVI connector (not to be
confused with the two single-link DVI ports present on
certain cards), image correction controls such as
horizontal/vertical position and size are not required at all.
Also, with a nice little contrast ratio of 400:1, the contrast
settings have been eliminated. The result is an elegant-
looking screen that’s extremely simple to use.

One of its USPs is the 170-degree viewing angle. No
matter where you view it from, seeing its crystal-clear image
reproduction and massive size will leave you dumbstruck!

There are a couple of niggles, though. For one, it only
supports resolutions with a 1.6:1 aspect ratio (2560 x 1600,
2048 x 1280, 1920 x 1200, 1280 x 800, and 1024 x 640). Set the
display to anything else, and all you’ll get is a blank screen.
This severely limits the applications that it supports. Most
games, for example, do not have widescreen resolutions. This

seems a particularly pointless
design decision considering the
fact that widescreen displays by
vendors like LG support all
commonly used resolutions.

This problem is further
compounded by the huge bandwidth
requirements of the screen.
Resolutions of 1920 x 1200 and above
require a dual-link DVI port, whereas
almost all current cards have only
single-link DVI connectors. 

Thus, to actually get to use the
screen at a decent resolution, you’ll
require a card like the GeForce 6800
Ultra DDL, which will set you back by 

Rs 45,000 or so. Again, this limitation is not present in
the displays made by other manufacturers.

Thanks to this, the 30-inch display is certainly not
recommended for home desktop owners, even if they have
the Rs 1,90,000 to pay for this baby! Of course, if you’re a
hotshot multimedia designer with an unlimited budget in a
multinational design studio, your search for the perfect
display has ended. The rest of you can start saving now!

Company Apple Computer International
Price Rs 1,89,500
Phone 080-25550575
E-mail deepanshu@asia.apple.com
Web site www.apple.com

Rating

What A Pity—No Camera 

Making a grand entry into the PDA phone market is the Siemens SX66.
This quad-band phone features a design similar to the O2 XDAs.

The SX66 features a 240 x 320 3.5-inch 65K colour screen,
and for connectivity, it has Bluetooth, infrared, and
Wi-Fi (802.11b), not to mention the USB connection.

It features a fully-functional QWERTY keyboard,
which slides out from under the screen. Powered by
a 400 MHz Intel Xscale processor, it comes with
Windows for Pocket PC 2003 and has excellent
handwriting recognition, in addition to MS Word,
Excel, Outlook Express… the works!

Although the Siemens SX66 comes with 128
memory onboard (apart from the 64 MB ROM), the
interface does become slow if you multi-task. Also
featured is an SDIO slot for memory expansion.

A sorely-missed feature is the camera—which is pretty
much standard on anything that costs over Rs 8,000!

Company Esource Global
Price Rs 38,500
Phone 9820822205 
E-mail charan@esourceglobal.com
Web site www.esourceglobal.com

Rating
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Contour Perfit Mouse Optical 

At first glance, the Contour Perfit Mouse looks
like an optical mouse with two scroll wheels.

One of them, in fact, is a rocker switch that
works as a ‘Forward’ and ‘Backward’ button for
Internet Explorer.  

The mouse is available in small,
medium, large and extra large

sizes for right-handed use, and
small, medium and large for 

left-handed use.  
The Contour Perfit

Mouse is designed to fit the
palm perfectly, and
considering it is available
in different sizes, hardly

would anyone not find a
match for their hand. 

This is an ideal product for users who need
greater control over their mouse movement.

Company Contour Design
Price US $109.95 (Approx Rs 4,947) (all sizes)
E-mail info@contourdesign.com
Web site www.contourdesign.com

Rating
1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

Siemens SX66 PDA

Apple 30” Cinema HD Display
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Tablets For Corporates 

Fujitsu is the latest entrant into the rather dormant
tablet PC market. It is really sleek and snazzy, with

loads of flaunt value! Your entry into a boardroom
with this tablet PC is sure to turn heads!

It comes in the slate form factor and hence features
no keyboard (unlike a regular laptop) and runs
Windows XP Tablet PC Edition. It is really slim and
fairly light, so holding it in your hand should not
be much of a problem.

The added functionality that it brings
due to the Tablet PC edition is the
Windows Journal where, using the
stylus, you can scribble notes even in a
hurry—perfect for those meetings when you
can’t be bothered to type all you hear!

As regards hardware, it’s fairly feature-packed, with a 
1 GHz Pentium Mobile processor, 256 MB of DDR RAM,
Wi-Fi, infrared, a modem, Gigabit Ethernet, MMC and
Memory Stick reader, two USB ports, a microphone and a
phone port. You can toggle the screen between portrait
and panorama views.

Speaking of the screen, once in the sun, no matter how
much you squint your eyes or tilt the tablet, there is pre-

cious little that you will be able to see. It is way
too reflective, so any background light will
surely reflect off it and make viewing things a
pain.

The tablet performed quite well on our tests
with sequential read/write scores of 28/28 MB/s
and Random read/write scores of 21/20 MB/s, and

an average access time of 12 ms. The Business
Winstone test score was 10.5, which is
respectable for a 1 GHz processor.

You have the option of getting a docking
station and a wireless keyboard and mouse
to facilitate your desktop needs. The tablet
PC is handy—not to mention cool—for
taking instant notes. If you are not too keen

on taking down notes or have terrible handwriting, keep
away from this—else, this tablet will not let you down!

Company Fujisan Technologies Pvt Ltd
Price Rs 1,80,000; docking station Rs 20,000
Phone 022-56368718
E-mail sales@fujisan.co.in
Web site www.fujitsu.com

Rating
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Sagem My X-8

The Sagem My X-8 combines elegance and func-
tionality in a single package. Encased in an ele-
gant white and metallic silver casing, the My X-8
looks rather business-like.

Apart from its appealing design, the other
claim to fame of the Sagem X8 is its multimedia
capabilities—including the stunning 262,000
colour 240 x 320 screen, 1.3 megapixel camera
with flash and audio playback. Standard features
such as tri-band, GPRS, MMS, and Java
MIDP2.0 support are in place.

The phone comes with
various applications
including an organiser, alarm,
and timer. Infrared and
Bluetooth are integrated. The
phone offers 40 MB of space for
images and other data, and
allows for memory expansion
using the mini-SD format. The
phone clarity is superb. The 1.3-
megapixel camera delivers good
results when lighting conditions
are good. The flash serves its pur-
pose, but leaves you wishing for
more power when shooting in the dark.

The audio output is superb for a mobile
phone, and you can easily use it as an MP3
player. The battery should last you about three
days with standard usage.

Company Cenzer Industries Ltd
Price Rs 22,000
Phone 022-26858594
E-mail mktg@sagemindia.com
Web site www.sagemindia.com        

Rating
1 2 3 4 5

1 2 3 4 5

1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvment 
in many areas. 3 Average: Reasonably competent but nothing spectacular about the product. 4 Good: A good buy, better than most products in its category. 
5 Excellent: A brilliant combination of price, performance and features—far beyond expectations.

Write to pprroodduuccttss@@tthhiinnkkddiiggiitt..ccoomm. The Digit Test Centre will be delighted to respond 
to your queries.

Looking for more information on any of the products featured here?

A Dream Of A Media Centre

HCL’s Beanstalk Neo is a full-blown
media centre PC for your living

room. The sleek looking Neo is
designed along the lines of an LCD PC
and should go well with the décor of
any living room. 

The 17-inch LCD monitor offers a
crisp display, and its aspect ratio of
16:9 adds that extra punch when
watching DVD movies. The Neo
is powered by an Intel Pentium
IV 3 GHz, 800 MHz FSB processor
with HyperThreading technology. The Neo,
though, comes with a measly 256 MB of DDR RAM which makes the
Media Centre OS interface slow.

A DVD writer is integrated into the body; on the left edge, a flap
covers a four-in-one memory card reader. USB ports, Firewire port, six
channel sound jacks, Ethernet jack, modem jack, and optical SPDIF ports
are available on the base of the stand. Similarly, component Video-in and
S-video in/out are also available on the back of the base stand. A TV tuner
and FM radio is integrated into the main body. 

The Beanstalk Neo comes with a full-featured remote. It will set you
back by Rs 78,990. However, we feel the sleek design, good hardware and
desirable software bundle makes up for the price.

Company HCL Infosystems Ltd
Price Rs 78,990
Phone 0120-2537660 
E-mail sjuneja@hclinsys.com
Web site www.hclinfosystems.com

Rating
1 2 3 4 5

Fujitsu Stylistic Tablet PC

HCL Beanstalk Neo Media Centre PC
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The 650’s Better! 

The upgraded sibling of the popular Treo 600
(reviewed in the December 2004 issue of Digit), the
650 boasts of some significant enhancements—really

making it worth a dekko! Major upgrades in the new model
include a faster processor, an upgraded operating system,
EDGE connectivity, a better screen, Bluetooth support, remov-
able battery and video capture functionality—which was
lacking in the Treo 600.

The Treo 650 is powered by an Intel PXA270 312 MHz CPU,
running version 5.4 of Palm OS. The quadband GSM/GPRS
device offers about 23 MB of user-available memory—expand-
able through the SDIO (Secure Digital Input Output) slot. 

Installed applications include Phone, VersaMail, Web
browser, Camera, RealPlayer, and World Clock apart from
standard PIM applications such as Contacts, Calendar, Tasks
and Memos. RealPlayer can be used to play MP3 files, but you
would need an SD/MMC card to store the tracks, it does not
play from internal memory. 

The Treo 650, as was the case with its predecessor, is
designed for single-handed operation using the five-way
navigator and other hardware buttons. However, you need to
use both hands (thumbs, in fact) while typing text on the
QWERTY keyboard. The phone operation is smooth, and there
are no issues as far as voice clarity is concerned. 

The screen vibrancy is excellent with
colours reproduced well. The inbuilt
camera with 2X digital zoom captures
stills and videos at an acceptable
quality, if there’s enough light.

The rechargeable lithium ion
battery will give you enough juice to
last for three to four days with
standard usage, but will be greatly
reduced if you play media files,
games, or leave the Bluetooth
perpetually switched on.

Surely worth considering, 
if you want a device that lets
you stay connected anywhere
in the world, and offers
business and entertainment
functionality, all-in-one.

Company Esource Global
Price Rs 36,000
Phone 9820822205
E-mail charan@esourceglobal.com
Web site www.esourceglobal.com

Rating

A Real Diamond Of A Motherboard!

MSI’s P4N Diamond SLI motherboard ships with nVidia’s
Nforce 4 Intel Edition chipset. The board features

Scalable Link Interface (SLI) technology for plugging in 
two graphic cards. This is the first SLI board for the 
Intel platform from nVidia.  

The P4N Diamond offers six SATA ports, and is
RAID 0, 1, 0+1 and 5 capable. It also features two
Gigabit Ethernet ports, up to 10 USB 2.0
ports and two FireWire ports. On
the aural front, the board
comes with a
dedicated 24-
bit sound
chip from
Creative that is
equivalent to the
Creative Live!
series. The board is
also touted to be dual-
core processor ready. 

MSI has a pair of SLI
graphic cards to go with
the motherboard in the
form of NX6800GT SLI. Based
on the 6800 chipset, each card
offers two DVI connectors and a
composite video out. 

The test platform we used was a Pentium IV 3.6 GHz
processor, 1 GB of Micron DDR2 RAM running at 533 MHz in
dual-channel configuration, and a 250 GB hard drive from
Maxtor. We loaded the Forceware 71.89 drivers from nVidia,
along with the latest system drivers for Windows XP. The
bench returned some of the best results ever; with scores of
7905 and 19170 in 3DMark05 and 3DMark03 respectively. 

Doom 3 returned an impressive 99.6 fps at 1024 x 768 and
86.5 fps at 1600 x 1200. Halo also returned impressive scores
of 106.94 at 1024 x 768 and 91.37 at 1600 x 1200. The gameplay

in all the games was smooth, and the card played them
effortlessly when the resolutions were cranked up, and even
with full AA. 

In fact, the system benchmarks,
such as ZDBench Content

Creation 2004, the

platform
returned a score of

32.4, which is on par
with AMD Athlon 64-based systems.

This new nVidia-based platform is meant for
a high-end gaming machine. As usual, MSI has done

their bit of magic to exploit the potential in the nVidia chips
to the maximum. Both the P4N Diamond, and the NX6800GT
are worth their weights in gold.  

The P4N Diamond is priced at Rs 18,500, and the
NX6800GT pair of graphic cards will set you back by 
Rs 57,000. Although expensive, you have to see it perform 
to believe it!

Company Micro Star India
Price Rs 18,500 (MSI P4N Diamond Motherboard), Rs 57,000 (MSI NX6800GT)
Phone 9821551801
E-mail info@msi-india.com
Web site www.msi.com.tw

Rating

MSI’s P4N Diamond And NX6800GT SLI

1 2 3 4 5

1 2 3 4 5

Palm Treo 650
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The other usage pattern that
exists would be the data backup
and storage kind. Here, the need
is basically to back up lots of data
- probably once a day or once a
week - and the backup device will
stay put on your desktop,
whether at home or at the office.
For this, we tested desktop stor-
age and backup drives.

We conducted the following
series of tests:
Drive Index: A cumulative figure
that gives an overall performance
grade based on the average of
read, write and seek tests, as well
as the file and cache size of the
disk. The drive index simulates,
and hence benchmarks, the drive
performance under typical PC
usage, so the higher the score, the
better the drive.

Varun Dubey

I
t all began with the first
production model—the IBM
305RAMAC (Random Access
Method of Accounting and

Control) hard drive in 1956. It had
a mere 5 MB of space and had writ-
ing speeds of about 8 KB/s—hardly
considered a hard drive today!

We have, since then, come a
long way, but our desire to cram
more and more into less and less
space has grown exponentially.
Thankfully, so has the capacity of
the hard disks of today.

Most computer systems today
come with 40 GB as the default
disk space, and people are already
finding this insufficient—so 80 GB
hard drives are becoming increas-
ingly common.

The limitation with these
drives is that they aren’t really
plug and play. Sure, if you’re a
tech-savvy person, it just means
disconnecting a data cable and a
power supply cable, and porting it
around - but for the rest of us,
messing around with the internals
of a computer isn’t an exciting
option. Enter external hard disk
drives. Let there be, umm, space!

Understanding The Tests
We realised there are broadly two
usage patterns for external hard
disks. One is for people such as
graphic artists or designers and
photographers who need to carry a
fairly large amount of data back
and forth between the workplace
and the home or other places. For
such people on the move, we tested
portable drives.

Let There Be Space!
With the ever increasing size of personal and professional data, most of us just cannot make do
with thumb drives and CD-Rs. Meet the external drives that have come to save the day!

Photograph Sandeep Patil
Imaging Atul Deshmukh
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Sequential Read/Write: This
test is conducted with a single
large file, so the data is ‘in
sequence’. The hard disk already
knows where to look for the data,
and hence this results in faster
data transfer. If you transfer a
single large file of, say, 1 GB,
instead of multiple smaller files
totalling up to 1 GB, the single
file will be copied faster.

Random Read/Write: This is
conducted with multiple smaller
files instead of a single large file,
and the drive has to search for the
next file every time it is done copy-
ing another. This test, therefore,
results in slower times clocked.

Average Access Time: The
interval between the time the
request for data is made by the
system and the time the data is
available off the drive.

CPU Utilisation: Since a copy-
ing or backup job would probably
be going on in the background
and not as a dedicated process,
the drive that utilises less CPU
time is a better drive. It will give
you better system performance.
Lower CPU utilisation also means
that the drive can be attached to
older, lower-end processors with-
out the system hanging due to
lack of availability of computing
resources.

The tests we described so
far were synthetic
tests—they measure
drive performance
reasonably well.
But they are called
synthetic for a reason;
they might or might not
reflect real-world usage. So we
also did a good old copy-pasting
test, and copied 1 GB of assorted
data to and from the drive, as well
as single 1 GB file to test the
sequential and  random read/
write parameters.

Now that you have a basic
understanding of the tests, let’s get
straight to the tests themselves.

PORTABLE HARD DISK
DRIVES
Looks, Size and Build
We received drives in various
shapes and sizes, from circular to
rectangular to square. The only
shapes missing were triangles
and ellipses!

The Seagate pocket drives were
just that—pocketable. They were
scarcely bigger in circumference
than a cookie: they were 1-inch
drives and were quite thin as well.

But all they could hold was a mere
2.5 and 5 GB.

In this segment, the largest
capacity was that of the Seagate
100 GB. This was a cool-looking
square drive that had a metallic
mesh. It was slightly bulky and
somewhat heavy—not exactly a
‘pocket’ drive.

A really light and pocketable
drive was the Freecom FHD2 Pro
60 GB. This drive is wafer-thin and
extremely light. You wouldn’t feel
it if you were carrying it in your
pocket, though the pocket would
need to be large—the drive is
rectangular and rather long.

The Western Digital (WD) 40
GB Passport was low on storage
space, and quite bulky. But it
featured a rubberised underbody
that ensured that vibrations and
noise—which are, in any case,
next to nothing—were minimised,
and that the disk stayed put on
any surface. The ports are
protected by a rubber flap that
resembles the port concealers on
everyday digicams.

If you are looking for some-
thing that’s stylish with lots of
space, and is not just portable but
actually pocketable, look no

further than the Transcend
Storejet drives. They come in

20 and 40 GB models, and
are smaller than a deck
of cards. They weigh
just 100 grams!
In our portable HDD

shootout, the only drive that
came with the one-touch backup
feature was the Freecom FHD 
Pro 2 60 GB.

Funnily enough, in terms of
visual indicators, all the drives
preferred a cool blue for the LED,
or even on the buttons (as in the
case of the Maxtor and the WD).
That could be an oblique reference
to the blues of backup!

On To The Tests
Synthetic Benchmarking: We
started with the SiSoft Sandra file
system benchmark. The drive that
absolutely blazed through the
synthetic benchmarks was the
Seagate 100 GB. It returned a drive
index of 28. The only hitch,
performance-wise, was that the
CPU utilisation was marginally
higher, at 3.75 per cent. Remember
that the CPU we were using is
extremely fast, so CPU utilisation
on lower-end CPUs would be a lot
more than this. 

This drive could put up such
a fantastic show because of its 8

Freecom FHD2 -
Pro 60 GB

1 col Ad
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MB cache, which was bettered
only by the massive 300 GB
Maxtor One Touch II, which had
16 MB of cache.

The drive that came second
here, and second by a long way
from the third-placed Freecom
drive, was the Western Digital 40
GB Passport. The drive had fabu-
lous 31 MBps sequential read and
21 MBps random read speeds.

The performance of the other
drives was strictly ordinary,
though special mention must be
made of the 2.5 and 5 GB Seagate
pocket drives, for the simple
reason that they’re so small. They
utilised 1-inch drives as opposed to
1.8 inches for the Transcend drives
and 2.5 inches for the Freecom,
WD and Seagate 100 GB.

Sadly though, these drives
were our worst performers, with
speeds of 6 and 8 MBps respec-
tively for the sequential read and
sequential write tests. They have a
spindle speed of 3,600 rpm,
whereas all the other drives were

Our test bed comprised an AMD Athlon 64 FX 53 Processor, with
an MSI K8T Neo 2 motherboard, 512 MB of dual-channel DDR

RAM, along with a Seagate 120 GB SATA HDD. The graphics card
we used was a GeForce 5700 LE (128 MB).

The hard disk was formatted as FAT 32 and loaded with
Windows XP Professional with Service Pack 1.

The drives were benchmarked on the basis of Features,
Performance and Price.

We ran several benchmarks on the drives to find out which
was the best performing, and then weighed that against the price.
We were looking for the drive with the best all-round
performance, features, as well as price.

Features
We looked at the various inbuilt characteristics and qualities of
each of the drives. For the products being marketed as portable
devices, we laid particular emphasis on the drive’s weight and
dimensions for 1.8 and 2.5-inch drives only. We looked less at the
weight and dimensions of the 3.5-inch drives, because they will be
primarily used as a stationary backup device. 

We also observed the build quality, with more importance
being given to the sturdiness of the product. Extra points were
awarded for features such as extra USB/FireWire ports,
configurable buttons, and so on.

Performance 
To gauge performance, we conducted two types of tests-synthetic
and real-world. 

For the synthetic tests, we used the SiSoft Sandra Professional
2005 benchmarking suite to assess theoretical read and write
speeds, as well as average access times. We also tested with
Winbench 99 2.0 to measure the CPU utilisation of each drive.

In the real-world tests, we transferred a set of assorted files
of varying sizes totalling 1 GB, back and forth from the system
hard disk to the external hard disk, and noted the time taken for
each transfer. Similarly, for noting sequential speeds, we
transferred a single 1 GB file.

Price Index
Price Index was calculated using the price-per-MB ratio. That is the
ratio of the actual usable space—not the rated space, as there is
always some loss due to formatting—and the price of the hard drive.

How The Awards Were Given
The score from Features, Build Quality, Performance and Price
Index are given weightages relevant to the specific category. An
overall score out of 100 is then calculated. The product that
scores highest here is adjudged the winner of the Digit Best Buy
Gold award for its category. The second-highest scorer gets the
Digit Best Buy Silver award.

How We Tested

at least 4,200 rpm. In fact, the
Seagate 100 GB and WD Passport
were 5,400 rpm drives. Remember,
the faster your drive spins, the
better the transfer rate and the
lower the seek times.

CPU Utilisation: There is noth-
ing much to differentiate these
drives in terms of CPU utilisa-
tion—they just varied between 3.4
per cent for the Seagate 2.5 GB to
3.75 for the Seagate 100 GB. This
was true even for our tests in the
desktop storage/backup category,
so there really isn’t too much
point dwelling on this.

So why do we need to talk
about CPU utilisation at all? There
are other drives out there in the
market that hog much more than
3.75 per cent, but in the batch of
drives we received for this
shootout, it just so happened that
no drive—in either the portable or
the desktop category—was worse
than roughly 4 per cent.

Real-World Tests: We now
come to our real-world test results.
For these tests, we used a single 1
GB file for our sequential
read/write tests, and an assorted
set of MP3 files totalling 1 GB. The
files were copied to and from the
hard disk, and we recorded time
using a stopwatch.

Here, ‘write’ means copying
files to the hard drive being tested,
and ‘read’ means copying files
from the disk.

The results we saw were mixed.
There was no drive that beat all the
others in every test. But the drive
that did beat the others in most of
the tests was the Seagate 100 GB. It
was beaten fair and square in two
tests (and that’s half of the real-
world tests!)—the assorted read
test—where it was beaten by the
WD Passport, which clocked a time
of 39.95 as compared to 40.26

seconds for the Seagate—and,
rather surprisingly, the

sequential write test.
Here it was

beaten by the
Freecom FHD
2 Pro 60 GB,
w h i c h

clocked 42.89
seconds as compared

to 47.02 for the Seagate.
The worst performers

were again the Seagate 2.5 and
5 GB disks, with times that were
as much as 5 times slower than
the frontrunners.

The drive that really
impressed, apart from the light-
ning-fast Seagate 100 GB, was the
WD Passport. It almost matched
the Seagate in every test and beat
it in one, and was light-years ahead
of the rest of the pack.

The Transcend drives were
slow considering they have the
same spindle speed and cache as
the Freecom drive. This shows
that the Freecom disk’s cache

Transcend
Storejet 40GB

Seagate 2.5 GB Pocket Hard Drive
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implementation and utilisation,
is far superior to that of the Tran-
scend drives.

The King of Space: Without a
doubt, the Seagate 100 GB is the
clear winner. The drive is excep-
tionally fast and has a huge
cache, not to mention the massive
100 GB it can store, and is priced at
a very competitive Rs 13,000—just
Rs 1,000 rupees more than the
Seagate 5 GB pocket drive.

The drive that came in second
by a reasonable margin was the
WD 40 GB Passport. It is a really
good performer, and is eminently
comparable to the

Seagate except when it comes to
size, where it lucks out at a mere
40 GB. The WD Passport is priced
very reasonably at Rs 6,400, and is,
in fact, cheaper than the Tran-
scend 20 GB—priced at Rs 8,320.

Comparing the WD Passport
to the Seagate: if you buy two of
these WD drives, you’ll be paying
Rs 12,800 for 80 GB of space,
whereas the Seagate 100 GB gives
you a cool 20 GB of additional
space at virtually the same 
cost—Rs 13,000.

For overall performance, price
and features, the Seagate 100 GB
portable HDD gets the Digit Best
Buy Gold Award. The Western Digi-
tal 40 GB Passport comes in a
comfortable second to receive the
Digit Best Buy Silver Award.

DESKTOP STORAGE/
BACKUP SOLUTIONS

Looks, Size And Build
In our desktop storage/backup
segment, all the drives were very
bulky, and seemed even more so
when compared to the portable
drives we’ve been talking about so
far. In terms of looks, nothing beat
the Seagate drives with their
sturdy, square exteriors. The qual-
ity of materials that make up the
outer casing is excellent, and the
use of high-grade plastic makes
the drives sturdy and also light.
Their design also enables stacking
of one drive on top of another.

That’s not to say that the
Seagates were the sturdiest of the

JUNE 2005

JUNE 2005

Seagate 100GB

Western Digital
Passport 40 GB

Ahard disk essentially consists of a
flat plate-like object that is

polished to achieve a mirror- like
effect. This is the hard disk’s platter,
and this is where the data is actually
stored using the magnetic properties
of the material the platter is made of. 

Hard disks of today feature
multiple platters. Each platter usually
has a read/write head attached to it,
which in turn is attached to an arm or
actuator that moves the head over
the platter.

Writing is achieved by subjecting
the platter to a magnetic flux by the
write head, which leads to the change of
polarisation on the platter. The process is
reversed for reading—the magnetic field of the
platter affects that of the read head, and this
is interpreted as data.

A platter and a head can be thought of as
the gramophones and record players of
yesteryear, where the needle moved on the

record to read the record and play the song.
The case is pretty much the same here, except
the read/write heads don’t touch the platter—
they fly less than a hairsbreadth above it.

The platter can spin at roughly 3,000
inches a second, which is approximately 270
kmph! Today, hard disks generally run at 5,400
or 7,200 rpm, though you do get hard drives
where the platter spins at 15,000 rpm!

How Hard Disk Drives Work

1 col Ad
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lot—that honour goes to Maxtor.
The drives from Maxtor have the
strongest cases we’ve ever seen.
They’re built of solid metal! You
can keep stacking and these
babies will take all the weight you
can throw at them, and more!

The drives that disappointed
here were the WDs, which were
rather plain-looking, and had
bodies of plastic that felt flimsy. If
you were to try stacking up these
drives, we wouldn’t be surprised to
see some cracks after a while!

All the drives—except for
WDs—in the desktop storage/
backup category came with a
single button. This, when pressed
once, activates the power; when
pressed twice, it acts as a ‘one-
touch’ backup button. If you keep
it pressed for a while, the drive
shuts down.

The WD drives came with three
buttons: one dedicated power
button, with the other two for
automatic backup and on-demand

backup. In automatic backup, the
drive just goes ahead and backs up
stuff pre-specified by the user. In
on-demand backup, the backup
software opens up and you can
back up data as you please.

The only drive that featured
something apart from what we’ve
mentioned so far was the Western
Digital Media Center. It featured a
Multiple Multimedia Card Reader,
which is stipulated to read pretty
much every kind of card you can
throw at it. You can copy stuff to
the hard disk directly using the
on-demand backup button. There
is no screen, so you’re limited to
copying the entire contents of the
card—you can’t see or choose what
you’re copying.

On To The Tests
Synthetic Benchmarking: The test
process used here was exactly the
same as with the portable drives.

Almost every drive we got here
was a 7,200 rpm drive. For some
reason, the Maxtor 250 GB was a
mere 5,400 rpm drive with an
extremely low 2 MB of cache. All
the others had at least 8 MB, and
the Maxtor One Touch II came
with 16 MB of cache onboard.

We started with the synthetic
benchmarking using SiSoft
Sandra 2005. One drive that
absolutely blew everyone away
was the Maxtor One Touch II. It

ATA: Advanced Technology Attachment. This is a
standard interface for connecting storage devices such
as hard drives, CD-ROMs, etc. It allows only 18 to 36
inches of cable length, and is therefore seen mostly as
an internal solution.
Cache: This is a buffer available to the hard drive, and
is usually a physically separate entity on the hard
drive’s IC. It synchronises data transfers between the
disk, reading it off the platter and the disk’s I/O system
to the computer. Normally, a larger cache will result in
faster read/write speeds and access times.
DMA: This gives devices within the computer the
ability to communicate to and access the system
memory without utilising the CPU—which results in
faster overall computing. All modern disk drives
support this.
Heads and Actuators: Modern hard disks have
multiple heads and multiple platters to read from. The
head is what reads the data from the platter, and the
actuator is the arm that moves the head across the
areas of the platter.
IDE/EIDE: IDE stands for Integrated Drive Electronics,
and is the standard used for all the drives commonly
found in computer systems today. EIDE is enhanced
IDE; it is a specific type of attachment interface
specification that allows for high-performance, large-
capacity drives.
MTBF: Mean Time Between Failures. This is essentially
the reliability index signifying the average time for
which the device will definitely work. Typically, hard
drives have an MTBF rating of 500,000 hours.
Head Parking: When the platter of the hard drive is
not spinning, the head rests on the surface of the disk.
When the platter does start spinning, the head drags
along the surface till enough speed is gathered for it to
disengage from the surface and stay nanometres
above the platter to read or write data. This dragging
can corrupt data, so there is a special track where no
data is written and is used for the head while it is idle
or gathering speed.
Platter: The flat disk that actually holds all the data on
the hard disk, in magnetic format. When requested,
the head reads the data off them.
SCSI: Small Computer Systems Interface; pronounced
‘skuzzy’. This is an advancement of the IDE/ATA
interfaces. While IDE is an interface, SCSI effectively is
a system-level bus with controllers on each SCSI device
working to optimise data flow. SCSI has multiple
standards such as ANSI, ITIC, NCITS and T10.
SATA: Serial ATA. It was primarily developed to replace
the parallel ATA technology. Transfer speeds for SATA
start at 150 Mb/s, and the newer SATA II is touted as
being capable of 3 Gb/s.
Spindle Speed (rpm): This the speed at which the
platter in the hard drive spins. The faster it spins, the
faster the access time, as the time taken by the head
to reach and access the data is lesser. Till recently,
5,400 rpm was quite common, but with the fall in
prices, more and more computers are shipping with
7,200 rpm drives. Laptops usually have 4,200 rpm
drives.
Seek Time: The seek time is the amount of time
between when the CPU requests a file and when the
file is sent. On an average, seek times are in the 2 to 5
ms range for internal hard drives. It’s a lot more for
external hard drives due to the interface limitations.

Jargon buster

1/4th page Ad

Western Digital
Media Centre
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was even close to the Maxtor One
Touch II. The drive absolutely
blazed past the competitors, being
at least two seconds faster in every
test. It comfortably annihilated

the competition, but this was
totally expected, given the huge
amount of onboard cache.

scored a blazing 41 MBps in the
sequential read score test. To be
fair to the others, though, the
Seagate 400 GB Barracuda did
score the same points as the
Maxtor most of the time, except
in the sequential/random write
test, where it scored 28 MBps, as
compared to the One Touch II’s 31
MBps, and in the random read
test, where it scored 31 to the
Maxtor’s 26 MBps.

The other drives did OK, but
were really not up to the mark. The

Seagate 400 GB Barracuda and the
Maxtor One Touch II were
completely in a league of their own!

CPU Utilisation: The story is
identical to that of the portable
hard disk drives. Scores varied
between 3.74 for the Maxtor 250
GB and 3.96 for the Seagate 160 GB
and the WD 250 GB.

Real World Tests: We now
come to the tests that separate the
winners from the also-rans. In
terms of pure data transfer, both
from and to the drive, no drive

Scoreboard                              Portable HDD 
BRAND
Model
Features

Drive Specifications

Physical Dimensions (LxWxH) (mm)

Weight (in grammes)

Drive Form factor (in inches)

Capacity (in GB)

Spindle speed (in RPM)

Data Buffer size (in MB)

Interface type

Visual Indicators

Additional configurable buttons

Power over interface

Miscellaneous

Build Quality

Sturdiness (Scale of  5)

Aesthetic design (Scale of 5)

Package contents

Bundled software

Carry-case included (Y/N)

Other accessories

Documentation:

Quickstart guide

Manual

Performance

Sisoft Sandra 2005 Drive Benchmark

Drive Index (in MBps)

Sequential Read (in MBps)

Random Read (in MBps)

Sequential Write (in MBps)

Random Write (in MBps)

Average Access Time (in msecs)

Winbench 99 2.0

CPU Utilisation in %

Real world file transfer tests

Sequential Write (1 GB) (in secs)

Assorted Write (1 GB) (in secs)

Sequential Read (1 GB) (in secs)

Assorted Read (1 GB) (in secs)

Price index:

Actual storage space (in GB)

Price (Rs)

Price per MB

Overall (100%)

Seagate
Pocket Hard Disk 2.5 GB
9.37

70mm(diam)

65.00

1.00

2.50

3600

2

USB 2.0

Blue LED

None

USB 2.0

None

2.75

3.50

Toolkit

✖

USB Cable

✔

✔

14.04

4

6

4

6

3

22

3.40

198.41

227.00

196.44

148.78

0.55

2.32

10000

4.21

23.97

JUNE 2005

Freecom
FHD-2Pro 60 GB
10.23

127x79x15

175.00

2.50

60

4200

2

USB 2.0

Blue LED

One Touch backup

USB 2.0

None

3.75

3.50

Backup Software

None

USB Cable

✔

✔

43.37

22

25

18

25

17

15

3.63

42.89

58.26

46.08

42.13

8.59

56.00

15500

0.27

62.18

Transcend
Storejet 20 GB
10.07

95x71.5x15

118.00

1.80

20

4200

2

USB 2.0

Blue LED

None

USB 2.0

None

3.50

3.75

SJ Utililty

✔

USB Cable

✔

✖

23.72

10

11

9

11

11

19

3.60

97.00

100.00

96.45

96.78

5.43

19.00

8320

0.43

39.21

Transcend
Storejet 40 GB
10.58

95x71.5x15

118.00

1.80

40

4200

2

USB 2.0

Blue LED

None

USB 2.0

None

3.50

3.75

SJ Utililty

✔

USB Cable

✔

✖

35.41

17

19

15

19

14

16

3.65

56.09

71.24

55.05

55.28

5.50

37.00

16000

0.42

51.48

Western Digital
Passport 40 GB
7.84

144.3x89.1x21.4

400.00

2.50

40

5400

2

USB 2.0

Blue LED

None

USB 2.0

None

3.50

3.25

None

None

USB Cable

✔

✖

47.58

26

31

21

25

21

14

3.74

44.72

53.22

38.90

39.95

13.74

37.00

6400

0.17

69.16

Seagate
Pocket Hard Disk 5 GB
9.43

70mm(diam)

65.00

1.00

5

3600

2

USB 2.0

Blue LED

None

USB 2.0

None

2.75

3.50

Toolkit

✖

USB Cable

✔

✔

16.67

8

8

7

8

5

24

3.70

156.74

226.05

141.66

128.90

0.93

4.70

12000

2.49

27.03

Telephone Web siteCompany E-mailBrand

Contact Sheet External Harddirves

Freecom
Maxtor
Seagate
Transcend
Western Digital

J.S Equipments
Fortune Marketing
eSys Information Technologies ltd
Mediaman
Priya ltd

022-23860976
011-26427627
011-51811694
022-23828100
022-566631000

jse@vsnl.com
yogi@maxtor.com
naresh@esysmail.com
sales@mediamangroup.com
priyabom@priyagroup.com

www.freecom.com
www.maxtor.com
www.seagate.com
www.transcend.com.tw
www.wdc.com
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The painfully slow drive here
was from Maxtor—the Maxtor 250
GB. No surprises, as the drive has a
slow 5,400 rpm spindle speed
coupled with a devastatingly low
cache (a mere 2 MB). There was no
way this drive was competing for
anything with anybody. The rest
were simply out of its league.

The other drive that was
impressive and really kept a consis-
tent performance was the Seagate
400 GB Barracuda. Although it
can’t be compared to the One
Touch II, it was commendably fast,
and its value-for-money proposi-
tion is simply to die for! A massive
400 GB for a mere Rs 20,000!

The fact that the Seagate 400
GB scored some pretty impressive
numbers is not to say that it was
second only to the One Touch II. In

fact, the WD 250 GB drive beat the
Seagate 400 GB in every real-world
test, and was slower only in the
sequential write test.

So if massive storage is not
what you are looking for, and if
you are a WD fan, this one is a
pretty good buy.

Mr Spacious: The drive that
eventually won had everything
going for it: price, performance
and some pretty decent features.
The Best Buy Gold goes to the
Maxtor One Touch II 300 GB. This
is an excellent backup solution 
as it is affordable, performs like 
a dream, and features a huge 
300 GB of space.

The Seagate Barracuda 400 GB
comprehensively beat the rest of
the competition, and though the
price tag might seem a shocker,
the fact is that no other drive or
drive manufacturer out there gives
you a 400 GB hard disk drive. Cost
per MB, though not the lowest, is
certainly competitive—so we
adjudge it our Best Buy Silver
award winner. 

varun_dubey@thinkdigit.com

Desktop Storage/Backup DrivesJUNE 2005JUNE 2005 JUNE 2005

Seagate
160 GB with Firewire
8.24

180.9x165.5x57

1050.00

3.50

160

7200

8

USB 2.0/Firewire

Yello LED

Single Power/Backup

Button

Power Adapter

None

4.00

3.25

Backup

✖

USB/Firewire

cable/Power

adapter/stand

✔

✔

33.61

24

28

20

20

18

15

3.96

56.91

62.28

39.15

54.79

5.49

149

12500

0.08

47.34

Seagate 
100 GB ST9100801U2-RK
13.25

127x99x25.4

100.00

2.50

100

5400

8

USB 2.0

Blue LED

None

USB 2.0

None

4.25

4.00

Seaget utilities

✖

USB Cable

✔

✔

50.14

28

34

23

25

25

14

3.75

47.02

52.66

31.89

40.26

17.00

93.00

13000

0.14

80.39

Seagate 
400 GB Barracuda
9.99

180.9x165.5x57

1176.50

3.50

400

7200

8

USB 2.0/Firewire

2 Blue LEDs

One Touch backup

Power Adapter

None

4.00

3.25

Backup

✖

USB/Firewire cable/Power

adapter/stand

✔

✔

46.89

35

41

31

28

28

8

3.87

41.90

46.63

39.42

33.88

8.57

372.00

20000

0.05

65.09

Western Digital
WD2500BO11 RNN
8.68

230x150x50

1360.00

3.50

250

7200

8

USB 2.0/Firewire

Blue LED

Power, Auto backup,

and On Demand

Backup

Power Adapter

None

3.50

3.50

Backup

✖

USB/Firewire

cable/Power

adapter/stand

✔

✔

44.24

29

29

29

27

27

9

3.96

43.65

44.98

31.16

34.93

7.16

233

15000

0.06

59.76

Western Digital
250 Media Center
10.18

230x150x50

1360.00

3.50

250

7200

8

USB 2.0/Firewire

Blue LED

Power, Auto backup,

and On Demand

Backup

Power Adapter

MMC card reader!

3.50

3.50

Backup

✖

USB/Firewire

cable/Power

adapter/stand

✔

✔

40.96

24

24

25

21

21

2

3.89

54.46

58.08

37.36

45.90

8.55

232

12500

0.05

59.38

Maxtor
300GB One Touch II
11.01

210x120x4

1380.00

3.50

300

7200

16

USB 2.0/Firewire

Blue LED

poewr button single

press is backup

Power Adapter

None

4.00

2.75

Backup

✖

USB/Firewire

cable/Power

adapter/stand

✔

✔

49.77

35

41

26

31

31

14

3.79

34.20

42.24

26.99

31.54

10.05

300.00

13750

0.04

70.48

Maxtor
One Touch 250GB
7.73

210x120x4

1380.00

3.50

250

5400

2

USB 2.0/Firewire

Blue LED

poewr button single

press is backup

Power Adapter

None

4.00

2.75

Backup

✖

USB/Firewire

cable/Power

adapter/stand

✔

✔

33.73

22

25

21

19

19

9

3.74

58.26

57.50

48.71

48.73

8.95

233

12000

0.05

50.05
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Seagate 400 GB 
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F
ew devices exemplify digital convergence
better than the smartphone with its various
functions—that of a PDA, cell phone,
camera, and more. There was a market—
now fast declining—for dedicated PDAs; and

a huge market for cell phones. Someone tacked those
two together, and the result was a huge success. And
then, someone else threw in a camera as well, and
that was the masterstroke. Smartphone sales are
already eating into PDA and vanilla cell phone sales,
and ABI Research (Allied Business Intelligence
Research, New York, USA) predicts that by 2009,
smartphones and connected PDAs will represent
nearly a quarter of all handsets shipped.

In simple terms, this is what digital convergence
is all about—the coming together of diverse tech-
nologies into simple devices that are more useful
than the original individual devices themselves. But
there’s more to convergence than just this. It’s an
inexorable force that is driving markets worldwide;
it’s a force that is pushing innovation to the limits;
it’s a revolution.

Let’s get back to the clock—the simple time-
displaying device. In days bygone, a wristwatch or
pocket watch were solely how we told time. Then
came the LCD and LED, and we had clocks all over
the place—in those old Nintendo and Casio pocket
video games, in home music systems, in TVs, in VCRs.
This is a primitive, but very indicative, example of
convergence. Think about it. It is, in fact, a very good
example. What happened? 

Essentially, manufacturers decided to throw in
clocks into diverse devices, and people liked it—they,
in fact, began to expect this of all electronics devices.
You might ask why a video game should display time,

and that brings us back to the smartphone: who
wants a camera in a phone? In fact, many do. Which
brings us to the question: Was it the market that
drove the innovation, or did the finished product
create demand? 

All we know as of now is that someone took a
piece of duct tape and stuck a camera onto a phone
(and perhaps we’ll soon see people throwing in
phones into cameras!). The idea clicked (no pun
intended) and as a result, a huge new market was
created in a short span of time. 

One driving factor here, could have been the fact
that with a phone, which these days is equipped with
Infrared and Bluetooth communications possibili-
ties, people could share their photos at the press of a
button unlike with other media.

If markets drive convergent innovations, we have
to ask, what are the ideal converged devices people
want? And if innovations create demand, we have to
ask, what of ideas that don’t work out?

As regards the former, think of the following as
the ultimate example of digital convergence: your
fridge automatically detects there’s not enough milk.
Without your even having to press a button, it uses
your home’s wireless network to get on the Internet,
places an order at your local supermarket and the
milk is delivered. Some call this the Holy Grail of digi-
tal convergence. 

One needs to see what is at work here: it’s the
same thing that drove almost all technological inno-
vations—the idea of making human life easier. That
is the essential driving force. But there’s more on the
subject of what people want. With huge flat-screen
TVs making their presence felt everywhere, courtesy
dropping prices, they will become essential compo-
nents of the networked home in the not-too-distant
future. And people will want content to fill those TV
screens with. That hunger for content will come
simply as a result of the TVs being there. The fulfil-
ment of one market will create another.

What about convergence ideas that didn’t take
off? Sometimes, when one idea is shotgun-married to
another, the result turns out to be something no one
wants. A prime example is the CueCat—a mouse-like
device that could scan bar codes, whose correspon-
ding products you could look up on the Internet with
one click. For reasons unknown, it flopped.

No one can pinpoint why exactly the CueCat
flopped; think about an almost identical concept—a
camera in a phone that can click a bar code. One can
then log on to the Internet for information. Say you’re
buying meat: the barcode contains information about
how the animal was bred and reared, and you get this
within a moment of scanning the barcode; this helps

‘Convergence’ is a lot of things, and means different things to different people—as
you’ll find out in the pages that follow

What Is Con  

Convergence is not just about gadgets. It’s also about connectivity (left) and the
facilitation of everyday things, exemplified by the fingerprint scanner (right)



53JUNE 2005 DIGIT

4 Years Of Tech

in your decision to buy. This is happening now, and
seems a good idea to many people.

That said, there is no single definition of conver-
gence. A popular definition on the Internet says
that digital convergence is “the technological trend
whereby a variety of different digital devices such
as televisions, mobile telephones, and now refrig-
erators are merging into a multi-use communica-
tions appliance employing common software to
communicate through the Internet.” Someone else
says, “What is really happening is the convergence
of content, communication, and computing.”

Think about how content reaches us nowadays.
Radio, satellite, cable, fibre optics, wireless, the
Internet are some of the more common media.
This is an example of how our lifestyles are chang-
ing, or are being changed, by the fact that we go
anywhere we want, do anything we want, and the
content reaches us anyway. Cable disconnected?
Turn to the Internet. Net connection down? Get it
from someone’s GPRS phone, on the move. And so
on. Content is making its way across boundaries.

Communications is key when we’re talking
convergence: devices are talking to each other
more and more. Your iPod talks to your PC. Your
phone talks to another in the sense of being able
to transmit a picture to it—whether you’re stand-
ing near the other phone or whether you’re thou-
sands of miles away from it. 

Everything has a chip—from phones to cars to
stereo systems. And all these chips will talk to each
other—or are already talking to each other. Compa-
nies want to put a chip into everything.

Says Gottfried Dutiné, an executive vice-presi-
dent at Philips, “Digitisation is creating products
that can’t be categorised as tech or consumer elec-
tronics. The walls are coming down.” And as an
article in BusinessWeek Online, dated 21 June 2004,
puts it, “That sets up a collision of three massive
industries. In one corner stands the $1.1 trillion
computer and software biz, with its American
leaders. In another is the $225 billion consumer-
electronics sector, with its strong Asian roots and
a host of aggressive new Chinese players. The third
camp is the $2.2 trillion communications indus-
try, a behemoth that extends from wireless power-
houses in Asia and Europe to the networking stars
of Silicon Valley. All the three groups will have a
hand in building the digital wonders that are
headed our way.”

The rush to churn out those digital wonders
has reached critical mass. Innovation is now a full-
time job. Many products coming out of this rush
will flop: this is uncharted territory, and there are
few precedents to draw from—there are few stan-
dards, and interoperability and security are 
key issues. The ones that make it will define 
our digital future.

Going back a little, think about the PC. What
can’t you do on a PC these days? You can have one
browser window open showing you the latest
cricket scores. Another brings you an e-learning
class (you shouldn’t be looking at cricket scores
when you’re studying, but anyway). An MP3 song
plays in the background. And on and on… all at
the same time, most of them via broadband. 

Broadband is the enabler: if communication
is to happen and content is to be delivered, you
need a fat pipe. How could streaming Internet
video be delivered to your smart TV without an
always-on broadband connection? The PC, with its
broadband connection, is a wonderful example 
of how ‘just a device’ became a converged 
device. Convergence is all around; and with most
people owning PCs, the PC had to be affected
sooner or later.

As with the refrigerator example, another Holy
Grail of convergence is the perfect, networked
living room. The all-in-one living room device
hasn’t yet been manufactured, but it will soon be. 

Market factors dominate here: how soon will
ultra-high bandwidth get to homes? How soon
will large flat-screen TVs become affordable to all?
When all that is worked out, the idea is simple
enough: one centralised entertainment device
with a broadband connection and wireless satel-
lites. The device will be fed from diverse sources,
and the satellites may be anywhere—even in your
house—and without any wire clutter whatsoever.

In Singapore, Australia and other places, you
can pay for a can of Coke at a vending machine
with your cell phone—beam your phone at the
machine, and your Coke is billed to your phone
account. Luddites may ask, why not just pay using
coins instead?

But the revolution has already begun. The
Coke machine example states what digital conver-
gence is all about: everything digital will talk to
everything else digital, and things digital will be
near you all the time, everywhere.

 vergence?

Some converged gadgets just flop—refer Crash Landing in this issue. Others,
like the Kaleidescape (at right), are at the cutting edge of innovation
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In the beginning was the singularity—the physical
state of being everything, yet nothing. A state of
being so dense that the entire universe was all of

one dot. Just then, the big bang happened. And the
universe was created.

The singularity, in a sense, was the ultimate
converged world—where dark matter, the stars, the
black holes, the planets, the comets, well, just about
everything, was one. Mankind, it has been conclu-
sively proven, evolved from a converged world.

It is therefore apt that we are moving once again,
technologically at least, toward a converged world—
where more is less, and less is more. Where gadgets
come together, and technologies meet halfway. We
are coming full circle, so to speak.

Convergence can often be a daunting word, where
more is misunderstood than understood. Trouble is,
truly very little of it is understood. Is convergence
limited to communication? How can convergence
increase productivity at the workplace? And so on.

These are questions that require answers derived
from evidence gathered over a period of time. Yet, we
all know that convergence is where we are headed. It
is as if we are in a primordial soup of technological
evolution, where cell phones are still cell phones (add
a small camera here and a small PDA there), MFDs still
do only four functions at most, and personal enter-
tainment gadgets are still just that—personal enter-
tainment gadgets.

The time, therefore, has come to create a revolu-
tionary product. Very few technology products have
changed the course of history. The last time a prod-
uct did that was the personal computer, and that was
in the 1970s. The ‘big ticket’ product prior to the
computer was the television, in the 1920s. And around
30 years prior to that came the radio.

Nearly 30 years after the PC, therefore, we are due
for one more revolution.

Some say the Sony PlayStation Portable is the ulti-
mate converged tool. How shortsighted can we be? The
PSP is a glorified personal entertainment gadget. It
gives you gaming, it gives you good video, and it gives
you great audio. At best, it is an iPod killer; at worst,
it is the first step to the ultimate convergence tool—the
OmniPerpetual Machine, as I would like to term it.

The OmniPerpetual Machine (or OPM, or Opium!)
would do just about everything you ever wanted the
ultimate convergence tool to be—a PC, a personal
entertainment gadget, a credit card, a mobile phone,
a camera, a printer, a scanner, a fax, a copier, an
instant messenger, a pager, the works. I can already
see the headlines: “Opium is the opiate of the masses.”
Marx just turned in his grave.

The Opium is your car key, your personal infor-
mation databank, your personal banker. It connects to
the Internet to give you the latest tax information,

and tells you how much you have spent in the last
month. It is connected to the camera at home so you
can keep constant vigil. The Opium is also the one-
stop GPS navigator, your one-stop connect to the
unknown world in whatever country you are in. It is
your interpreter, your communicator within an alien
country; it gives you the latest currency rates, the
sights to see, the people to meet, and the maps to
reach them.

It allows you to make phone calls over the Internet.
It allows you to downloads songs, videos and TV
programmes, and broadcast video around the world.
Corporations will video-conference with any other
company around the world using wireless broadband,
thus reducing air travel and creating an alternate cost
structure for any company.

Well, you get the picture. The Opium will be a do-
all gadget. I don’t know what shape it will take, and I
daresay, even the most intrepid of artists would dither
to make a prototype illustration. 

Sachin Kalbag is Executive Editor of Digit

“Convergence can often be a
daunting word, where more is
misunderstood than understood”

Convergence As The 
Opiate Of The Masses

Nearly 30
years after
the PC, we
are due for
one more
revolution
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Yet, it is a gadget that could well be the ultimate
achievement of mankind. Are we dreaming? Maybe.
But if the ultimate objective of physics is to find the
Grand Unified Theory, the ultimate objective of
personal technology should be a gadget that can do
all of the above, and more. Most of all, the gadget
will serve to make the world smaller than
ever before, and create a world that has answers
at its fingertips.

Sociologically, though, it will be a nightmare,
further dividing the haves and the have-nots. But
then, what gadget or technology has not divided
the world? Today’s world, more than ever before,
is cleaved into the haves and the have-nots.
If 20 million people in India have access to the Inter-
net, there are 980 million who do not. If there
are 160 million people with access to TV, there are
840 million who don’t.

Despite these daunting figures, it is only
inevitable that technology will move towards
this machine. It may not be called Opium
(anyone with a better name can send their
suggestions to editor@thinkdigit.com), but it
will be there.

To be sure, building such a gadget would not be
too much of a problem. As aviation experts put it
when the Airbus 380, the world’s biggest passenger
plane, was in flight: “It is only a matter of scaling up.”
Today, the strongest candidate for such a universal
machine is the humble cellular phone. Build

the devices around the cell phone, and you would
slowly, but surely, move towards the ultimate
converged device.

However, the bigger issues will be: Who will
provide the surrounding infrastructure to support
information of all kinds on a machine like the
Opium? Will the government address the bandwidth
issue to clear broadcast issues? Will ultra-wideband
technology become de rigeur? Will wireless data access
be cheap enough for the common man to access
without restriction?

We don’t know the answers yet, and it would be
foolish to hazard a guess. We wouldn’t want to predict
what government regulations could be, nor can we
even predict what the public’s reaction would be.
What if we never take to the Opium, just as we never
took to the Apple Newton?

Admittedly, the Opium will not take us even a step
closer to Utopia. At best, it may create a new army of
technocrats. No technology in the history of mankind
has been ubiquitous, none omnipresent. It would be
wrong to assume that the ultimate convergence
device would be a ubiquitous device. The presence of
such a device in anybody’s hand would be more of an
exception than the rule. It would definitely mean that
humans have advanced technologically to a very high
degree, but not so much as to turn technological
utopia into reality. That, unfortunately, would remain
a topic for science fiction novels. 

1/2 pg V AD

Who will provide the
infrastructure to support
information on the Opium?[
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Robert Sovereign-Smith

We’re on the verge of an age of convergence,
and the very first place you’ll interact with
the new technologies will be at home.

Manufacturers are in the fight of the millennium,
trying to get into consumers’ homes, trying to intro-
duce technology solutions—and, consequently, their
gadgets—into every aspect of your life.

The fine line between electronics and comput-
ing devices is almost invisible already—everything
from music systems to cars have computer chips
embedded in them, and they’re touted to get
a lot smarter.

We take a look here at what technologies and
gadgets you can expect to see in your house over
the next few years. Some of them have already
been implemented, and are beginning to gain
popularity, while others are still in the prototype
stage, or have only just been envisioned.

Those with millions in the bank can possibly
go out right away and get their house outfitted,
just as is described in this article. The less fortu-
nate among us will have to wait a few years.

The Living Room
The most important room in the house, the living
room, is where the majority of gadgets being made
are targeted. This is because this is the room where
you and your family spend most of your waking
hours—seeking entertainment. All entertainment
devices can be broadly classified into two groups:

The Display Device: The TV is currently the
default family entertainment centre, and thus, is a
multi-billion dollar market. We have seen the TV go
from a dumb visual output device to the interactive
entertainment centre that it is today. With more
technologies and companies coming up with
increased interactivity, such as Direct To Home
(DTH) and Pay-Per-View, and even more companies
already offering Internet access to your TV via set-
top boxes, it’s merely a matter of time before the TV
becomes a one-stop entertainment centre.

The Audio Device: Everyone loves music—it’s
just tastes in genres that differ. Today, music
systems are already offering VCD, DVD, MP3, and
Audio CD playback. Some digital entertainment
centres come equipped with wireless networking
so they can connect to your PC and stream audio
and video to your audio and display devices.

Your home
is all set to
become the
central
computing
device of
your life

One World,

Illustrations Shyam Shriram
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The living room of the future will still serve as
a family entertainment room, and will divide all
content, whether from satellite channels or from
your own PC, into audio and video. These audio
and video streams will be sent to unified audio
and video output devices. 

Since speakers are meant to be heard and not
seen, you will be able to install hidden speakers
throughout your house that will act as the audio
output devices. Volume and settings will be visually
controlled via the room’s video output device. More
likely, however, is that your walls themselves will
become your speakers; or for that matter, perhaps
the ceiling as well—talk about surround sound!

Perhaps, much further in the future, we will be
able to install paper displays that can cover our entire
walls as wallpaper, and give us the freedom to
demand the appearance of a screen, of any size, on
any part of a wall or ceiling.

However, for now, we’ll stick to the already-popu-
lar LCD screen that can cover one wall of each room
and act as a visual output device for entertainment,
computing, and as a graphical user interface (GUI)
for changing the settings of all other devices. One
such display device can be installed in every room of

the house, and the device will connect to all others
in the house wirelessly. The device will be controlled
by the house CPU, and will automatically follow you
as you move around the house—switching on
displays when someone enters a room, and switch-
ing off once everyone leaves.

The Hallway/Entrance
The logical place for the main home security panel
is somewhere near the front door, so why mess
with logic? This will merely control the security
settings of the house, such as turning on or off the
movement sensors outside, setting the burglar
alarm, and auto-locking the house at predefined
times. All these settings will also be accessible
from anywhere else in the house using touch-
sensitive video output devices, and entering the
correct username and password combinations.

The main CPU will govern the security settings
as well as other important semi-AI functions, such
as privacy and data synchronisation.

When watching a movie or having dinner with
your family, the house will automatically recognise
that the entire family is involved in a particular activ-
ity, and will automatically screen calls and e-mails. 

One Home
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Let’s assume you have three levels of callers—
‘one’ for unidentifiable callers, ‘two’ for friends,
and ‘three’ for VIPs. So when your family sits down
to dine, the house will automatically change its
status to ‘Dinner’, and, depending on the setting
you’ve preset, will screen callers from the three
levels—for example, only allowing level three calls
to come through. It will also give callers from the
other two levels a polite reason for not connecting
them, and give them a tentative time to call back,
or even call them back as soon as you finish
dinner—again, all preset.

Using secured wireless networks, the house will
also connect to various other devices, such as the
entertainment centre in the living room to send it
instructions about what movies you requested for
the evening, or what audio playlist is most popular
at this time of day, and on this day of the week. 

This house CPU will also monitor the external
security camera and watch for movement or people
approaching the doors or windows. You will be able to
set it to pop up a visual of the person approaching on
the video output device in the room you are currently
in, while the speakers will play a soft alert sound. 

The Kitchen 
Keeping with the current popularity of open
kitchens, perhaps the kitchen no longer needs to
be just that, and can be converted into more of a
chore and recreational area.

Devices such as washing machines and dish-
washers will connect wirelessly to the house CPU
and receive instructions from it. The house CPU
will also control other devices such as the refrig-
erator, your Personal Digital Device (PDD) and the
central heating or cooling.

The house CPU informs your family when the
fridge is low on food stocks, or when you are
running out of dishwash detergent. It also moni-
tors the functioning of these devices, and will
even be able to draw a bath for your family,
remembering the temperature that each family
member prefers.

On a more personal level, convergence will
mean that your house CPU will be the central
repository for all your family’s personal data. Each

Devices exist that will blow your mind with the advancement of technology they
display. Check them out for yourself online.

Solid State Hard Drives: Ahh, a thing of fiction for every hardware junkie. After
all, it’s the hard drive that’s the bottleneck of systems today! But, how about memory-
cum-hard drives that offer read speeds of 8 GBps, and write speeds of 6 GBps (a SATA
hard drive offers a mere 150 MBps). Quantum Optical memory offers just that, and a
250 GB memory chip-cum-hard drive is about as big a glucose biscuit! Check out Atom
Chip Corporation at www.atomchip.com, and don’t miss the Consumer Products link—
there’s a tablet PC with 250 GB non-volatile memory (RAM + hard drive), and a 4 GHz
AtomChip CPU. The products are mainly developed for the US Military, but you can pay
the site a visit and dream, can’t you?

Not-So-Crazy Ideas: Most of these inventions have to be dreamed up before they
are invented. It’s a pity not many companies are willing to share their dreams with us.
However, the NEC Design studios is kind enough to share some of their future projects
online. Visit http://www.nec-design.co.jp/showcase/ to see some really innovative ideas.
We loved their “tag” soft shell mobile phone so much we were inspired to use it in the
visual below, as an illustration of the Personal Digital Device (PDD) of the future.

Believe It Or Not!
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member will have a PDD, which is nothing short
of a wearable (and perhaps flexible) laptop-cum-
cell phone-cum-PDA that can use your house
network or public networks outside for its
computing needs. It will act as a complete
personal communications device that will make
and receive phone calls, send and receive e-mail
and other communication from your family,
friends, colleagues, and the authorities.

The house CPU will synchronise itself with
your PDD to make sure that both are up-to-date
all the time—taking care of all data changes that
have occurred when you were out.

The Car/Garage
Currently, our cars are the dumbest of the gadg-
ets we interface with, and hopefully, manufac-
turers will bring some of the technological
sophistication that already exists in luxury
sedans into the models for the masses.

Even currently available technology can make
our cars a million times smarter than they are
today, and hopefully this segment will be less
ignored in the future—especially as traffic conges-
tion increases, in turn increasing the time we
spend inside our cars.

Global Positioning Systems (GPS) are already
available in more expensive cars, so imagining
this in every car is hardly far-fetched. This will
enable your house CPU to connect to the central
traffic server, using your predefined authentica-
tion, and inform your family of your whereabouts.
It will also let your family contact you on your
car’s communications system.

The car will also have a computer running some
very basic functions, such as fuel injection and
communications, and could also be set to govern
safety—keeping safe distance from other vehicles and
objects by using radar or imaging. This could put an
end to accidents, traffic congestion and rash driving.

The car’s communications device could be a
mini-home theatre system, offering both audio
and video outputs for video conferencing, phone
calls, music or even movies—hopefully the auto-
drive functions will be well developed by then. 

Your PDD could interface with your car, telling
it where your next appointment is, and pinpoint
your destination to the car’s GPS device. Satellite
imagery could help your car automatically chart
the fastest route to your destination, taking into
consideration traffic and weather conditions.

The car locking system and ignition could be
fingerprint-controlled, doing away with the entire
“Now where are my car keys?” scenario. It would also
help the car identify the driver, adjust the seat accord-
ingly, as well as select the appropriate music playlist
and user account. This will ensure that you always
hear the music you like, or prevent you from receiv-
ing e-mails meant for your dad, or worse, him receiv-
ing “I love you” messages from your significant other!

The Gadgets
We understand why many people reading this
article might make incredulous sounds, and
call it all mumbo jumbo. Well, here are a few
gadgets that have already been developed, or
prototyped, and are expected to be available to
consumers soon…

Many
people
reading this
article
might make
incredulous
sounds, and
call it all
mumbo
jumbo...
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Visteon Family Entertainment System
Here’s a neat way to have fun while driving—well
OK, so the fun is all for the back seat passengers! 

This product is great if you have a driver, or if
you are driving and have kids. Long car journeys,
or even short ones on our congested roads, can feel
like an eternity, but with a Visteon Family Enter-
tainment System, the kids will never ever
complain again.

It features a DVD player, so you can pop in a
DVD movie for the kids to watch while you are
driving, or you can plug in a video camera, or
anything with an audio/video out, and view its
contents. Kids of all ages can even plug in a video
game to have some fun. Use an Xbox, play DOOM 3
in a car?
See www.visteon.com for more details.

LG Television Refrigerator
The LG Television Refrigerator includes a cable-
ready, 13.5-inch television screen, FM radio, two
speakers and a TV tuner.

No longer will your mom, your spouse, or even
you, have to miss out on your favourite television
shows just because you have to be in the kitchen
preparing dinner. 

It’s also easy to see this device being fitted with
Wi-Fi and hooked up to a home network.
See www.lgusa.com for more details.

Blaupunkt’s 15.4-inch Video Monitor
At 15.4-inches, and with a WXGA pixel resolution,
this overhead car monitor delivers superb video
performance. It also boasts of the simplest cable
installation possible—almost plug-n-play. This is
just another example of well-known brands
coming up with more gadgets targetted at enter-
taining your family while inside your car.
See  www.blaupunktusa.com for more details.

Kaleidescape
This is a system that records your DVD movies onto a
hard drive, then connects to the Net to get high reso-
lution DVD cover images and all other details it can
get, such as year of release, cast, rating and reviews,
etc. It will then let you search through your library
and instantly play any movie you want.

Since the device connects to all TVs in the
house, you can easily access your movie playlist
from just about anywhere in the house. It also has
a cool-looking touch-screen controller, and a really
simple to use interface. 

Problems of piracy abound, as users could rent
DVD movies from the local movie library  and copy
them to the Kaleidescape. There’s a court battle ongo-
ing between the makers of Kaleidescape and the DVD
Copy Control Association (DVD CCA), but the products
are still avialable, pending a judgement on the case.
Get one before the final court ruling, just in case!
See www.kaleidescape.com for more details.
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Arrow Biometric Fingerprint Identification Lock
This is sort of a dream device for the more forgetful of us. Never again
will you find yourself locked out of the house, office or even your car. 

The Arrow biometic fingerprint identification lock is powered by
batteries, that will give you enough advanced warning, so don’t
worry you won’t be locked out because the batteries died!

This device will fit perfectly into the future, as we move towards more
secure ways of transacting, whether it’s paying a bill or opening a door.
We can see this device being utilised not just in houses, but also for cars,
safes, personal lockers and even at supermarkets—it can make identity
theft and the use of stolen credit information a thing of the past.

A more creative line of thought could see them implemented in
schools and colleges, to make sure that only students authorised to
enter a classroom can do so. It could do away with ‘cheating by proxy’
(where someone else appears on your behalf, usually a smarter some-
one!), and even help in maintaining foolproof attendance records!
See www.arrowvision.us for more details.

Solid Drive Speaker Drivers
Turn a wall or a table into a speaker. Sound unbelievable? Believe it!
Solid Drive speaker drivers can make any flat solid object into a
speaker, by vibrating it to produce sound. Even windows can become
speakers, or the door, or a conference table—use your imagination! 

The best use for it though, would be inside the walls of your
converged house, so that you get a true, complete surround experi-
ence, and no speakers are ever visible.
See www.soliddrive.com for more details.

The House
As you can see, most of the devices mentioned here are hardly
components of a science-fiction flick. If you have enough money, you
can have the home of the future today! The good news is that as these
devices become more popular, the prices will fall, and all of us will
be able to afford the converged home of our dreams!

The home of the future will blur the existing lines that we draw
between different types of devices. And, if at all we’re forced to
divide the digital content, it can only be into audio and video—only
because that’s how we as humans experience multimedia content. 

The demarcations between PCs, PDAs, TVs, audio systems, etc,
will be obliterated forever, as it isn’t really important to us what
we’re interfacing with; what’s more important is that we get the
content we desire, and are able to compute and communicate via
the audio-visual devices at will.

The box “Believe It Or Not” on page 60 points you towards some
more devices that we can expect to see in the near future.
Technology, of late, has become boring. It’s true! All we could see
happening over the past decade was CPUs getting faster, and hard
disk sizes increasing, but nothing groundbreaking. Now, thankfully,
we seem to be past this stagnation, and have started climbing again—
the next 10 years promise tons of exciting changes, not just in tech-
nology, but in the way we lead our lives! 

robert_smith@thinkdigit.com

1 col Ad
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One of the first definitions of convergence
came from Nicholas Negroponte: “Bits co-
mingle effortlessly. They start to get mixed

up and can be used and re-used separately or
together. The mixing of audio, video, and data is
called multimedia. It sounds complicated, but it’s
nothing more thanco-mingled bits.”

Negronte pointed out in his 1995 bestseller
Being Digital that our world is fast exchanging the
trade in atoms for the trade in bits. In other
words, he has been a big proponent of the ‘bit
switch’—the idea that we’re moving from produc-
ing and distributing atoms in the form of prod-
ucts to producing digital things in the form of bits
that get pushed around the world.

We present two columns Negroponte wrote for
Wired magazine—‘Wearable Computing’ and ‘Bits
And Atoms’. These columns read as well today as
they did when they were first published.

Wearable Computing
The digital road warrior’s kit—laptop, cell phone,
PDA, and pager—is just capable enough to bother
you everywhere without necessarily helping you
anywhere. It’s absurd that each device is still on
such poor speaking terms with the others. We
walk around like pack horses saddled with infor-
mation appliances. We should be in the saddle,
not under it.

The Evolution Of Softwear
More than 20 years ago, The Architecture Machine
Group at MIT built a mediaroom based on the idea
that one should be inside a computer rather than
in front of it. While that vision foreshadowed
today’s immersive environments, it did not go far
enough and shrink the room to the size of
a person.

In the future, the PC will be blown to bits,
many of which, naturally, should be kept near you
rather than in your home or at your office. But so
far, software has not been particularly soft.
Though bits are as insubstantial as the ether, they
tend to be packaged in hard boxes. For hardware
and software to comfortably follow you around,
they must merge into softwear. Developing wear-
able computing requires as much attention to the
medium as the message.

In fact, the medium becomes the message.
What single manufactured material are you

exposed to the most? The answer is fabric. We wear
it, stand on it, sit on it, and sleep in it. Marvellous
technology goes into looms, but all we ask fabric to
do is protect us from the elements, look pretty, and
not wrinkle or shrink. Can’t it do more?

Advances in conducting polymers and
reversible optical media are pointing towards

fabrics that can literally become displays. Amor-
phous semiconductors can be used to make solar
cells to power fabric. Polymer semiconductors are
candidates for wearable logic. The result would be
the ultimate flexible computer architecture. Fash-
ion accessories will take on new roles, becoming
some of the most important Internet access points,
conveniently surrounding you in a Person Wide
Web. How better to receive audio communications
than through a earring, or to send spoken
messages than through your lapel?

Footwear is particularly attractive for comput-
ing. Your shoes have plenty of unclaimed space,
receive an enormous amount of power (from walk-
ing) that is currently untapped, and are ideally
placed to communicate with your body and the
ground. When you come home, your shoes can talk
to the carpet in preparation for delivery of the day’s
personalised news to your glasses.

Nicholas Negroponte is founder and director of the Media Laboratory
at the Massachusetts Institute of Technology, Cambridge, USA

“Computing is not about
computers any more. It is
about living.”

Of Bits, Atoms,
And Softwear
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The Body Bus
A wearable computer will be useless if you have to
walk around looking like the back of your desk.
Fortunately, bits are more than skin deep. Tom
Zimmerman has shown that the non-contact
coupling between your body and weak electric fields
can be used to create and sense tiny nano-amp
currents in your body. Modulating these signals
creates Body Net, a personal-area network that
communicates through your skin. Using roughly
the same voltage and frequencies as audio trans-
missions, this will be as safe as wearing a pair of
headphones. Keeping data in your body avoids the
intrusion of wires, the need for an optical path for
infrared, and conventional problems such as regu-
lation and eavesdropping.

Your shoe computer can talk to a wrist 
display and keyboard and heads up glasses. Activat-
ing your body means that everything you touch is
potentially digital. A handshake becomes an
exchange of digital business cards, a friendly arm
on the shoulder provides helpful data, and picking
up a phone downloads your numbers and voice
signature for faithful speech recognition.

Cyborgs
Cyborgs are here already. No, this isn’t a paranoid
fantasy about intruders from the future. Two
cyborgs have been roaming the Media Lab, wearing
computers day in and day out for over two years. It’s
an uncanny experience teaching a course to Thad
Starner, who is simultaneously watching you lecture
and annotating the lecture notes behind you
through Reflection Technologies’ Private Eye, a
wearable heads-up display.

Steve Mann goes further, wearing a completely
immersive system: movable cameras connect to a
computer and transmitter to send video to a work-
station for processing and delivery back to displays
in front of his eyes.

This lets him enhance what he sees (he likes
living in a ‘rot 90’ rotated world) and position his
eyes. (Some days he likes having his eyes above his
head, or at his feet, and when he rides a bicycle he
sets one eye looking forward and one backward.)

He can assemble everything he’s seen into larger
mosaics or 3-D images, and through the radio-
frequency link you can see through his eyes (at
www.wearcam.org).

Don’t expect to see much computing featured
in Bill Blass’ next collection, but this kind of digi-
tal headdress will become more common. Bear in
mind that 20 years ago, no publisher anticipated
that teletype terminals would grow into a portable
threat to books, that paper tapes would merge
with film into multimedia CD-ROMs, or that tele-
phones would threaten the whole business model
of publishing by bringing the Web into your home.

The difference in time between loony ideas and
shipped products is shrinking so fast that it’s now,
oh, about a week.

This article was co-authored by Neil Gershenfeld, an
MIT professor and one of three co-principal investiga-
tors of the Media Lab’s newest research consortium,
Things That Think.

© 1995 Nicholas Negroponte. Reprinted with permission
from the author.

1/2 pg V AD



66 DIGIT JUNE 2005

4 Years Of Tech

Bits and Atoms
The $400 Limit Applies To Atoms Only
When returning from abroad, you must complete a
Customs declaration form. But have you ever declared
the value of the bits you acquired while travelling?  To
Customs officers, the value of any diskette is the same—
full or empty—only a few dollars; the value of the atoms.

I recently visited the headquarters of one of the top
five integrated-circuit manufacturers in the US. I was
asked to sign in and, in the process, was asked whether
I had a laptop with me. I did. The receptionist asked for
the model, serial number, and the computer’s value.
“Roughly US$1 to $2 million,” I said. “Oh, that cannot
be, sir,” she replied. “What do you mean? Let me see it.”

I showed her my old PowerBook, and she estimated
its value at $2,000. She wrote down that amount and I
was allowed to enter.

Our mindset about value is driven by atoms. The
General Agreement on Tariffs and Trade is about atoms.
New movies and music are shipped as atoms. Compa-
nies declare their atoms on a balance sheet and depre-
ciate them according to rigorous schedules. But their
bits, often far more valuable, do not appear. Strange.

Atoms Are Judged Less Greene 
Than Bits
When Judge Harold Greene broke up AT&T in 1983, he
told the newly created regional Bell operating compa-
nies that they could not be in the information business.
Who did he think he was fooling? The seven sisters were
already in the information business and doing just fine,
thank you. Their largest margins were—and still are—
from the Yellow Pages, which they have sold at great
profit. Judge Greene, sir, the companies are and always
have been in the information industry. What are you
talking about?

What the judge is saying is that the companies have
every right to kill thousands of trees, to litter our
homes, and to fill garbage sites with their information
business, as long as this information is in the form of
atoms. But as soon as the companies deliver the exact
same information with no-deposit, no-return, environ-
mentally friendly bits, they have broken the law.

Doesn’t that sound screwy? Was anyone thinking
about the meaning of ‘being digital’ during the time
that AT&T was being disassembled? I fear not.

Pay Per View
During a speech I gave at a recent meeting of shopping
centre owners, I tried to explain that a company’s move
into the digital future would be at a speed proportion-
ate to the conversion of its atoms to bits. I used video-
cassette rental as an example, since these atoms could
become bits very easily.

Wayne Huizenga, Blockbuster’s former chairman,
was the lunch speaker. He defended his stock by saying,
“Professor Negroponte is wrong.” His argument was
based on the fact that pay-per-view TV has not worked

because it commands such a small piece of the market.
By contrast, Blockbuster can pull Hollywood around by
the nose, because video stores provide 50 per cent of
Hollywood’s revenues and 60 per cent of its profits.

I thought about Huizenga’s remark and realised
that this extraordinary entrepreneur did not under-
stand the difference between bits and atoms. His
atoms—videocassettes—prove that video-on-demand
will work. Videocassettes are pay-per-view TV. The only
difference is that in his business he can draw as much
as one-third of the profits from late fees.

Library Of The Future
Thomas Jefferson introduced public libraries as a funda-
mental American right. What he never considered was
that every citizen could enter every library and borrow
every book simultaneously, with a keystroke, not a hike.
All of a sudden, those library atoms become library bits
and are accessible to anyone on the Net. This is not what
Jefferson imagined. This is not what authors imagine.
Worst of all, this is not what publishers imagine.

The problem is simple. When information is embod-
ied in atoms, there is a need for all sorts of industrial-
age means and huge corporations for delivery. But

suddenly, when the focus shifts to bits, the traditional
big guys are no longer needed. Do-it-yourself publishing
on the Internet makes sense. It does not for paper copy.

Markoff-On-Production
It was through The New York Times that I came to know
and enjoy the writing of computer and communica-
tions business reporter John Markoff. Without The New
York Times, I probably would not have been introduced
to him. However, now it would be far easier for me to
collect his new stories automatically and drop them
into my personal newspaper or suggested reading file.
I would be willing to pay Markoff five cents for
each of his new pieces.

If one-fiftieth of the 1995 Internet population
subscribed to this idea, and Markoff wrote 20 stories a
year, he would earn $1 million, which I am prepared
to guess is more than The New York Times pays him. If you
think one-fiftieth is too large a percentage, then wait
awhile. Once someone is established, the added value
of a distributor becomes less and less in a digital world.

The distribution and movement of bits is much
easier than atoms. But delivery is only part of the issue.
A media company is, among other things, a talent
scout, and its distribution channels, bits or atoms,
provide a testbed for public opinion. But after a certain
point, the author may not need this forum. In the digi-
tal age, Wired authors can sell their stories direct and
make more money, once they are discovered.

While this does not work today, it will work very
well, very soon—when ‘being digital’ becomes
the norm. 

© 1995 Nicholas Negroponte. Reprinted with permission
from the author.

“Our mindset about value is driven by atoms. Movies ship
as atoms. Companies declare their atoms on a balance
sheet. But their bits, far more valuable, do not appear.”[
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Sanket Naik

After a decade of blank and weightless
proclaims, the age of digital convergence has
finally dawned upon us. With industry

bigwigs including Intel, AMD, Sony and Microsoft,
to name a few shifting to solution-centric strategies,
digitally converged products are making it to the
mass markets—slowly, but steadily. 

Digital convergence is bringing three major
industries together—the IT industry with its hard-
ware and software expertise, the consumer elec-
tronics industry—deeply rooted into entertainment
and the telecommunication industry that enables
short to long range communications. 

Such a diverse communion results in the manu-
facture of extremely versatile products that
combine the best of technologies from all three
sectors. Just a few years ago, cell phones that
doubled as digital camera, audio/video players or
gaming consoles that transformed into a media-
centric device were unthinkable. But now, they
seem to be the imminent future. 

Rapid developments in technology leading to
faster chips, higher bandwidth buses and broad-
band communication are proving to be the major
driving factors behind the convergence trend; not to

mention the warm-hearted acceptance from
consumers who are always on the lookout for that
something new. 

In this article, we bring to you some of the
coolest products that incorporate cutting-edge tech-
nology and convey the very essence of digital conver-
gence in their own unique way. 

Oakley Thump
Oakley’s Thump is the coolest converged product
that combines fashion with technology in a
unique way of its own. While audio players have
been built into watches, headphones and cell
phones, Thump is the first audio player to be built
into sunglasses. 

The Thump is made out of lightweight durable
plastic and is hence suitable for use all day long. The
lenses can be flipped up, making it possible for the
shades to be used indoors without skipping on
listening to your favourite music.  

The earphones are well-placed and highly
adjustable. They can be rotated, extended or raised
to fit any ears without much discomfort. The
controls are placed on the two arms of the shade. 

Buttons on the left side are for volume control
while those on the right are for Play/Pause/Power
and Skip/Shuffle. Songs are played back either in
the order they are copied or alphabetically. There

Converged Accessories

The stuff
dreams are
made of…
for geeks
anyway!
Presenting
the best of
the
converged
devices
available
today. A
word of
caution:
Highly
obsessive!

Ultimate
Converged Accessories
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are also some pre-configured equalisers
to be cycled. 

On the specifications front, the
Thump is available in two versions—128
MB and 256 MB. The Thump supports
MP3s, WAV and DRM protected WMA
audio formats. A USB 2.0 port is provided
for faster transfer of songs and it is even
backward compatible with USB 1.1. 

A non-removable Lithium-ion battery
provides the necessary juice for keeping
the audio player running for the claimed
six hours. But, with prices starting at $400
(Rs 17,400) for both versions, Oakley’s
Thump isn’t for shallow pockets. 

Fossil PDA Watch
Dick Tracy fans will love Fossil’s wrist PDA
watch. This rather ‘cute’ looking device
harbours a fully functional PDA based on
Palm’s OS 4.1. Looks wise, it is hardly
distinguishable from a traditional wrist-
watch, but speak of functionality, and it has
enough features to beat the most hectic
schedules without missing any events. 

The PDA watch is powered by a
Motorola Super VZ 66 MHz Dragonball
processor and has 8 MB of RAM; enough
for hourglass-free operation! The petite
touch screen display has a 160
x 160 pixel resolution offer-
ing 16-level greyscale depth
and backlighting for view-
ing in dark.

Inbuilt applications
include an address book for
contact management; a date
book for scheduling; a To Do
list; a Memo Pad for taking
notes; a calculator. And yes,
it also tells time. 

These applications apart,
the watch can run most
Palm software; however,
Fossil recommends using
specially designed applica-
tions to take advantage of
the watch navigation
system, a rocker switch and
larger font set.

For connecting with the PC, the watch
comes with a USB port and an Infrared
transceiver for communicating with other
Palm devices. Power is derived from an
internal rechargeable Lithium-ion battery.
Fossil claims a battery life of three to four
days provided you use it for 30 minutes a
day without backlight and IR. 

Priced at $249 (Rs 10,900), Fossil’s PDA
wristwatch costs as much as a decent PDA
from Palm. But it’s the size that distin-
guishes it from the rest. Now, does size
really matter?

Adidas_1
Sportswear giantAdidas, a synonym for
high quality footwear has introduced a
shoe for the geek. The Adidas_1 was
conceptualised around 2001 and after

slogging for all these years, Adidas
finally managed to get in on the tarmac.
So what’s tech got to do with a shoe?
Well, this is the first shoe with an embed-
ded microprocessor that adapts the shoe
cushioning based on the terrain and the
user’s demand. 

While the fact is that no two runners
have the same physical characteristics,
the same pair of shoes can’t always
provide the necessary comfort to both.
To tackle this problem Adidas_1 can
dynamically change the cushioning
depending on the terrain, your weight
and the speed, to provide the right
amount of comfort. 

The shoe has a magnetic sensor
placed in the heel and monitors any
changes in weight, pace and surface type
at a rate of 1,000 times per second. This
information is then fed to a micro-
processor, the brain that determines
whether the cushioning is in the ideal
zone. If the cushioning is not right, the
microprocessor sends a signal to a motor
that is connected to a cushioning cylin-
der in the heel to either relax or tighten
depending on whether soft or firm cush-
ioning is required. 

There are two buttons on the sides of
the shoe, which are required to be
pressed simultaneously to switch on the
active cushioning system. Moreover,
there are five preset levels of cushioning
that can be achieved using these two
buttons. A small battery powers the
entire system and is located under the
foot soles of each shoe. 

Priced at $250 (Rs 10,875), the Adidas_1
are a really expensive pair of shoes. Would
you really want to get them dirty?

O’Neill’s H2 Series Backpack
Energy source is a persistent problem
with many portable computing products
such as MP3 players, cell phones and
other electronics devices. The built-in
rechargeable batteries can hardly hold
fort for a day and if you are the adven-

Running just got high-tech, thanks to the Adidas_1
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turous type, this problem is simply compounded
by the lack of access to electricity. 

Your prayers seem to have been answered.
O’Neill’s H2 series of backpacks is what you should
be looking at. The H2 series integrates two flexible
solar panels with necessary electronics to control
communication and entertainment devices. 

The solar panels generate power during
favourable lighting conditions and supply it to your
iPod, mobile phone and integrated Bluetooth module
via a USB connection. The system also has an elec-
tronic board that senses which device is
in the most need of power and
smartly allocates it accordingly. 

Apart from the solar panel,
the backpack also has an inte-
grated Bluetooth module for
handsfree calling. A microphone
is built into the left shoulder
strap and a universal headphone
jack is integrated in the chest
pocket. Moreover, when you get a
call, the iPod is automatically
paused till the call ends. 

Both—the iPod and Bluetooth
module—is stowed away in discrete
water-resistant compartments. A
soft, washable, fabric control
panel is placed on the left shoul-
der strap to control playback of the
iPod without having to reach for
the device deep inside the pack.   

The backpack is constructed from ultra-light and
strong nylon for maximum durability. The pack also
incorporates a snowboard carry system, shovel stash
and compression straps. Prices are not yet out, but
we fear they will be astronomical. Adventure calls!

HP ep9012 Instant Cinema
Digital Projector
The ep9012 from HP is an all-in-one projection solu-
tion for home users combining the ambience of a
projector, fidelity of a 2.1 sound system and the
versatility of a DVD player. 

The projector is based around DLP technology
and delivers sharp and crystal clear images. For
better colour saturation and depth, a six-segment
colour wheel makes into the projector. The 840
lumen built-in lamp offers enough brightness and
contrast for big screen viewing at home. 

The integrated DVD player can play DVD-video
and DVD±R/RW straight from the projector. 

The DVD player also supports VCD, SVCD, CD-R,
CD-RW, CD-audio and MP3 audio formats for maxi-
mum versatility. Other interesting features include
playing JPEG files from a CD directly as a slideshow;
just short of allowing direct camera connection.

To complete the cinematic experience, the
system is equipped with a 2.1 speaker system. It has
two speakers on each side, capable of delivering
20W and a third 30W sub-woofer base for bass. For
a full immersive aural experience you can connect
the ep9012 to any 5.1 enabled home theatre system. 

The ep9012 is further equipped with S-video,
composite video, component video, PC DVI and VGA
(via adapter) inputs. To make it future proof the
eop9012 is HDTV ready. Expected price for the
ep9012 is around $2000 (Rs 87,000), so get ready for
a compact home entertainment system.

Microsoft Xbox 360
Microsoft’s soon-to-be-released next generation
gaming console—the Xbox 360—takes convergence
to the next level. While the gaming aspect is at the
core of its design, looking at the specs and the
functionality one can’t argue the fact that it is
more than just a gaming console. 

The new Xbox is supposed to derive its comput-
ing power from a triple core processor running at
3.2 GHz, where each core is capable of running two
threads simultaneously, leading to generation of six

threads at once. Such huge reserves of computing
power means a lot of data can be thrown at the CPU
for the ultimate gaming experience. 

The graphics section is handled by a custom-
made ATI chip with 512 MB GDDR3 RAM and a 10
MB frame buffer. The chip also has 48 Shader units
working on a new Shader language to deliver the
best eye candy ever seen on a console.

Storage is provided via a detachable 20 GB hard
drive which can further be upgraded when you run
out of space. The Xbox 360 comes with a 12X dual
layer DVD drive and will support most formats
including WMA and MP3 CDs. The console also has
two memory unit slots. 

On the I/O front, the console offers three USB
2.0 ports for connecting it to a PC, has an Ethernet
port, is wireless-ready supporting 802.11a, b and g
standards and is video camera-ready. 

Further, you can stream media from portable
devices, digital cameras, Windows XP PCs and can
rip music to the Xbox 360’s hard drive. In also comes
with a Windows Media Centre extender built-in. 

Archos PMA400
Archos Pocket Media Assistant400, as the name
suggests, is a portable media player that also acts as
a digital assistant. Based on a Linux platform, the
PMA400 offers class-leading features in a small and
compact structure. 

The PMA400 can record directly from your TV,
VCR, cable box or a satellite receiver with the help
of a cradle that comes with the package. The
device also allows transferring of media from a
Windows PC or a MAC on to its 30 GB hard drive.
The recording is saved in MPEG4-SP format and
the device can playback MPEG4-SP videos with
soundtrack in MP3 format up to a resolution of
704 x 480 at 30 fps.  

Microsoft’s XBox 360 that’s making waves, and Archos’ PMA400
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On the audio front, the PMA400 can
play MP3, WAV, WMA and DRM-protected
WMA files. The PMA400 can be used as a
Dictaphone using the built-in micro-
phone. It also has a recording application
that can record in MP3 and WMA in real
time from most analogue devices. 

The PMA400 also allows playing of
Qtopia-based games and it also has
Mophun game engine for playing games
based on the format. You can also transfer
your entire photo album can store around
three lakh photographs to be viewed on its
small screen. 

The device is Wi-Fi ready and supports
802.11b standard. You can also connect
using the Infrared and Ethernet port
provided via a USB to Ethernet adapter. 

You can browse the Internet using the
built-in Opera browser and send and
receive e-mails via the integrated e-mail
client. A personal information manager
lets you schedule your meetings and
events just like a PDA, as the PMA 400 has
a touch screen for easy data input. Since
the PMA400 is based on the Linux plat-
form you can customise it by adding new
third-party applications or your own. 

Archos claims a battery life of four
hours for continuous video playback and
nine hours for music playback. Priced at
�800 (Rs 48,000), it’s not cheap but the
functionality demands it.

Samsung SCH-V770 Cell phone
A 7-megapixel camera phone! Yes that’s
what Samsung’s SCH-V770 offers.
Launched at CeBIT 2005, the SCH-V770
ushers in a new era of true digital photog-
raphy convergence in cell phones.  

While most cell phones today offer
cameras with primitive features, the 7
mp camera on the SCH-V770 has a level
of sophistication seen on standalone
digital cameras with 7 mp sensor. Boast-
ing impressive features such as 3x opti-
cal zoom and 5x digital zoom and
auto-focusing, it should offer good
results. The SCH-V770 can also attach to
a wide-angle and tele-conversion lenses,
a first for any mobile phone. 

Other inter-
esting firsts on a
cell phone
include the
manual control
of the camera.
The SCH-V770
allows manual
adjustment of
focus, shutter
speed and auto
exposure lock. It
also offers shut-
ter priority, aper-
ture priority and
fully manual
options for expo-
sure control.    

The display on the SCH-V770 uses a
new TFD (Thin Film Diode) LCD that
ensures QVGA resolution on the small
display size. The screen can reproduce a
breathtaking 16 million colours to give
lifelike pictures. 

Video-on-demand (VOD) and music-on-
demand (MOD) are the other new features
that are available on the V770. It also
supports a TV-out function for viewing
those photographs on a TV set. 

For storing the pictures, the phone
comes with a 32 MB MMC Micro apart
from the internal memory. The set is
supposed to go on sale later in the year,
so stay connected. 

BMW 3-Series Cars
BMW is a name that epitomises opulence
and performance in cars and does not shy
away from using the best available tech-
nology so they go faster, handle better
and have the best safety and comfort.  

The 3-Series from BMW has been a
favourite among techies for its practical-
ity and sporty character. The new 330 is
packed to the gills with technology.

Under the hood, you have a magne-
sium and aluminium composite engine
block fitted with BMW’s Valvetronic
ignition system that digitally controls
the ignition to improve the car’s power
and fuel efficiency.  

BMW’s iDrive system is a digital inter-
face that manages a lot of functions such
as GPS navigation, Internet access, BMW
Assist System in case of emergencies,
climate controls and the stereo functions.
The interface is operated via a knob and a
small in-dash LCD display. and can also be
controlled via voice commands. 

Full control over the internal climate is
also provided. The windshield has built-in
sensors that can detect rain, mist and can
automatically switch on the wipers.  

The car is also equipped with radar-
based cruise control and, once set, it keeps
the car at a safe distance from other vehi-
cles even in high traffic. We didn’t even
dare ask the price! 

sanket_naik@thinkdigit.com

Samsung’s revolutionary 7-megapixel camera phone—the first-of-its-kind to
be launched
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Convergence is, generally speaking, a good
thing, and converged gadgets are supposed to
make life easier for us. But not all converged

products are good. Some, in fact, never made it to
market. Others did and flopped.

It’s not just about the products themselves being
good or bad. It sometimes turns out that a good idea
is not well-received by the market. It’s a different
story with each converged device that turns out to
be an also-ran. No-one can pinpoint why some
tack-ons, such as the phone-cum-PDA, become the
norm, while others, such as the TV-VCR combo,
never gain momentum.

Here, we take a look at some products
that seemed to have been driven by market
forces pointing towards convergence, but never
became bestsellers.

Silicon Film Technologies’ (e)film
Silicon Film Technologies’ (e)film held the promise
of changing regular film cameras into digital ones.
This might have been a great product, because it
would mean savings for people who already owned
regular SLRs and didn’t want to invest in a brand-
new digital camera.

EFS-1, a ‘digital film insert’, was an electronic film
cartridge that slipped into the back of an SLR camera

body. The (e)film cartridge could capture up to 24
1.3-megapixel images. You were supposed to be able
to use your SLR the way you normally did—with the
lens, filters and accessories. Your SLR camera could be
loaded with (e)film, and any of its accessories could
be changed without much trouble.

Since 24 images is generally considered insuffi-
cient, you could invest in an (e)box, where the
images could be downloaded—after which you
could continue shooting.

The product was expected to hit the market
around 2001, but is yet to do so. What went wrong
is not clear. But what’s also at question is the util-
ity of (e)film: would the captured images be as good
as those captured by a digital SLR? And with costs
of digital SLRs—as well as those of regular digital
cameras—dropping, is there a place in the market
for such an innovation?

This is, ultimately, an apparently good idea
that didn’t seem to have stood up to the scrutiny
of the market.

The TV-VCR Combo
A TV-VCR combo is not be such a good idea, for
multiple reasons. There are, in the market today,
CRT TVs, LCDs, plasma displays, projection TVs, and
more. VCRs—yes, don’t forget the good old VCR!—
also have multiple features such as super-fast
motion, slow motion, freeze frame, on-screen
programming and so on.

Landing
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So what happens when you take the combo? Do
you get the best of both worlds? The simple answer
is no. Manufacturers choose a TV model and a VCR
model, and just put them both together. The
converged product does not offer you as much
variety as the individual ones do.

If there are five VCR models you could choose
from, and ten TV models, and the features in each
of these are to be combined in the new offering, the
permutations and combinations are limitless. What
is a manufacturer to do? You are, ultimately, stuck
with a model of TV that you like somewhat, and a
model of VCR that you like somewhat. Here, it’s a
case of too little choice, unlike with most converged
products where the choices seem overwhelming.

Web TV
Television and the Internet have been on a collision
course for a long while now—the idea of converging
the two into something useful has been doing the
rounds for some time. Microsoft’s WebTV, which was
brought to market around April 1997, is still strug-
gling to get noticed. Time Warner’s AOLTV, a combi-
nation TV and Internet service, included a TV-like set
with a keyboard and remote. It was to enable
consumers to watch regular TV and access the Web
at the same time.

So what happened? AOLTV has many features
such as a program guide and the facility to record
shows or remind you when they’re
on the air. You could watch
programmes while simultane-
ously browsing the Web,
exchanging instant messages,
chatting about a show or send-
ing e-mail. However, the service
was extremely slow and clumsy.
It was priced at $249 (Rs 10,800),
which included the set-top box,
wireless keyboard and remote.

Installation was a painful
task. On most Web TVs, it was
difficult to get a TV program and
a Web page on the screen at the
same time, though that’s supposed to be the prime
feature. Another point is that the picture quality
on TV and that of Web pages is, of course, differ-
ent—most TV screens produce pictures that are 544
pixels wide, while PCs have at least 800-pixel reso-
lutions. So when you try to fit a Web page on a TV
screen, the text becomes difficult to read.

E-book readers
Passionate book lovers would have embraced e-book
readers whole-heartedly if only it offered the same
reading pleasure that a paperback does. There are
quite a few in the market, but it is still difficult to
find one that serves the purpose satisfactorily.
E-book readers, though a good idea, never took off
in a big way.

Many factors contribute to choosing a good e-
book reader. First comes cost, not only of the reader,
but of the downloaded books as well. Size, weight
and ergonomics also contribute to the decision to
purchase the reader. Then there’s readability, clar-
ity, glare, and the reader’s ability to handle different
fonts and symbols. Low resolutions make the type
look strange; reading in sunlight is also difficult.

One example of an e-book reader is the REB
1100, introduced by electronics giant RCA. The
company stopped promoting the product for
reasons unknown.

Sony eVilla
Sony Corporation’s eVilla was an Internet appliance
that fit on kitchen counters, and enabled users to
surf the Internet, send e-mail, and store music. The
eVilla featured a vertical 15-inch monitor, ran on
the BeIA operating system, had a memory stick
reader instead of a hard drive, and had two USB
ports for connecting to Zip drives and printers.

Priced at $500 (Rs 21,750), the eVilla weighed
nearly 32 pounds, and was 16 inches in depth.
In fact, the manual had directions on how to lift
the device!

The product was launched around June 2001,
but was hastily withdrawn from the market two
months later. Although no clear reason was given
by the company, a spokesperson attributed the
withdrawal of the product to “falling short of our
initial expectations with regard to stability and
usability”.  The operating system also could not
cope with the network demands placed on it.

The CueCat 
The things companies do to be called ‘the first’ or
to gain attention is best demonstrated by the

CueCat. When it was launched
towards the end of 2000, the
product was highly lauded. Digi-
talConvergence, the company,
designed the CueCat as a cat-
shaped barcode scanner about
the size of a candy bar.
Customers could attach CueCats
to their PCs, and the device
could read barcodes at the
back of products. When a
customer swiped one, the
CueCat directed the user’s
browser to a Web page with
information about the product.

The designers also envisioned that the CueCat
would read barcodes in newspaper and magazine
articles, and take readers to related stories on the
Internet. The problem: not many people thought
that a product that only scanned bar codes was
worth investing in.

What Next?
Silicon Film Technologies, Sony and DigitalCon-
vergence may argue, “at least we tried”; but they
confused what was possible with what is useful.
Companies may churn out converged products by
the dozen, but demand will be decided only by
the usability and efficiency that the products
have to offer.

Moreover, these products were driven by
market demand more than the actual evolution,
if you like, in the lab. They will, therefore, always
remain stop-gap options until the real thing is
developed. A cut-paste job will not get conver-
gence far. It will only mar the image of conver-
gence in general, and make the consumer wary of
the next device that will be launched.

preethi_chamikutty@thinkdigit.com
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Varun Dubey

James Bond is the flamboyant secret agent who
almost always seems to be able to dodge certain
death, and always manages to find time off from

saving the world to romance some of the most beau-
tiful women on the planet! But the women, the
death-defying close shaves, or the martinis—shaken,
not stirred—are not the only things that constitute
Bond’s aura. 

Most of us salivate over the gadgets he uses,
perhaps even more than we do over the women in his
company. That’s where Bond fits into this special
issue that celebrates convergence: many Bond gadg-
ets reek of convergence. They’re smart, they’re multi-
functional, and they talk to other gadgets. The
makers of the Bond movies do seem to have put some
effort into envisaging a converged world—although,
of course, it was necessary that only Bond, and no-
one else, had the gadgets!

We plunge into the wonderland of Bond’s
gadgetry, and analyse what is possible in the real
world and what will remain in the reel world.
We’ve rated all gadgets by a ‘Coolness Quotient’
based on how much we’d love to own one of them,
and also a ‘Plausibility’ score, based on how likely
it is that such gadgets can be made available.
Scores are out of five.

Gadget: Briefcase
Movie: From Russia With Love
This was the first gadget the Quartermaster—or Q—
gave James Bond. The briefcase held an AR7 foldable
sniper rifle, 40 rounds of ammo, a tear-gas cartridge
disguised as a tin of talcum powder, some money in
the form of 50 gold sovereigns, and concealed
throwing knives.

Plausible?
Yes, but we need to ask: with all that equipment
inside, how did Bond manage to carry it around? Ten
on ten for Q’s packing skills—but we’ve got to subtract
a few for the sheer craziness of lugging around some-
thing so heavy and trying to save the world while
you’re at it!
Coolness Quotient: 2.75
Plausibility: 4.5

Gadget:  Mini Breather
Movies: Thunderball, Die Another Day
This gadget, slightly larger than a pen, allowed Bond
to breathe underwater for about four minutes.

Plausible?
This is one of Bond’s gadgets that fall in the ‘fantastic’
category. To get to hard facts today, a four-litre scuba
tank will give you 30 to 35 minutes of breathing air,

Dr Connected”
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over the
gadgets
Bond uses—
and many
of them
reek of
convergence

“The Name Is Connected.
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and the smallest tank today is still as big as a cola can—
and will provide only two minutes of breathing. Sorry
Mr Bond—this doesn’t gel with reality.

Having said that, we must give credit where it
is due—hats off to the guys who thought this up.
When Bond’s engineers came up with this kind of
portable design, portable air tanks had not yet
been invented!
Coolness Quotient: 4
Plausibility: 2

Gadget: Omega Watch
Movies: Golden Eye, The World Is Not Enough
This beautiful Omega Seamaster is a collector’s item
in itself, but of course, for Q, and hence for Bond,
beauty is not enough. By the time Q was done with
it, this watch boasted of a high-power laser diode that
could cut through two inches of steel! It also featured
a button that could arm or disarm any deployed
magnetic mines.

In The World Is Not Enough, the gadgetry is
enhanced, and the watch incorporates a miniature
grappling hook including a 50-foot high tensile micro
filament, which could support a massive 800 pounds.
Q also incorporates dual high-powered lasers into the
design, and the casing is made of titanium.

Plausible?
Well, a lot of Omegas do come with a titanium body,
but that’s pretty much where the semblance to real-
ity ends. Even if you could incorporate a high-
powered diode into the watch, where would all the
power come from? And let’s believe that the wire fila-
ment can hold 800 pounds of weight, let’s also
suppose that the watch strap can withstand the same
weight—we still fail to see how it's possible for a
human wrist to take that much stress! Also, we think
it’s improbable that any 800-pound people would
want to scale 50-foot walls! 

Here, audience intelligence seems to have been
ignored, and this watch, though absolutely cool,
remains in the reel world.
Coolness Quotient: 3.5
Plausibility: 1

Gadget: Bell Textron Jet Pack 
Movie: Thunder Ball
The pack strapped on to the user’s back like a back-
pack, and was the size of about two scuba tanks, filled
with propellants and a turbine thruster. With this

thing strapped on, the user could fly at extremely
fast speeds to a height of 600 feet!

Plausible?
Oh yes! It sounds fantastic, but not only is it possible,
it was, in fact, a working prototype on loan from the
US Army. It can carry a person over nine metre-high
(30 foot-high) obstacles at a speed of 11 to 16 kmph.
Now that’s what we call a flight of fancy!
Coolness Quotient: 4
Plausibility: 5

Gadget: Latex Fingerprints
Movie: Diamonds Are Forever
These false fingerprints were like latex stickers. Finger-
prints were taken on hot latex, which was then
allowed to cool and set in shape. You could stick it on
to your fingers and assume a whole new identity!

Plausible?
Absolutely. Details of how to fake fingerprints are
easily available on the Net, and all you need is
things available in your own home. Of course, it’s
illegal to fake fingerprints!

Recently, a study from Yokohama National
University in Japan showed that phoney fingers
concocted from gelatine, called ‘gummy
dummies’, were able to trick quite a few
fingerprint systems.
Coolness Quotient: 3
Plausibility: 5

Gadget: Watch/Ticker Tape
Movie: The Spy Who Loved Me
The ultimate in faxing, this watch had an inbuilt
satellite link. MI6 could send Bond short messages
that would then be printed out on a spool of tape.

Plausible?
Not really. If you have ever seen a fax machine, you’ll
know that if it was possible to make the unsightly
device any smaller, it would already be in mass
production.

But the possibilities are interesting. Imagine a
news report, or stock market updates, being spat out
of your watch on ticker tape. You’d have to be careful
to not trip on the tape though…
Coolness Quotient: 3.5
Plausibility: 1

Left: Fake latex fingerprints from Diamonds Are Forever; Right: The AR7
foldable sniper’s rifle and the briefcase from From Russia With Love

The Bell Textron Jet Pack Bond used in Thunderball
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Gadget: Pen Grenade
Movie: Golden Eye
Perhaps the most clichéd of spy gadgets—no spy is
complete without one! The pen looks like any
other pen, but is actually a Class 4 grenade. You
click the pen thrice (careful, fidgety people!) to
activate the four-second detonation timer. If,
within the four seconds, you click the pen thrice
again, the bomb is deactivated. Here’s one pen
that’s mightier than the sword for sure! Since
Hollywood has done this gadget to death, not
many people find it cool any more.

Plausible?
Well there is nothing against this really, except for
how much of explosive you could store in such a tiny
device—which leads to the question of whether
any serious damage could be caused by such a
small explosion.
Coolness Quotient:1.5 
Plausibility: 1.5

Gadget: Digital Camera
Movie: Golden Eye
Now this is a really cool gadget: a high-res camera
that could send pictures directly to MI6 headquarters
using a satellite link.

Plausible?
Why not? Many handhelds of today (the O2 XDA II,
Treo, and more) have Wi-Fi connectivity. All a camera
manufacturer needs to do is put in a Wi-Fi chip to
connect to a network. From there on, you can e-mail
the image just like you do from a regular cell phone.
In fact, the Nikon D2H is already Wi-Fi-enabled!

The only problem might be the size of a high-reso-
lution image. That apart, it would be cool to be able
to send pictures to everyone the minute they’re
clicked! In fact, you could send them to your local
digital studio and pick up the prints on your way back
home! Now that’s the convergence we need to see!
Coolness Quotient: 3.75
Plausibility: 5

Gadget: Ericsson Mobile Phone
Movie: Tomorrow Never Dies
Once Q was done with this phone, it was equipped
with a stun gun capable of delivering a 2,000 volt elec-
tric shock (activated by pressing ‘Recall 3’), a finger-

print scanner for breaking into safes, and a mini
screwdriver that appeared when the antenna was
removed. The phone opened up like a book to reveal
a small LCD screen and disc-tapping the disc twice
would start the car, and moving the fingers on the
disc would drive the car!

Plausible?
Well, apart from the 2,000-volt shocker and the
fingerprint scanner, everything else is plausible—the
technology of today would certainly let you do it.

As for the 2,000-volt shocker, we wonder what
batteries were used! God help Bond if he spilled one
of those shaken-but-not-stirred martinis on himself!

It isn’t too difficult to incorporate the driving
through a cell phone though; most Mercedes cars
employ drive-by-wire, wherein everything is
computer-dependent and controlled, and whether it
receives the instructions from a pedal or from a cell
phone is immaterial.
Coolness Quotient: 4.5
Plausibility: 3

Gadget: Aston Martin DB5
Movie: Tomorrow Never Dies
Bond has always preferred British cars, and his
preferred mode of travel (when not snatching
enemy cars or running from them on foot!) is an
Aston Martin, in this case, the DB5.

The DB5 featured tyre shredders that could be
extended from the wheel hubs; bullet-proof wind-
shields; a retractable bullet shield that rose from
inside the boot area; revolving number plates that
made the car legal and valid in all countries; a
passenger ejector seat for dispensing of unwanted
hitchhikers; oil-slick dispensers to get rid of
pursuants; smoke screen dispensers; retractable
duel machine guns mounted beneath the head-
lights; rear-mounted duel water cannons for blast-
ing away pursuers; a cellular fax machine,
disguised as a car stereo console; a cellular voice-
mail system; and let’s not forget the refrigerated
glove box for storing a bottle of Bollinger and two
glasses—after all, Bond never knows when a lady
friend might hop in for a spin!

Wouldn’t it be cool if our Maruti 800s could
have some of this gadgetry? To be fair, the cars of
today will let you have a fair bit of the above luxu-
ries—barring the military installations such as
machine guns, of course. Let’s take a look.

Plausible?
Tyre shredders: Not needed in India, as our
government has provided these already; they’re
called ‘roads’!
Bullet-proof windshields: Already a reality in most
cars with flashing red lights on top—Dr Manmohan
Singh has a reinforced BMW Series 5, which can with-
stand rocket-launcher attacks!
Revolving number plates: Though illegal, these are
far from high-tech.

Most limousines already have cable TV and
full communications capabilities. In fact,
some outrageously luxurious models even have
a mini swimming pool and a helicopter
landing pad! For once, Bond was actually behind
in terms of gadgets.
Coolness Quotient: 4
Plausibility: 4.5

Bond has
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preferred
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Aston
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Tomorrow
Never Dies

LLeefftt: Bond spying and clicking pictures with his digicam in Golden Eye; RRiigghhtt: controlling
his BMW 750iL with his Ericsson phone
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Gadget: BMW 750iL
Movie: Tomorrow Never Dies
This was the top-of-the-line BMW at the time. With a
roaring V12 inside, this car also featured not one, not
two, but 12 surface-to-surface missiles on the sunroof!

Coupled with Bond’s Ericsson cell phone, this car
was drivable via the controls on the phone without
Bond being physically present in the car. Such an
expensive piece of machinery would obviously need
to have protection measures built in.

After the security system was activated, anyone
who touched the car would get a rather nasty electric
shock, and if he or she managed to recover from that,
there were tear-gas dispensers incorporated as well.

To let Bond travel ‘no strings attached’, the BMW
logo on the bonnet rose to form a cable snipper! The
car also had metal tyre spikes deployed from under-
neath the rear bumper. The most mundane of the
features were the re-inflatable tyres, which could re-
inflate at the touch of a button after a puncture.

This technology is already in the market, with
tyre companies selling ‘Run Flat’ and self-sealing
tyres, wherein the tubeless tyres can take around 10
punctures and carry on without any problems.

Plausibility
The car is a complete fantasy, except for the
remote-controlled driving and the re-inflatable
tyres. Even the latter seem a little far-fetched
the way they’ve been portrayed in the movie.
Coolness Quotient: 4.5
Plausibility: 1.5

Gadget: X-Ray Specs
Movie: The World Is Not Enough
The stuff that every kid’s dreams are made of! The
glasses are rather stylish (as are all things Bond!) and
very functional. In the movie, they help Bond roam
around a casino scanning for concealed weapons and
inspecting ladies’ lingerie.

Plausible?
Wouldn’t it be simply great if they were plausible?
We’d surely get one of those for our New and Notable
reviews, not to mention a 30 days with… article on it.
But sadly, it’s not to be. X-ray technology works on
the principle of absorption and reflection, a lot like
radar, and it works fine on guns, metals, and, of
course, bones. But not on lingerie—it just doesn’t
reflect anything! 007 gets 000 here.
Coolness Quotient: 5
Plausibility: 0

Gadget: BMW Z8
Movie: The World Is Not Enough
If the BMW Z8 roadster, which can do 0-100 in less
than five seconds, isn’t enough eye-candy in itself,
Q was at it again and added more weapons than
the US carried into Iraq!

The car incorporated surface-to-air missiles,
and a needle-thin sonic beam that let Bond eaves-
drop on conversations in surrounding areas and
buildings. It also had all the equipment from
previous cars—rockets fitted behind headlamps,
remote handset driving, and much more. The car,
using sensors, could drive itself to where the
remote control was located!

Q practically choked it with technology. The
car had the absolute latest in intercepting equip-

ment, surveillance and countermeasures. The car’s
body was redone and fitted with titanium plating
and armour, and a multitasking heads-up display.

Plausible?
Yes. Even the sonic beam technology to eavesdrop
on conversations was available in 1999, when the
movie was released. It’s currently being researched
so it can work by bouncing off  obstacles! The only
thing is, we wonder if the car would really be able
to carry the weight of all the heavy stuff—surface-
to-air missiles included.
Coolness Quotient: 4
Plausibility: 4

Gadget: Aston Martin Vanquish
Movie: Die Another Day
In Die Another Day, Bond was back to his ever-faith-
ful Aston Martin, as in the Vanquish V12.

As always, Q gave it a complete overhaul, post
which the car had two under-hood mounted auto-
aiming machine guns, front-firing rockets behind the
main air intake grille, seat with spring-loaded ejection
system, enhanced waterproofing, under-chassis air
cannons, and central console-mounted controls.

This car was more feature-packed than any of
the previous Bond cars. It incorporated four grille-
mounted rockets plus two machine guns; two
motion-sensing guns hidden under the bonnet;
and spiked tyres for ice driving.

But all this was routine stuff which Bond has
had movie after movie, so Q decided to do some-
thing new—and gave this car the capability to turn
invisible at the flick of a button!

Plausible?
All the regular features of this car are plausible.
And do we need to actually go ahead and state that
a car that turns invisible is not plausible?!
Coolness Quotient: 5
Plausibility: 2

Over the years, James Bond has become synony-
mous with the absolute cutting edge in technol-
ogy. There’s now a controversy over who will play
the next Bond, and with the death of Q, it would
be interesting to see what MI6 can conjure up for
Bond in the next movie. We just hope it is every bit
as entertaining and far-fetched as the devices in
the earlier movies! 

varun_dubey@thinkdigit.com

The BMW Z8 being bisected by Bond’s enemies
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Ram Mohan Rao

Immortality! Mankind’s greatest desire, and the
driving force behind the medical sciences. Utter
the word, and most of us start dreaming of all

the things we could accomplish or the way our lives
would alter if we could live forever; the thought is
surreal. However, immortality, or at least a vastly
enhanced and elongated lifespan, is not entirely
fictitious or far-fetched any more. All mankind
needs to do, is evolve.

We have seemingly hit a plateau on the ladder
of evolution, and it’s time we started climbing
again. It’s time we broke out of the shackles we were
born into, not just in terms of lifespan, but also in
terms of physical limitations. As the Extropy Insti-

tute (www.extropy.org) puts it, “Human beings
achieved ‘civilisation’ thousands of years ago.

Yet, we have not shaken off the ancient tyran-
nies that haunt the human condition. We suffer
physical and emotional sicknesses ending in
decrepitude and death. The primitive parts of our
brain spur us to envy, hate, despair, and kill. Our
philosophies and religions attempt to express our
highest values, yet, we use them to oppress and
control. We use them to crush the world’s complex-
ity into a simplicity that we can clutch to like a secu-
rity blanket for the human condition.” 

The Human Condition
Hundreds, perhaps thousands of things, define the
human condition. We do not communicate effi-
ciently enough—our speech is but glorified grunts
compared to the immense possibilities of direct
brain-to-brain communication. Our experiences are
defined by hundreds of limiting factors such as
distance, time, atmospheric conditions, and so on.
The simple fact is that our minds are evolving, but
our experiences are limited by the imperfect
construction of these vessels called bodies that
carry our advancing brains.

The logical progression would then have to be
the advancement of the physical form. This is possi-
ble using implants and various electromechanical
devices. To put it succinctly, mankind needs to phys-
ically evolve by turning Cyborg.

Mankind?

The
advancement
of the
physical
form is
possible
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implants and
various
electro-
mechanical
devices

Whither

“The body is neither a very efficient nor very durable
structure. It malfunctions often and fatigues quickly; its
performance is determined by its age. It is susceptible
to disease and is doomed to a certain and early death.
Its survival parameters are very slim—it can survive
only weeks without food, days without water and
minutes without oxygen.”

—Stelarc
Principal Research Fellow,

Performance Arts Digital Research Unit,
Nottingham Trent University, England

Illustration Binesh Sreedharan
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The cyborg
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defy death 

The Cyborg
We’ve spoken about cyborgs earlier, in the January
2005 issue of Digit. We laid out a definition, and
spoke about what kind of research is going on in
the field of cybernetics, which, according to Dictio-
nary.com, is “the theoretical study of communica-
tion and control processes in biological,
mechanical, and electronic systems, especially the
comparison of these processes in biological and arti-
ficial systems.”

‘Cyborg’ happens to be short for ‘cybernetic
organism’, and a cyborg, with his (or her) implants
and wirings-up, is neither purely human nor purely
machine; he is a convergent form, and he has the
tools to defy death.

Apart from just living forever as cyborgs, we
could have greatly enriched lives. No more will our
minds, which can traverse vast lengths of space and
time in the blink of an eye, be bogged down by
the physical limitations of speech, language, touch,
sight and other boundaries. 

Wired Humans
Strictly speaking, anyone with an implant of some
sort may be called a cyborg, because his or her body
has been augmented. That includes people with
pacemakers and artificial limbs. An extreme exam-
ple of this is clothing—it can be considered an
augmentation of the skin.

However, we must remember that what defines
a cyborg is that his relations with the universe have
changed, usually for the better. Seen in that light,
while it is true that someone with an artificial limb
has a slightly different interface with the universe,
he is not, in a subjective sense, a ‘true cyborg’. He
experiences, and responds to, reality pretty much
the same way we non-cyborgs do. What, then, do
we mean by a ‘true cyborg’?

We may define a true cyborg as one whose rela-
tions with the universe have changed in a dramatic
way; as one whose body has merged, quite literally
and very significantly, with the mechanical.

So what kind of creature are we imagining? We
can borrow from science fiction and talk about
limbs that can be torn apart and replaced,  eyes that
can pop out of their sockets and have the capability
of zooming in or out, and infrared or ultraviolet
vision. But we can go further, and imagine a being
with add-ons that give him tremendous powers.

For example, this creature would have trans-
mitting and receiving antennas wired to its brain
through which it could communicate directly via
thought; most of its body parts and internal organs
would be replaceable, mechanical and synthetic; its
senses would be augmented in such a manner that
it takes in reality in richer colours than we do; its
implants would give him memory and brain power
far superior to ours. It is this organism we are call-
ing the true cyborg.

Cyborg Experiences
So how would you spend you time as a cyborg? The
same way you do now, except that your reality is
enhanced by a variety of implants and accessories.

All unpleasantness is done away with, and only
desirable experiences pass on through to your
brain. You could have a special interface, exclusively
through which you communicate with the world.
This interface might filter out unwanted people
and conversations; the interface could also enable
the recording of your thoughts and experiences so
that you can play them back later. You could actu-
ally re-live your favourite experiences.

Think about what defines our lives today…
Books and movies? As a cyborg, you could ‘read’

and ‘view’ via your thought receiver antenna, from
a central server common to all of cyborgdom. This
server would record the experiences of all fellow
cyborgs, so there is a much vaster pool of informa-
tion to draw from than what we have now. And the
transmission would be instantaneous, doing away
with the need for spending hours reading a book
or watching a movie.

Social interaction? Already, many people prefer
interaction over the Internet, rather than face to
face. In cyborgdom, there would be no need for any
unwanted interactions; entities could be screened
for suitability, and interactions would be at light-
speed, without the need for elaborate, time-
consuming social customs.

Sex, and other pleasures? If, or when, you felt
the desire for such experiences, you could simply
tap into your experience server, and have the expe-
rience delivered—either as a standalone experience
‘applet’, or in conjunction with a fellow cyborg. As
a matter of fact, there need be no males or females
in cyborgdom; all entities would be equal.

Work? Ah, that lowest common denominator of
all human endeavour! Well, there would be no work
required of the cyborg version of you, since work
only serves to support the being—and in the stage of
evolution we’re talking about, life-support systems,
Matrix-style, would be the norm.

In essence, your life as a cyborg would revolve
around experience; you create your own experience-
space, think and live in it, and are isolated from
nature. You are no longer bound by space and time.

Ethics
According to Kevin Warwick, professor of cyber-
netics at the University of Reading, UK (see his
column Human-machine Convergence on page 86), it is
possible to control nearly every aspect of our
psychology by the means of implants. Stage fear?
Rely on the implant to get rid of it.

In such a scenario, there is bound to be a rush
for these mind and body-altering augmentations.
Will human qualities mean anything any more?

There is nothing, conceptually speaking, to prevent us reaching a state where we augment
all our body parts—limbs and internal organs included
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Every human will be defined by the augmentations
they carry; it will mean the end of jealousy, of the
concept of talent, but will also spell the end of art
and uniqueness. 

To elaborate, we are defined by our all-too-
human qualities such as confidence, motivation,
inhibitions, love, hate, and so on and so forth. In
cyborgdom, these will mean nothing, as we could
simply augment any quality at will. You could
choose to play the guitar as wonderfully as Joe Satri-
ani does, paint like Michelangelo, or bat like Viren-
der Sehwag; all you need to do is choose. You could
choose to alter your feelings so you begin to actually
hate someone you love, or to love someone you hate.
You could even go as far as changing your physical
feeling of heat or cold, and decide to shiver in the
summer and sweat in the winter. The possibilities

are endless, and limited only by the imagination.
Is this ethical? Debates already rage about mind-

altering substances—recreational drugs as well as
prescription medications. What kind of debates
would begin once such implants became available?

Anti-implant advocates would essentially say
that the use of implants is unfair, that it gives an
unfair edge to those who can afford them. In the
beginnings of the rush to the cyborg state, then,
would be another Digital Divide: the implanted rich
and the only-human poor.

Eugenics
Ultimately, all this could boil down to the classic
have and have-not situation, where the rich can
afford to live forever, while the poor die dreaming
of better lives. It could also lead to more serious
scenarios, where implants are restricted to certain
countries or races. Imagine the western world living
forever as cyborgs, with third-world countries
suffering in the human condition. The last thing
mankind needs is another Hitleresque vision, where
someone decides who lives and who doesn’t.

Nature
Do we have an idea about what will happen to the
race if we rush ahead to embrace a wired future? In
fact, do we have an idea, even now, of what it means
to be human? If we have no defining idea what
humanness means, how can we possibly know what
it will be like to lose it?

What has the human race done thus far? We
were born into nature, comprehended and won over
it, and destroyed half the planet. We built inhuman
cities where people lead artificial lives, alienated
from nature; we fell prey to diseases that are caused
because of this disharmony with nature.

What this points to is that even in the purely
human state, we never did comprehend the essen-
tial need for the bond with nature; and so, how can
we expect to understand what will happen when
that bond is broken altogether—as will happen
when we turn cyborg?

Death
Returning to the question of immortality: will we
not be toying with the natural balance of the planet
if people were to live, say, for 300 years or more?
Think overpopulation. And who would decide when
and why someone was to die, if the need arose to
kill off some people when the need to reduce the
population arose?

This has a strong link with what we had to say
about eugenics. Who gets to live, and who gets
killed? Can we comprehend the power structure and
government that would be necessary to manage
such a world, where nature is not in control
any more?

And what if a particular individual decided to
live on indefinitely—would such a life be worth it?
The question is pertinent because that’s where
we’re rushing to: one of the defining qualities of
Utopia in cyborgdom is the possibility of living as
long—and as happily—as one wanted to.

A quote from Anglo-American novelist Susan
Ertz is in order here: “Millions long for immortality
who don’t know what to do with themselves on a
rainy Sunday afternoon.”

This is, of course, one point of view: there are
many who would maintain that immortality is the
way to go. And this is a deeply philosophical ques-
tion as well—whether to die or not. We will not go
into that here. Suffice it to say that such questions
will become more and more pertinent as we move
into the wired future with its extended life-spans.

The ‘Matrix’ Trap
When we achieve the levels of automation required
to support human beings on run-of-the-mill life
support systems, without the need to eat, the
human being will have an option. Some aver that
this will open up the avenues required for people
to finally do what is worth doing: creativity will be
unleashed, entertainment will be on-the-spot, and
the struggle for survival will be gone.

But the cyborg will necessarily fall prey to iner-
tia. He will have the option to choose entertainment
exclusively and indulge in nothing else. He will have
the option to lie in the permanent state of artificial
stimulation of the senses. This raises the spectre of
a Matrix-like situation, where a powerful few govern
the sleeping, experience-immersed majority.

To see how this is a very real possibility, think
again of recreational drugs. It is a known fact that
laboratory rats prefer cocaine to food, and will starve
to death given the option—continually choosing the
offered cocaine rather than the food.

We know very well how strong the drive towards
inertia is. And if the drive towards inertia is so power-
ful, what about the drive to an entertained inertia—

Will we all become “nodes on the Internet,” as Warwick says? The possibility of a
eugenically-enhanced, mass-produced population is real, and very scary
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a world where
one needs to
do nothing,
simply experi-
encing, with
five senses or
more, rich
worlds we
cannot even
describe today?

Such will
be the tempta-
tion that will
face the
cyborg. 

Who will
have power over
them? What
will the politics
of such a situa-

tion be like? There are no clear answers.
The rush to converge with machines may have benign motivations:

a longer, healthier life, free from disease and pain. But there are
hidden dangers that need serious looking-into.

Reality
Thus far, we have spoken as though the ideal cyborg form is indeed
achievable. It may be. But receiving an implant is no simple matter.
Warwick and others have proved that simple implants do, in fact, pose
no long-term problems. But what of more complex ones, those that
interface with the nervous system? We just don’t know yet.

In fact, the order of the day is unanswered questions. What does it
mean to ‘experience’ ultrasonics? Is direct-thought communication
really possible? Will implants, in fact, successfully interface with the
brain, with its billions of neurons? We do not entirely understand
memory; how can we assume that memory augmentation is possible
via implants?

The demand for augmentation will certainly be there when the
time is ripe. As of today, human cloning is banned, but is a very real
possibility. And what an immense demand for human cloning would
be there if and when it were legalised!

In the same way, when implants that interface with the nervous
system become available, there will be tremendous demand. It will
first be for medical reasons, as in restoring sight to the blind. Then
there will be the experimenters—those who will treat such implants
as a method of toying with the boundaries of experience.

Given the socio-economic divides of today, not everyone will have
access to them. However, the experiences of a few will be sufficient to
prove the concept, and make it known what it is like to be a ‘true
cyborg’. What happens if those first reports turn out to be positive?

Whither Mankind?
Warwick and others maintain that cyborgdom is the next, natural
step in our evolution. This, they say, is because we are creating
machines more powerful than ourselves, and the only way to keep up
if they jostled for power with us would be to merge with them. This,
of course, assumes that the machines will have a will of their own,
that they will want to dominate. If that ever becomes the case, turn-
ing cyborg will be the only way to go!

There are other compelling forces that will drive humanity the
cyborg way: the sheer desire on mankind’s part, as we said at the
outset, to overcome our inherent limitations. The desire to cure all
disease permanently, to forever negate Adam’s sin and not have to
work any more. The promise, thus, of a utopian existence.

What direction humanity will take will be determined only after
the first ‘real’ experiments. It’s then that we’ll know what will happen
to mankind, to cyborgdom. We can only hope that we learn a lot more
about what it is to be human before that day arrives. 

ram_mohan@thinkdigit.com 

A typical, very representative artist’s impression of what a half-human, half-machine
organism will look like. Augmentation of the senses is a crucial feature of such impressions

Given the
socio-
economic
divides of
today, not
everyone
will have
access to
implants
that
interface
with the
nervous
system
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If asked to name the two technical advances that
will have a profound effect on society in the
not-too-distant future, my answer would be

clear and certain. 
Firstly, the ability to communicate directly

from brain to brain between humans, which could
be called ‘Thought Communication’. Secondly, the
use of electronic signals, as opposed to chemical,
for the treatment of all sorts of ailments, particu-
larly those that are mental in nature, which could
be described as ‘E-Medicine’.

These two seemingly disparate realisations
have, perhaps surprisingly, a common technologi-
cal base—namely the use of implant technology to
link the human brain directly into the computer
network. Essentially, humans will become nodes
on the Internet. From a cybernetic viewpoint,
signals on the human nervous system and those
in the computer network are interchangeable, and
are effectively one and the same.

The two major advances of Thought Commu-
nication and E-medicine also have commonality,
in the sense, important initial steps have been
taken in the appropriate direction. In both cases,
we are already on the way to achieving the results.

In the case of Thought Communication,
contact has been successfully achieved thus far,  in
the form of radio telegraphic communication that
takes place directly between the nervous systems
of two humans. 

An experiment repeated between two human
brains is merely a matter of time. What will be
interesting then is how swiftly things will move
forward. Will it be a case of telephonic communi-
cation, followed by memory uploads and down-
loads, or will we all learn to think in a new
language—with our original spoken language,
with speech (in general) becoming obsolete? 

It’s important to realise how poorly humans
communicate at present, converting complex elec-
trochemical brain signals into relatively trivial
bursts of pressure waves, by mouth movement,
which is called speech. These waves are picked up
in the ears of other individuals, who in turn, try to
put some sense into the signals they are receiving.

Unfortunately, the understood message is
invariably altered from the original, intended
message, especially when different cultures are
involved. Thought Communication, therefore,
offers a much more powerful, effective, and less
error-prone means of communication.

As was the case with the telegraph, the tele-
phone and the mobile phone—all had a significant
impact on society, culture and commercial inter-
ests. Thus, communicating by thought is likely to
have an even more profound effect than all the
above three combined.

E-Medicine also depends on the basic electro-
chemical nature of the human brain and nervous
system. Chemicals have, for some reason, been the
mainstay in the Western world for treatment of all
types of diseases for centuries. However, in the
twilight of the last millennium we witnessed the
first twinklings of the successful treatment of
diseases by means of electronic brain stimulation
through implanted electrodes. 

The treatment of Parkinson’s disease by this
approach was found to be very successful. In fact,
in the new millennium, the number of patients so
treated had already run into hundreds. Now we
can witness reports on successful trials and
further studies involving individuals with epilepsy
or multiple sclerosis. Clearly, the field is rapidly
growing and diversifying.

Indeed, it is exciting to look at the range of
absolute potential in the broader sense of E-Medi-
cine. Basically, what we are looking at is the use of

KKeevviinn  WWaarrwwiicckk, the world’s first Cyborg, is a 
Professor of Cybernetics at the University of Reading, UK 
For more of Kevin Warwick, visit www.kevinwarwick.com

“Electronic signals can be used to
alter the workings of the human
brain in a variety of ways”
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purely electronic signals to dramatically alter the
functioning of a human brain. In the case of
Parkinson’s disease or epilepsy, the result is to
override or counteract the nature of the disease,
restoring the individual to a semblance of
normalcy. In this sense, the use of electronic
signals can be seen as a viable alternative, and in
many cases, an improvement on the more tradi-
tional chemical alternative.

Electronic signals can be used to alter the
workings of the human brain in a variety of ways.
For instance, we can consider the possibilities of
memory download—giving individuals memories,
which hitherto, they have never experienced. 

This can even be extended to education. Want
to play golf like Tiger Woods? Well, perhaps the
mental ability can be downloaded, even if physi-
cally you might be a little overweight or out of
condition. But potentially, even that could be dealt
with. Why not try the patented ‘Slimplant’—elec-
tronic signals used to control a brain’s functioning
regarding eating and drinking patterns and the
amount of regular exercise? 

Research on rats has shown that their planned
movements can be controlled externally by  the
computer. When this is transferred to the human

brain it means that you will not be able to have
that extra meal that you know you shouldn’t; the
implant will not let you! Of course, this could put
McDonald’s out of business!

All sorts of behavioural patterns could be
controlled in the same way. For instance, one indi-
vidual could potentially control some of the move-
ments and decisions made by another. Not sure
what your spouse is doing? Well, now you could
be, via an implant. 

Conversely, a person might want such signals
to allow them to deal confidently with an inter-
view, or make a presentation, or to do the right
thing on a first date. The possibilities are endless.
Any time you are not sure—rely on the implant. 

At the same time, such possibilities raise
enormous social and ethical questions. It is one
thing to use this technology for therapeutic
purposes in order to help someone who has, say,
Parkinson’s disease or paralysis—very few people
would disagree with such usage. 

However, it’s a very different thing when it
comes to controlling another individual’s habits
or movements. Even if technology allows it, the
society on the whole may not be keen on the idea.
Society is, indeed, a strange creature.

The ethical issues are further exacerbated
when enhancement of an individual is contem-
plated. The ability to communicate by thought is
one feature. However, brain implants offer the
possibilities of: extra-sensory input (such as
infrared, ultrasonics), extending your nervous
system across the Internet (your brain can directly
control technology in cyberspace), having the

mathematical and memory features of a computer
directly linked with your brain, and being able to
think in many dimensions. 

Through my own implant self-experimentation
research, I have already experienced an extra,
ultrasonic sense. I have directly controlled a robot
hand on a different continent by brain signals
alone, and have communicated directly from one
nervous system to another. 

To me, the prospect of upgrading from the
limited world of a human into an exciting part-
human part-machine world—a ‘Cyborg’, in science
fiction terms, is so exciting that I cannot wait.
Although many others will feel like I do, some may
feel quite differently.

For instance, if some humans have extra abili-
ties, how will they treat those that remain mere
humans? Nevertheless, just because some people
do not want to be upgraded, why should they  stop
those who want to be upgraded? Clearly, we face
tough ethical questions in the years to come.

One area where this is highlighted is the mili-
tary domain. Implant technology opens many
avenues to a whole new world of technological
warfare. Not only can those involved have more
improved intellectual capabilities, including extra

senses, but also, humans themselves no longer
need to be physically present in the battlefield. 

With a nervous system that can be extended
via a network, the human soldier, pilot or sailor
can be safely ensconced at home, while some of
their senses are remote, at the point of combat.
Any thoughts of the individual on control or move-
ment, as would be the case in firing a missile, can
then be translated into immediate, direct
commands in the combat zone. 

From the home side’s perspective, this has the
distinct advantage of saving the lives of those in
combat. For the opposition, however, it becomes
more of a challenge. Destroying a vehicle or
machine would be just that and only that. If it can
be replaced, it will be. 

Moreover, the attacking machine will need no
intelligence, no computer, and no high technology
on board. Effectively, it can almost become a
‘throw-away’, low-cost artificial soldier, with the
actual personnel residing safely at home.

Space travel, too, would take on a distinctly
different meaning. Why send astronauts into the
extremely dangerous environment of outer space
when they can stay at home and have their nerv-
ous system linked to a distant planet, by satellite? 

In this way, we will soon be able to experience
planets at the extremes of our solar system, which
would, at present, appear to be impossible other-
wise—simply because of the time required to safely
transport humans across space for such a distance,
never mind bringing them back again. 

In all probability, we will develop space trav-
ellers that spring to life when they arrive at a

“With a nervous system that can be extended via a
network, human soldiers can be safe at home, while some
of their senses are remote, at the point of combat.”[

[
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distant planet, carrying and relaying signals from
and to the human astronauts back on planet earth.

With this brave new world, just as we have
tremendous positives, just as we can enable a lot of
people who would otherwise have a more
restricted life, just as we can upgrade all human
mental capabilities and replace worn-out biologi-
cal body parts with shiny new mechanical pros-
theses—we have a potential goliath of a negative
hiding around the corner.

The big question is, can we as humans stay in
control? Can we remain the dominant life form on
earth, or will we hand over power to a machine
species, the likes and nature of which we really do
not understand?

I believe it’s not our physical prowess that has
put humans in the powerful, controlling position
we have on earth; rather, it’s our intelligence. To
put it simply, courtesy our intellectual capabilities,
and because human brains can mostly out-think
and outwit those of other creatures, we have
claimed for ourselves the driving seat on earth. But
as machine intelligence is rapidly improved, as
computer-based systems become more powerful,
how long can human domination last?

It is estimated that within a decade, standalone
computers will have more processing power than
an individual human brain. Not only that, but they
will be networked. And what is the intelligence of
a machine-brain network? 

Even now, a typical computer can perform
more calculations in the blink of an eye than a
human brain can perform in a week. By giving such

machines the ability to defend themselves under all
conditions, we endow them with survival instinct—
and this doesn’t have to be programmed in.

As of now, it would be quite impossible to actu-
ally ‘switch off’ the Internet. We humans are far
too dependent on it. Many lives revolve around the
Internet on a day-to-day basis, and already, our
present way of life demands that the Internet
remain operative. Humans are, in fact, the
machines’ defenders!

Just as humans do not listen to sheep or dogs—
creatures we feel are less intelligent than ourselves,
similarly, intelligent machines are very unlikely to
listen to humans now. For instance, if a sheep came
into your room today and said “Baaah”, you would
not say to it, “OK, yes, I will do what you tell me”.
After all, the noises the sheep make are trivial in
comparison with human language. Likewise, in the
future, intelligent machines will find human
noises (speech) trivial.

What is to be done about this? Are we all
doomed? Clearly, our only hope is to upgrade our
own abilities, to create a partnership between
human intelligence and machine intelligence. So,
far from being something that would be good to
do, linking human and machine brains together is
quite simply something we have to do. 

“If you can’t beat them, join them”, appears to
be true here. The decision is yours. Will you be
happy remaining a human, part of a sub-species in
the years ahead? Or wouldn’t you rather be
upgraded and have extra memory and extra senses?
Wouldn’t you like to converge with technology? 

1/2 pg H AD
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Aditya Kuber

Technology, in a way, needs to go back to the
basics to implement the latest in cutting edge.
Cryptic as that may sound, sample this:

fingerprint identity could well be the most secure
way to protect your data and identity. This is a clas-
sic example of convergence that could take us back
to our roots in an attempt to secure us. What are
some of the other practical areas that convergence
could make life easier in?

Communication
Perhaps the industry that would benefit most from
widespread application of convergent devices is the
communications industry. There are various
avenues where the communications industry could
implement converged devices or technologies.

Telecommunications
Cell phones have already integrated MP3 players,
cameras, PDA functionality, Web browsing capabil-
ities and payment options. Add to this the possibil-
ity of using this as a hub for all communications,
including security for your home, and you have a
truly converged device. After the race to make
devices smaller, vendors are back to manufactur-

ing bulkier cell phone handsets, but this time, it’s
not because of the lack of know-how in controlling
sizes. It’s just that the handsets have so much
packed in to them that there is no other option!

Coming back to the handset as a security hub, it
may sound far-fetched, but it’s as simple as using
the WAP facility on the phone. Your home could be
secured with cameras that are accessible through
the Internet (even on your office desktop) and there
is a WAP site for this as well. All you do is log on
securely and choose the room you want to view. In
case of a problem (a burglary, accident, etc), you are
on top of it. Even if you are not watching, you could
be intimated of a problem via a text message and
you could then log on to see what’s going on. 

Imagine this being used by doctors to monitor
patients or dispense advice if they cannot be pres-
ent personally. Yes, this also opens up some more
security loopholes, but the benefits far outnumber
the pitfalls.

Entertainment
Considering entertainment as a part of communi-
cations, you will no longer need to buy a newspa-
per. In an ideal world, this could also help save
trees and cut down on the production of paper. But
more practically, you could just download a page
(or a news article) from your favourite site (or news-

Convergence

Convergence
is here to
stay. But
what type of
convergence
is practical?
How far can
we go to
make it work
and that too,
effectively?  

Applied 
Convergence
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paper) and read it on your handheld device.
Technologies that are enabling foldable OLEDs
(Organic Light Emitting Diodes) can make the
experience even richer. You just plug in the sheet
of screen to your computer (or phone) and down-
load the day’s newspaper. Navigation keys placed
right on the sheet will help you read through the
entire newspaper. 

Of course, these services would be paid for, but
they are at your convenience. Like newspapers,
books and even movies or music could then be
downloaded to such devices and accessed at your
convenience. That, in the future, would be the true
operative word. Convenience.

Education
Videoconferencing and virtual classrooms
already exist, and this is one of the best
marriages of technology, the Internet and a
necessity that we have yet seen. In areas where
schools or colleges are inaccessible, but tele-
phone lines are available, virtual classrooms or
teaching via videoconferencing can prove to be
interactive and almost as good as the real thing.
Using tools such as instant messaging and e-mail
can further boost practicability. Reliance
Infocomm, for example, offers good connectivity,
and could be perfect for this purpose.

Good old Doordarshan has been telecasting the
UGC classrooms on its National Network for a while
and it the programme has been popular. Even with-
out videoconferencing, education can reach a large
audience thanks to technology. Just VCD payers—or
even VCRs for that matter—can aid in this. It’s just
a question of the drive being there.

Agriculture And Farming
Picture this: a farmer has a huge crop and it has
been hit by a bug, but he has no idea which one it
is… no one around seems to know. He doesn’t have
enough time to go to the big city and get it
analysed and then treated. But somewhere in the
annals of the World Wide Web lie the answers.
Problem is, he cannot access it since he does not
know English. But, thanks to the one computer-
and Internet-savvy person in the village, he finds
the answer to his problem and saves his year’s crop.

Taking it further, from the consumer point of
view, an animal being reared for meat could be
tracked from birth. Information about its parents,

medical history, diet history and the way it was
killed could be made available just through the bar
code on the final package. Buyers could just scan
this using their cell phone and get the information
on their WAP-enabled cell phones before making a
buying decision. Why not?

The camera phone could work well for farmers
as well. In the first scenario, instead of the farmer
going on to the Internet, he could just take a photo
of the bug and MMS it to the nearest authority—
government or private—and get personalised infor-
mation and help faster than any other means.
Moreover, this information could then be logged for
the future reference of other farmers.

Healthcare
One of the major fields of convergence of basic,
consumer-friendly technology could be healthcare.
The worst time for a patient is after he suffers his
injury or ailment and before medical help arrives.
Using cameras or camera phones, in such situa-
tions could help address this better.

In fact, in an ideal world, a doctor need not leave
his chamber again unless absolutely necessary. It’s
akin to telecommuting for doctors. Agreed, this may
not be the most convenient way in all cases, but in
some, it could definitely save doctors and patients
a lot of time and grief.

In today’s day and age, when operations are also
happening via videoconferencing, nothing is
fantasy. Experts, in particular, need not travel thou-
sands of kilometres at the risk of 10 other patients’
lives to operate on one patient. There are doctors
who are competent enough to successfully operate
with just the expert’s guidance, and this is already
reality. It’s like TeleOperate.

Identity protection
Fingerprint identity or cornea scanning could
combine the uniqueness of the human body and
technology to create perhaps the most secure form
of identity protection. 

Contrary to what films may show us, there is a
certain amount of surety this form of security
lends us. A fingerprint is made of a series of ridges
and furrows on the surface of the finger. The
uniqueness of a fingerprint can be determined by
the pattern of ridges and furrows as well as the
minutiae points. Minutiae points are local ridge
characteristics that occur at either a ridge bifurca-
tion or a ridge ending. The other method is the
correlation based method that is more practical
since matching minutiae in low-quality scans
could be difficult.

But where can it be implemented? Can colleges
and schools have this to avoid cheating? Can offices
secure data and maintain the secrecy of classified
information? Can governments implement this to
ensure that information is not stolen and misused?
The first example may be a bit far-fetched, but the
other two are certainly practical and have, in fact,
been implemented in certain setups.

Prohibitive costs are the main hindrance,
although devices from companies like Sony and
Microsoft are aimed at the mass market. 

Plus, the huge amount of data and the cumber-
some nature of including new and dynamic data
could prove restrictive.

aditya_kuber@thinkdigit.com

Distance learning (left) and fingerprint identity (right) are two areas where
convergence of the old and the new can facilitate things a great deal
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Convergence is not just about technology
but is a combination of technology,
institute and culture. Take the case of

villages, where physical communication is tough
vis-à-vis in the cities. But, despite distances being
lesser, communication in cities is poorer than in
villages. Technology is not necessary for
communication.

In terms of communication, technology is
the word while the institute becomes the
grammar. Communication within communities
where modern means are absent is a study. The
real problem is communication within the
communities.

In a city, the problem is communication
within the community. We send e-mails
within offices. Communication is not
merely about getting information across.
There is more to it. Semiotics—the science

of symbols—also forms a big part of
communication, and cannot be ignored.
Often, more is said through signs than through
words… if you take this away, communication
is limited.

One point I would like to make here is that in
areas where ‘modern’ communication is weak,
intra-community communication is strong, and
vice-versa. There is, of course, a paradox to this.
As mentioned earlier, convergence should be of
communication, community and institute. If you
consider analogical communication, there are
metaphors involved, which may convey part of
the meaning. This involves a sender and a
recipient. In the case of digital communication,
the entropy is much more.

The other paradox is that societies are
created and based on the myths, legends and
stories they have passed on. This is what creates
a culture. This can go forward only through
analogue communication. One needs to apply
their mind to understand the meaning. What is
also does is allows you to understand, own and
derive your own meaning.

In the case of digital communication, there is
high entropy. Information is trashed much
faster. But things like folklore and folk songs are
still alive. These have been passed down through
analogue communication.

One main challenge we are faced with is
the asymmetry of modern technology. There is
a division between the ‘haves’ and the ‘have-
nots’. There is a need to reduce this, but it is
not possible. 

By design, any service—including telephony—
would like to recover their cost, and wider
deployment can help them do this fast. But there

is a cause-and-effect angle to this as well. In such
a case, they can survive through innovation.
Take, for example, the case of someone in a
village who needs to access a doctor or an expert
for a crop disease. There are various reasons he
cannot; he doesn’t have the money, there is no
access to a doctor, or the expert has no
knowledge in his area, or there is no research
available in the problem he needs addressed.
What’s worse is if the wrong problem is
focused upon.

A systematic approach could actually help
solve this. Let’s re-look the above problem. The
common refrain is, “What should I do?” If there
were a kiosk, the villager could go and ask the
operator for the answers. But what if the
operator does not know English and the farmer,
too, is illiterate? Does this mean they have to be
deprived of the information?

Dr Anil K Gupta, Kasturbhai Lalbhai Chair in Entrepreneurship,
Indian Institute of Management, Ahmedabad

“Convergence should be of
communication, community and
institute.”

Convergence
Is Not Congruence
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Indian language content is the only solution
to this. Although funds have been earmarked
for this, they have so far been spent in the
wrong manner.

Which brings us to the question, “Who is
paying for this?” In India, the poor pay more
taxes than the rich. While direct taxes in India
are progressive, the indirect taxes are
still regressive.

In convergence, culture and language need
to be bound very closely. Nuances of language,
which may say more than anything else, are
better in one’s own language than in any other. 

India is a diverse country and that is its
richness. By trying to do everything in English,
we might just kill our own character.

Our language shapes our habit of
thought. Different languages shape different
thoughts. We need all these languages to
thrive if we want different, rich thoughts
to be thought out. Information and
Communication Technology (ICT) can enable
this. But for that, we need people who are
passionate about diversity.

There are different groups of people with
different needs. Those for whom convergence
must happen need unique solutions. A VCD
player and a black-and-white TV that costs
Rs 3,000 can help communities access
information that was hitherto beyond their
reach. This is convergence.

Convergence solutions need to be robust and
cheap, not necessarily interactive. One-way

communication with a time lag is fine—so long
as it happens.

Thinking that we need continuous
interaction could make people miss out.
The Internet is not available in our
languages, and depriving people of
information till that happens could leave
people out in the cold. Providing solutions
in ten days is also fine so long as there is
an assurance that it will happen.

Innovation, as I said earlier, is the way ahead.
Innovation will come through diversity—the
very character of India.

Convergence can be a shortcut to diversity.
It should not lead to congruence to
identical things. Imagine, then, innovation that
has come about thanks to convergence,
converted into enterprise. A grassroots
revolution can trigger globalisation. Sharing
these innovations is the way to move ahead and
the way to true convergence. Yes, you could
charge a licence fee and patents could be
granted… but this is the way ahead. 

1/2 pg H AD

Dr Anil K Gupta is a professor at the Centre for
Management in Agriculture at IIM-Ahmedabad; co-
ordinator of SRISTI (Society for Research and Initiatives
for Sustainable Technologies and Institutions;
www.sristi.org)and of the Honey Bee Network; and
Executive Vice Chair of the National Innovation
Foundation. Honey Bee is a newsletter on indigenous
innovations (www.sristi.org/honeybee.html).
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Mithun Kidambi

In many places today, the night watchman has
been replaced by a host of electronic sensors; these
detect changes in temperature, suspicious move-

ment and sounds of broken glass. Security systems
today have become watchdogs that don’t sleep and
keep a watch for you 24/7.

If someone breaks into your home, the sensor
informs the main control unit, which in turn sounds
the alarm. The system is like a guardian who’s always
watching over you, lest you slip up.

Security And Surveillance
Break-ins and burglaries are not the only reason you
need to install a security or surveillance system.
These setups also act as a nanny when there are
toddlers alone in the house or when older folk are
without company.

When deciding on how best to protect your home
or how to keep a tab on the activities inside, you need
to take several factors into account. There are many
home security systems, ranging from the very basic
to the extremely complex. The key to a quality system
is to find one that is effective, yet simple to use.

Earlier, security setups required extensive wiring
of your premises and expensive equipment such as
motion or touch sensors. This meant high costs, and
hacking of your walls to set up a surveillance system.

The most common system still widely used in a
number of housing complexes is the closed circuit
television (CCTV). This, coupled with a few basic
intrusion detection devices, was your security setup.

The protection afforded by such a system wasn’t
a very big deterrent for potential burglars. Also, these
acted more as a warning and recording device. There
was only that much you could do—watch a recording
of your house being broken into. 

Ultramodern Technology
With the age of convergence upon us, a lot of
progress has been made in security and surveillance
systems. Remote monitoring of your house and
protection does not come at a premium any more.
Also, the technology used is becoming foolproof
and easy to adapt to.

With the advent of the Internet and GSM tech-
nology, you can now monitor your house and prop-
erty in real-time. Moreover, you can take remedial
measures in case of a housebreak or other forms of
emergencies. So, what are the gadgets that play the
role of a watchdog and a protector?

Picture a scenario where a burglar has broken
into your apartment. You, of course, have the new
security system in place, complete with video surveil-
lance in real-time. A break-in would trigger an alarm.
This alarm could be set off by a series of infrared or
laser beams set at strategic points. You get a notifi-
cation of the intrusion via your cell phone in the

Home      Now!

Get
introduced
to the 
latest in
home
surveillance
systems for
foolproof
protection

Secure Your
Home      Now!

Illustration Binesh Sreedharan
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With security
becoming a
buzzword and
with
advancements
in technology,
people are
pushing for
better and
more efficient
products to
secure their
homes

form of a text message, or as streaming video
through your Internet connection. This message can
also be relayed to the nearest police control room or
security centre.

In addition to this, companies now offer you
systems where the doors and windows get locked
automatically in case of a break-in, and open up only
when a particular security code is entered. This prac-
tically traps the thief inside. 

Turning Futuristic Into Real
Sound futuristic?  Well, it’s not just a prediction.
Companies around the world are actually providing
their customers with such technology. In India,
Zicom Electronic Security Systems and Honeywell
are providers of high-tech security systems.

With security becoming a buzzword today and
with advancements in technology, people are push-
ing for better and more efficient products to secure
their homes. Equipment such as colour CCTVs, digi-
tal recording devices, wireless systems, radio
frequency identification tags and access control
cards, and automated contraband detection devices
have an increasing demand.

You also have biometric and multiple-PIN secu-
rity access systems. With multiple-PIN access
systems, each house has a secure PIN.

Each member of the household is given another
unique access code, too. For entry into the premises,
both combinations have to be entered. A failure to
do so would trigger an alarm. But are these really
high-tech security systems the only effective way to
stay protected? 

Keeping It Simple 
Skylink, a US-based security service provider, has a
series of simple security products, such as a little
motion detector that you can mount outside the
house, and if someone invades your space it signals
the base unit to beep and flash. By putting the base
unit in the living room and mounting the motion
sensor outside the front door, the LEDs (Light
Emitting Diodes) on the base unit give you intima-
tion if someone is at your door if you’re playing your
music or TV so loud that you can’t hear the doorbell. 

While their basic system configurations require
you to be home to see the lights flash and hear the
beeps beep, Skylink also offers optional equipment
that will send an emergency phone call to your cell
phone, pager, or wherever else you want it to yell for
help. All this is simple technology packaged elegantly

that works quite well in today’s hi-tech world.
Inix Technology from Malaysia has come up with

a simple security system called ‘Secure Smith’. Acces-
sible over the Internet, Secure Smith is a wireless
product comprising a home security system, electri-
cal equipment automation, home surveillance and
CCTV surveillance system.

Secure Smith does not need a PC to run, and
neither does it require wiring through your homes or
any additional infrastructure. This is because of a
proprietary technology that utilises electricity lines
to transmit digital data. Each Secure Smith control
panel is able to control up to 4,000 home appliances.
When the systems are clustered together, they can
also be used in office buildings and factories.

Convergence Yet Again 
Sophisticated wireless technologies are also being
exploited for home automation, which will not only
keep our homes secure, but also help us manage the
PC and the audio system. By plugging various home
devices into Lucent Technologies’ HomeStar
network, you can set a VCD/DVD player with the
same controls used to manage the alarm system. 

Before going off on holiday, you can program
your audio system to switch on during the evening.
This network can control your lighting as well. A
passerby would therefore be under the impression
that your house is occupied. You can turn your PC
with a Web cam into a video surveillance system, too.
There also exists software that let you control and
manage a video surveillance system and the lighting
of your home as well.

Security For The Masses
Housing complexes across the country are wiring
up their homes with the latest security systems.
Though many such systems come at a premium
(being imported), people aren’t cutting expenses on
the security front.

Equated monthly payment schemes have made
most security features accessible to more people.
Residential societies that already have such systems
installed just have to add a couple of hundred rupees
to the monthly bill for each apartment.

However, a few simple precautions such as secur-
ing all windows that could be accessible from the
outside, locking your doors, keeping track of your
keys, need to be done to secure you homes and your
valuables inside. No matter how high-tech a security
system you might have in place, there is always a
chance that it might fail or be cracked. 

mithun_kidambi@thinkdigit.com 

RFID sensors as small as this can help in authentication

as well as in other areas of home security

CCTV cameras can be disguised to look like almost anything.

Shown above is a tiny CCTV camera!
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Look up the word ‘convergence’ in the diction-
ary, and you will come across a range of mean-
ings. My favourite is the reasonably useless defi-

nition that says convergence is “the act, condition,
quality, or fact of converging.”

Huh? Other meanings and uses of the word are
not quite as circular. For instance, in biology, conver-
gent evolution means the adaptive evolution of super-
ficially similar structures, such as wings in birds and
insects. In mathematics, convergence is the property
of approaching a limit, or as my friend Hartosh said,
convergence is the way in which infinities can be
controlled, captured and understood. In physiology—
and this was something I didn’t know—it is the coor-
dinated turning of the eyes inward to focus on an
object at close range (what in other words we would
call being cross-eyed). And finally, convergence is a
meeting place, a site where things come together. 

Though digital convergence is often used to indi-
cate the last of these definitions, the other mean-

ings still prevail, making the idea of convergence
both slippery and richer. This is a good thing,
because dictionary definitions can sometimes be
straitjackets, and digital onvergence is different
things to different people.

These different meanings of the term play out in
different ways when we speak of digital convergence.
There are shades of the biological idea of convergence,
where different media and technologies develop simi-
lar features (your cell phone includes a camera while
your camera may double up as an MP3 player). The
mathematical idea of convergence, in the sense of a
series of events adding up to a finite, manageable
whole, highlights the manner in which this current
talk of digital convergence is just the current conse-
quence of media and knowledge coming together,
which began thousands of years ago when people
scribbled on cave walls. And of course, while the phys-
iological definition reminds us that despite the
wonders of technology, we need to focus our eyes
inward, to reflect and think about the meanings and
consequences of technological marvels.

However, the focus of this piece is not on biologi-
cal, mathematical or physiological convergence. It is
on digital convergence, and what it means for us as
learners and educators. In this context, I would like to
speak about three different kinds of convergence. The
first is digital convergence, the kind of convergence that
has received a great deal of attention lately (this
special issue is a good example). This digital conver-
gence is, for the most part, here already, which is
maybe why we spend so much time talking about it.

Digital Convergence
The words digital and convergence taken independ-
ently or together are today’s latest buzzwords.
People have argued that this new world of ubiqui-

tous and invisible computing, through small, rela-
tively inexpensive devices that merge multiple
media and communications technologies, will
reshape the way individuals and organisations
collaborate and share information.

Convergence in this sense of the term includes
content and application development for film, video
games, music, advertising, and mass media; distri-
bution, including wireless, broadband, VoIP and
more; hardware, such as cell phones, mobile devices,
game consoles, and so on. 

This digital convergence is often talked of
in technological terms (such as my cell phone,
digital camera or my gaming console). This
emphasis on the technical is not surprising
because there is still a lot of intricate and
difficult work (regarding communication
standards, interoperability, hardware handshakes
and software bugs) that need to be configured
and deciphered.

PPuunnyyaa  MMiisshhrraa, Associate Professor, 
Learning, Technology & Culture, Michigan State University

“Digital convergence obscures
physical and temporal 
boundaries...”

Technologies
On The Verge…
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At the same time, this emphasis on the techni-
cal should not obscure the psychological, social and
cultural aspects of these technologies. These tech-
nologies are reshaping the way individuals and
organisations collaborate and share information.
This digital convergence, in an important sense,
removes, and maybe more importantly, obscures,
physical and temporal boundaries that in the 
past served as impediments between individuals
and the world. 

When communication integrates, maps and
borders have less meaning—if any—and barriers of
distance begin to dissolve. In some ways these tech-
nologies of ‘action at a distance’ simplifies our lives,
since it allows us to connect with the world in ways
that we might not otherwise. It becomes the centre
of our social network and constructs a ‘virtual space’
within which we live, learn and work. 

Pedagogical Convergence
Living in the physical and social world—for both
work and play—requires acquiring knowledge. To
survive and thrive in these new social and physical
spaces, new ways of learning that meet the
demands of this new era will have to be developed. 

The convergence of our strategies and theories
of learning to live in this digitally integrated world
is the second kind of convergence I am alluding 
to—what I call pedagogical convergence. This conver-
gence deals with how our approaches to teaching

and learning need to converge with the new trends
in digital technologies. 

Learning today can no longer be restricted to 
12 + 4 years of schooling and college. Not only do we
have more to learn, we need to do it more often and
in less time. This puts severe stress on our existing
pedagogical systems including schools, training
workshops, colleges and universities. 

Learning can no longer be limited to being able to
recite multiplication tables by rote and such. Learn-
ing today is continuous, just in time and perpetual.
This fast pace of change means that there is little time
for leisure and reflection. Lifelong learning is not just
an idle hope, but rather, the need of the hour.

What role can technology play in developing
solutions to these problems? The first thing to
remember is that education and learning is always
about more than the technology. We must never
forget that technology is a medium, a tool for
converting ideas into action. 

However, technologies do not force one set of
actions over others. Technologies can be used for
‘old style’ learning as easily as for newer, flexible
pedagogy. The technology does not care. In some
sense it may even be easier to use technology to
achieve ‘old style’ goals.  This is why we often see the
online course that is merely a set of static Web
pages—a textbook moved onto the Web; or the naïve
drill and practice programme, cosmetically

enhanced by irrelevant and pointless flash and fizz.
We must remember that all the technologies in the
world are of no use if they are to push the same old
agenda. The language of pedagogy needs to rise up
to meet the language of convergence. 

I remember visiting a school in Nagpur and talk-
ing to the computer teacher there. The school did
not think of using computers to learn science. They
did not consider using computers to develop writ-
ing skills, though there is increasing evidence that
using word processors actually makes students
better writers and better thinkers. 

Sadly, this is true of most schools today. So the
constraints are not as much cost and access, though
these are critical issues—rather a failure of our
collective imagination.

A part of the problem is, given the fast pace of
technological change, our learning theories and
pedagogical approaches have often been engaged in
a game of catching up. This is not to say that we don’t
have a sense of what this pedagogical convergence
will look like. The new pedagogical convergence is
informed by thinkers such as John Dewey who urged
us to base all educational strategies on the impulses
of the child—the urge to communicate, inquire,
construct, and express.

Some of these new understandings are inspired
by the technology itself. Games and simulations,
with their rich multi-player, immersive, interactive,
social worlds are showing us the way to the future of

learning. The title of James Gee’s recent book says it
all: What Video Games Have To Teach Us About Learning
And Literacy. This is not to say that games and simu-
lations are the only way forward. Not at all. Educa-
tion is a multi-dimensional beast, and there is space
for various genres and ways of doing—as long as they
are thoughtfully implemented, and we resist being
seduced by the shiny, sexy surfaces of technology and
are prepared to peer deeper into their essences.

Deep Convergence
This brings me to the third and final kind of conver-
gence, which for want of a better term, I call deep
convergence. There are many people who pontificate
on the social and cultural consequences of digital
and pedagogical convergence. However, I take these
well-meaning pronouncements with a grain of salt
because forecasting often overestimates short-term
effects and underestimates long-term ones.

One thing that humans do is construct new
understandings of themselves, and the world they
live in through using these media. As the Foresight
group (http://www.foresight.gov.uk/) says in a report:

“At some point in our evolutionary past humans
entered the ‘cognitive niche’ and fundamentally changed
their relationship to the world around them and the rate
at which they could develop their culture. The artificial
world is about to do the same, with humans as partners
in the process—the effects will be equally far reaching.”

“Being on the verge is to be somewhere unstable and
unpredictable... There is also a sense of excitement,
mingled with fear, mystery and anticipation.”[

[
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What these new effects will be is hard to imagine.
These new technologies allow us to imagine new worlds;
to create new selves in this world. In some sense, this
idea of digital convergence is the first step towards an
unfolding journey that will spark other convergences,
many of which we cannot even imagine at this moment.

One of the things that humans have done over the
years, as new media have emerged, is play with their
capabilities and constraints, and then used them to
develop new ways of expressing themselves. These new
expressions are ways of developing a deeper under-
standing of who we are as individuals, as groups (such
as organisations or nations) or who we are as a species.

This is a different kind of convergence and is some-
what difficult to explain. Maybe the only way to do is
through an example. The beginning of the twentieth
century was a time of immense upheaval in our way of
understanding our place in the world. In the arena of
technology, those early years saw a range of inventions
that forever changed the way we lived. These include the
airplane, the radio receiver, neon signs, air condition-
ing, the vacuum diode, colour photography, motion
pictures, crossword puzzles, zippers, tommy guns,
insulin and the precursor to what we now call television.

And then there were the revolutions in science and
art, from relativity theory to cubism, from quantum
mechanics to surrealism. Within the space of a few
years we moved from a worldview where time and space
were absolute, to a relativistic, fractured, unstable one.
This change in zeitgeist was reflected in the sciences as
well as in the arts.

Consider the year 1922. This was the year that
Einstein won the Nobel Prize, James Joyce published
Ulysses, and T S Eliot published The Waste Land. This
was also the year that Picasso designed the sets for a
ballet performed by Diaghlev and scored by Stravin-
sky, the debut of which was attended by the likes of
James Joyce and Proust. 

This kind of a convergence is larger, deeper and
more fundamental than the other convergences I
have discussed above. In some fundamental way, these
convergences, developed a century ago, still define
the world we live in today. 

It would be foolhardy on my part to even attempt
to make predictions about the nature of deep conver-
gence that will emerge from the technological
changes happening around us today. Not the least
because the effects of technology on society, and of
society on technology are complex and multi-
threaded. Simple cause and effect relationships are
difficult to trace. 

Moreover, thinking of such deep convergences
can also be risky. At the heart of the word conver-
gence is the word ‘verge’ with its connotations of
being on the edge (as in the leading, or as others say,
the bleeding edge). 

Being on the verge, or at the edge, is to be some-
where unstable and unpredictable, and this instabil-
ity can be nerve-wracking. There is also a sense of
excitement, mingled with fear, mystery and antici-
pation. There is a realisation that decisions we 
make today will have ripple effects and conse-
quences, both intended and unintended, far beyond
what we can imagine. 

The era of digital convergence that this special
issue justly celebrates is the culmination of thousands
of years of biological and cultural evolution, even as it
is the first step in an unfolding process that will yield
its fruits in the years and decades to come. 

1/2 P V Ad
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Robert Sovereign-Smith

Every technology and standard has its draw-
backs, its loopholes. Though convergence
isn’t a technology by itself, it is the process of

amalgamation of others, and as a result, the new
technologies inherit the same problems that
plagued the parent technologies. 

In this section, we spell out a few warnings for
manufacturers and users alike, and pose a few ques-
tions that don’t really have an answer right now.

A Matter Of Choice
Technology was always meant to
ease our lives, and it did; until 
now, that is. The problems really
begin when you decide to
purchase a gadget. 

Take the example of a mobile phone—you
decide you need a new one. You even set yourself
a budget and think, “I’ll just buy the best phone
available in this price range.” Well, good luck find-
ing one—you’ll be hit in the face with over 200
models, each boasting one little thing or another
that the other models don’t have.

Let’s assume you’re loyal to a few manufac-
turer brands. So you decide it has to be from your
favourite brand. You manage to whittle the
choices down to less than 20. Of course, every
dealer out there has his ‘favourites’—the phones
he gets the most profit out of—and will try and
sell you everything but what you want. 

The days when dealers sold phones by the kilo
are long gone, too. Every second dealer reads up
on phones now. 

Of the 20 phones available from your favourite
brand, about 10 will be out of your budget—and
teasingly so. You’ll be tempted to spend that little
extra. You’ll read the features list and drool—
Bluetooth, GPRS, 3G, PIM Applications, Java-
enabled, games, PDA Applications, multi-
megapixel video cameras, MP3 support—ad
infinitum, ad nauseam.

The accepted practice today is to buy a phone
with features you’ll never use! Why? Because
mobile phones are so common today that you
need to have that something extra just to be
able to maintain your identity in your circle of
acquaintances!

The convergence of a whole lot of technologies
into everyday devices is making it harder for us

The era of
digital
convergence
is not
without its
misgivings

Con-vergence
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end-users to choose, and more often than not, we
end up with a gadget that has features we will
never use, or offers everything but the features we
really wanted. 

A common example is that of smartphones
that have so many features and complicated
menus that one cannot figure out how to turn the
damn T9/dictionary function off, so as to be able
to type in our Indian names in SMSes. Don’t you
miss your old phone now?

Incompatibilities Abound
It’s bad enough that technologies
have such short life-spans; conver-
gence just compounds this prob-
lem by orders of magnitude. Just
when you’re getting used to one

technology, they change everything and you are
stuck with outdated and incompatible hardware.

The Laser Disc (LD) player was the best example.
It could play VCDs, Audio CDs and Laser Discs (LDs
were the size of vinyl records, and about twice as
heavy). Those of you who bought one, will remem-
ber that within a few years, some genius decided
that LDs were too big and awkward to carry about,
so they invented the DVD. Now you are stuck with
an LD player. 

Want to watch the latest movies? Pop them
into the DVD player and enjoy Dolby surround
sound. Want to watch Pink Floyd’s  Pulse concert,
which you have on LD? Climb up to the attic, sift
through 20 boxes, pull out the LD player, wipe off
two inches of dust, connect it to the TV, realise
that it doesn’t work, spend four days trying to
find an engineer who has at least heard of an LD
player, leave alone fix it, give up, pack it all up,
put it back again, and go out and buy Pulse on
DVD! It’s just not fair!

Let’s not forget that even our two-year ‘old’
DVD players are on the brink of extinction, what
with Blu-ray and a host of other formats that
promise utopia on the horizon!

Upgrade Mania
Technology has always been
fickle; what’s in and cool today
will not necessarily be the norm
tomorrow. Hardware changes are
especially irritating, as it usually

involves you having to take a day off from every-
thing and going out and buying new parts for
something that actually works just fine! 

Again, as with the mobile phone example, you
bought a phone less than two years ago, and it
boasted of Bluetooth then. Today, you find it actu-
ally has Bluetooth version 1.0, whereas the stan-
dard today is 1.1.43.5572.x, or something equally
innane. So you can’t connect to certain newer
devices. Doesn’t that just want to make you want
to tear your hair out? 

And it’s not like you can just pop in a new card
and have it all work again. Take your phone to an
‘authorised service centre’ and tell them that you
want to have your phone upgraded to Bluetooth
1.1.43.5572.x, and they start shifting away from
you uneasily, and signal the receptionist to call the
loony van! 

Even if that doesn’t happen, the cost of upgrad-
ing a chip inside your mobile is almost 80 per cent

It’s bad
enough that
technologies
have such
short life-
spans;
Convergence
compounds
this
problem by
orders of
magnitude
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of the phone’s cost! You’d be better off pawning
the phone and buying a later model with the
feature set you want—if you can manage to figure
out what you want!

Even computers are not spared: Just when you
thought you had everything you wanted in a
computer, along comes Apple with their enticing
iPod, mesmerising you with its coolness, compact-
ness and sound, and before you know it, you’re
twenty-something thousand rupees in debt on your
credit card and have an MP3 player that can store 50
times more songs than you own, or have even heard!

That’s still not the problem, however. You get
home, unpack your little beauty and think, “Ah,
my precious, I can’t wait to download my entire
collection of MP3s to you!” Easier said than done—
“What the hell is this whole FireWire business,
where’s the damn USB connector?” you hear
yourself scream.

Time to upgrade your computer with a FireWire
PCI card! There goes another Rs 1,000, and more if
you decide to get a card that adds USB 2.0 heads.

Security Snags
Security is perhaps the biggest
worry of the digital age. Everyone
and their uncle are paranoid
about security, and with good
reason—what with all the millions

of worms, Trojans, viruses and malicious code
floating about in cyberspace. As devices and tech-
nologies converge, they increase the risk of creat-
ing even bigger security holes in the end product.

Take Bluesnarfing and Bluejacking for
instance! It’s bad enough that hackers are find-
ing it easier and easier to get into Bluetooth-
enabled devices; do we really need to give them
access to all our devices? Or for that matter, do
we want to put ourselves at additional risk by
letting convergence force us to store all our data
on just a single exploitable device?

If an older cell phone was hacked, the hacker
only got hold of, say, contact numbers and
SMSes, but if your smartphone-with-a-camera is
hacked, the hacker can get hold of your
address book, your pictures, your files, meeting
schedules and more. Think Paris Hilton!

Let’s not even begin to imagine what a hacker
would do with your Bluetooth-enabled laptop—
which, incidentally, is Bluetooth-enabled only
because you need to transfer data to and from 
your smart-phone!

Of Standards 
There are none! At least that’s
how it seems when the latest
technologies are released, and
subsequently incorporated into
new gadgets. 

It’s quite silly that some device manufactur-
ers form small consortiums and test interoper-
ability only between themselves. As a result,
when new technologies are released, you get a
rush of devices that are only half-tested and
released, just to keep up with the first-to-
market brand. 

As a result, a device made by manufacturer A
works with a similar device made by B, but not
with devices made by C and D. And, with your

luck, all your friends will buy devices from
manufacturers C and D.

So now what? Either you cross your fingers,
hope that your manufacturer will release a quick
fix (such as a software ROM update/flashing) that
will make the devices compatible, or you junk
your device and buy one from the same manufac-
turer as your friends.

On The Blink
Convergence means that you
depend on fewer gadgets to help
you do more of your daily tasks.
But what happens when the
device fails, or when you drop it?

As it is, devices aren’t made to be even half as
sturdy as they used to be; now you have the addi-
tional worry of knowing that this one little
gadget in your hand is your cell phone, PDA,
laptop, MP3 player and more, all together.  

Take a smartphone that you use as a cell
phone, MP3 player and PDA. If you drop it and the
phone display goes kaput, you have to send it for
repairs. While the phone is being butchered at the
service centre, you’re stuck without your PDA
contact list, meeting schedule, and even your
travel music! 

Even with MFDs (Multi-Function Devices), if
the scanner unit stops functioning, you have to do
without printing, copying and faxes while it’s
being repaired!

Jack Of All
Manufacturers are so busy trying
to offer you a whole range of uses
for a single device that they end
up compromising on quality. 

There is no contest between
the quality offered by specialised devices and the
quality of converged devices. A standalone scan-
ner will always work faster and better, ditto for a
printer; digital cameras will always offer more
functions and better picture quality than cell
phone cameras. It’s the same for all devices.

It’s Not All Bad
The point of what we’ve said here is not that
convergence shouldn’t happen; it most definitely
should. But manufacturers and users alike need
to be more discerning about the problems we’ve
mentioned, so as to best avoid wasting their time
and our money.

Manufacturers need to test and verify the
compatibility of technologies properly, not just
with their devices, but also with devices from
other brands. This is only possible when brands
stick to offering technologies that have proper
standards and guidelines in place. Perhaps reach-
ing a standard before launching a product is the
solution. But is it possible?

As end users, we also need to be more discern-
ing about what we buy, and think a lot before
spending our hard-earned money on the latest
gadgets—just because they showcase features that
we’ve never even heard of! We also need to realise
that the latest, is not always the best.

Remember, if the buying stops, the manufac-
turing will too! 

robert_smith@thinkdigit.com

Security is
perhaps the
biggest
worry of the
digital age 
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Which are the five most-wired nations in the
world today? We have shortlisted five coun-
tries that are leaders in the wired revolution,

with soaring technological innovations and a rapidly
multiplying Internet community. We considered vari-
ous parameters to arrive at the select some. 

We took into account the Information Society
Index (ISI) 2004—research firm IDC’s annual survey,
which evaluates the information wealth of 53 coun-
tries around the world. It combines 15 variables in
four infrastructure pillars (computers, the Internet,
telecommunications and social factors) to calculate
and rank each nation’s ability to access and utilise
information and information technology. 

We also considered the annual ‘E-readiness’
rankings for 2004 and 2005, prepared by the Econ-
omist Intelligence Unit (EIU) of The Economist and
IBM’s Institute for Business Value. The 65 countries
surveyed are assessed on their ability to promote
and support digital business and information and
communications technology (ICT) services—a
weighted collection of nearly 100 quantitative and
qualitative criteria. 

However, keep in mind the estimates arrived at
by the surveys may vary. Also, the rankings accorded
to the nations by research firms are very dynamic.  

SINGAPORE
A global hub in Asia, Singapore is a kind of bellwether
for the introduction of new technology. It ranks first
in the Global IT Report 2004-2005. Also, in the 2004 e-
readiness rankings by the EIU, Singapore emerged as
the top country for Asia-Pacific. The island nation is
also the second most wired country in the world,
according to the 2004 Networked Readiness Index. 

It is strategically location within ASEAN (Associ-
ation of Southeast Asian Nations), which represents
a combined market of more than 500 million
people. Singapore has the lowest rates of corruption
and is ideal to initiate e-commerce and Internet
marketing. Singapore is host to more than 6,000
multi-national corporations; the high-tech and
financial services industries are lightly regulated,
and telecom was privatised in 2000. 

Consider Singa-
pore’s port: it has a
first-mover status
as the world’s IT
leader in seaport
logistics. A world
leader in broad-
band rollout, there
are thousands of
broadband access
points across 
the country.

Wired Countries

The top five
wired
nations are
not just
about the
highest
number of
PCs or
mobile
phones.
They also
have policy
support for
digitisation
and a 
tech-savvy
citizenry 

Top Five
Wired Countries

Illustration Shyam Shriram

Capital: Singapore
Population (millions): 3.54
Area: 683 sq km 
Internet penetration: 60.2 % (Sep 04) 
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DENMARK
The erstwhile seat of Viking raiders, Denmark has
evolved into a modern, prosperous nation with an
advanced broadband infrastructure and one of the
highest levels of broadband penetration in Europe.

Denmark replaced Sweden as the information
champion in the IDC Information Society Index (ISI)
2004. It leads in the telecom variable—notably wireless
subscribers, high user penetration and mobile Internet
users. Almost 69 per cent of the Danish population
accesses the Internet, with 84 per cent connecting from

home, 22 per cent of
households using
broadband while
the total mobile
subscriber penetra-
tion in Denmark
reached 60 per cent. 

Denmark  also
ranked No. 1 in the
EIU’s 2005 e-readi-
ness rankings, and
was proclaimed to

be the best place in the world to conduct business over
the next five years. The government has promised 
to boost spending on R&D, and facilitate the creation
of knowledge industry. 

According to the Computer Industry Almanac,
Denmark is among the leading countries in computer
and Internet penetration—as of 2004, there were 682
surfers per 1,000 Denmark residents, compared to 649
in Australia; 641 in Canada; 611 in Japan; 570 in the UK;
and 628 in the US. 

Denmark has it all—highly developed infrastructure
and institutions, a skilled labour force, low inflation
rates, political and economic stability, and an interna-
tionally plugged financial sector. 

CANADA
Canada has one of the highest rates of Internet usage
and broadband adoption in the world. It ranked fifth
on IDC’s Information Society Index (2004). Residential
broadband access enjoyed continued growth in 2004
as the increase in dial-up accounts slowed. 

Broadband deployment continues to progress
under active government encouragement, with 85 per
cent of Canadians now living in communities served
by high-speed Internet access. 

The 2004/2005 Telecoms, Mobile and Broadband in
Canada Report by BuddeComm indicates that almost
43 per cent of Canadians use a wireless device. Canadi-
ans are heavy Web users, with 90 per cent using e-mail
weekly. Anti-spam/virus software company, Sophos,
ranked Canada as the fourth highest spamming nation
in November 2004 with 5.7 per cent of all spam in the
world originating from Canada.  

The Canadian Government launched an anti-spam
action plan in
2004. The Cana-
dian Internet
R e g i s t r a t i o n
Authority oper-
ates the dot-ca
Internet country
code Top Level
Domain—there
are more than
530,000 .ca
domain names.

SWEDEN 
Another Scandinavian nation, Sweden has one of the
world’s highest life expectancies and one of the lowest
birth rates. It’s the most tech-savvy country in Europe
according to a 2005 report by Jupiter Research, a US
market analysis firm. Sweden was ranked  as the third
most e-ready nation by EIU (2005). 

The EIU named Sweden as best-in-class in key areas
of connectivity—mobile penetration and Internet use,
and a standard setter in e-government implementation.
Sweden ranked second in the Information Society
Index by IDC in 2004—with highest penetration of Inter-
net access, highest usage of mobile phones, and a very
high level of Internet and computer skills among busi-
ness managers. For instance, it has the
highest business penetration rates for
Microsoft Windows and Apple OS. 

The gadget loving populace doubles
as an advanced testing ground for a
range of mobile commerce applica-
tions—even the Bluetooth technology
was  invented in Sweden. The country’s
WCDMA (Wideband Code Division Multi-
ple Access) 3G mobile infrastructure
covers over 70 percent of the population,
state wireless consultants Northstream. 

Incidentally, Sweden is the only
country in the world to have more mobile phones than
inhabitants—thanks to lower calling costs than any
other European nation! 

THE UNITED STATES OF AMERICA
The US ranked third on the Information Society Index
by IDC (2004), and ranked second on e-readiness (EIU
2005). This land of silicon chip innovators and manu-
facturers scored highest for PCs per household and
software spending, steadfast in its position as the
world’s largest consumer of computer products and
services. The US also ranked higher because of secure
Internet server penetration, overall spending on IT
and growth in broadband adoption. 

The US remains the world’s leading broadband
user with nearly 31.7 million lines in the third quar-
ter of 2004. The number of broadband users increased
36 per cent in 2004, accounting for 55 per cent of the
total at-home users by the end of 2004, according to
a survey by Nielsen/NetRatings. 

In fact, nearly three out of
four US households with a phone
line have access to the Internet,
states the February 2004
Nielsen/NetRatings survey. 

According to Sophos, the US
continues to lead the world in
originating spam attacks;
accounting for over two out of
every five (42.1 per cent) spam e-
mails sent throughout the world. 

According to research group Point Topic, the total
number of US DSL (digital subscriber line) subscribers
is growing, but still lags behind the country’s 19
million-plus cable modem subscribers. 

In July 2004, residential broadband connections
in the country overtook the use of slower, dial-up
connections for the first time. Almost one-third of
the wireless services budget in the US is now dedi-
cated to data. The vast majority (91 per cent) of US
firms use wireless data. 

renuka_rane@thinkdigit.com

Capital: Copenhagen 
Population (millions): 5.4 
Area: 43,093 sq km
Internet Penetration: 68.7 % (Mar 05)

Capital: Ottawa
Population (millions): 32.5
Area: 9,976,137 sq km 
Internet penetration: 63.8 % (Dec 03)

Capital: Stockholm
Population (millions): 9.04
Area: 449,965 sq km
Internet penetration: 73.6 %
(Feb 05)

Capital: Washington D.C. 
Population (million): 296
Area: 9,629,047 sq km 
Internet penetration: 67.8% (Feb 05) 
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Alvin Toffler once talked about people who
“suffer from the dizzying disorientation
caused by the premature arrival of the

future,” and it is not surprising to find that the
rapid changes that technology is causing in many
lifestyles and workplaces often happens at a pace
that staggers even the most techno-savvy of
communities and even countries.

Nothing epitomises this more than the
telecommunications industry in India. In a land
where a famous Harvard professor once said “half
the population was waiting for a telephone while
the other half was waiting for a dial tone”, it is
amusing, though not surprising, to find not just
educated professionals but even farmers and
milkmen making effective—and sometimes
innovative—use of the mobile phone.

In fact, a few years ago, it seemed that the
wireless revolution would catapult Asia ahead
of the long-developed nations of the USA and
the UK, where the traditional population were

slow to adapt to the new trends in
communications technology.

Not for long, though—passing through Denver
airport on a recent trip to the US, I was amazed to
see that almost all boarding gates have now
become wireless ‘hot spots’. Take out your
computer, click your browser and you are on the
Web faster than you can say ‘PDA’!

With the number of hot spots expected to soar
from a few hundred in 2003 to over a hundred
thousand by the end of the decade, and cellular
providers such as Sprint and Verizon boosting the
capabilities of their wide area networks to
facilitate high speed data transfer, the world is
changing faster than many of us would imagine.

Picture three scenarios so eloquently described
in Hemispheres Magazine and you will get the
message: Wireless Point of Sale devices are
beginning to augment, and in some cases replace,
the traditional billing stations at major retailers
such as Home Depot, Sears and K-Mart, with
agents walking up customer checkout lines armed
with handheld PCs and order scanners—a process
that is being referred to as line busting.  Barton
Marlow, a Michigan construction firm, is setting
up wireless networks at all its construction sites to
help engineers, financial analysts and other site
and corporate office employees share architectural
blueprints, project plans, spreadsheets and e-mails
to speed up the construction process. And the
third, Studio Pipelines of America, a Vancouver
television production company, has given PDAs to
all studio hands, producers and even actors on
production sets, and connected them to a wireless
network to enable set planning and even script
updating to be done ‘on the fly’.

What has been the sequence of events leading
up to this movement of wireless technologies into
the mainstream of business? The ill-fated Apple
Newton, introduced in 1993, was probably the first
attempt in this area, but it was the introduction of
the Palm Pilot three years later that really set off
the revolution in handheld computing.

And now, notebook computers with Intel’s
Centrino technology come with inbuilt wireless
capabilities; PDAs provide wireless connectivity
through national and international carriers;
smartphones and pocket PCs are beginning to
merge in terms of features and functionalities; and
tight integration between computing and
communications is enabling seamless handling of
voice, data e-mail and text messages, with
multimedia messaging services now being
provided as well.

The ubiquitous Bluetooth will soon make
seamless and cordless communication between
smart devices a feature of all working

Ganesh Natarajan is Deputy Chairman and Managing Director of Zensar
Technologies, Pune, and chairs the Innovation initiative of NASSCOM

“...the world is changing faster
than many of us would imagine.”
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environments. Public WiFi systems are becoming
the order of the day, with more and more people
slipping in a wireless LAN card in their computer
and connecting at airports, bookstores and coffee
shops. Airlines such as Lufthansa and SAS have
introduced the service on their flights, and SBC
plans to make countrywide access points a reality,
starting with 13 states in the US. 

The proliferation is being helped by the
substantial reductions in costs with routers, access
points, LAN cards, and other devices all witnessing
dropping prices, and the cost of setting up and
moving wireless networks now becoming a
fraction of that associated with wired Ethernet. As
the 802.11b standard yields to the more advanced
standards with higher bandwidths and higher
ranges, more advanced applications, such as video,
will be enabled. The only concern that remains is
one of security against hackers, but newer third-
party software will result in industry-strength
features in this area as well.

The concept of ubiquitous computing that
makes wireless so attractive is also being extended
to Global Positioning Satellite (GPS) technologies,
wireless cash registers, and Radio Frequency
Identification (RFID) systems. Logistics firms
running delivery operations across vast
geographies are able to schedule and service

customer needs better and faster using GPS, while
retailers and manufacturers can track supplies
and inventory across the supply chain using RFID.

The day is not far when all these facilities will
get fully integrated, and the science fiction dream
of locating a restaurant, making a reservation,
finding the lowest prices and paying without cash
are all available to completely transform the day to
day processes of working and living. 

I remember writing in a column a couple of
years ago about the modern man in a smart world
leaving his office in a car that receives a message
from the fridge at home that there is no milk and
routing its journey via the grocer’s store, where
the order has already been placed and is ready for
pickup. All that and more is waiting to happen in
the very near future.

Will the wireless revolution transform this
country soon? Of course it will, as some industry
leaders such as RPG Retail, Hindustan
Construction, Star TV, etc, begin to emulate the
global best-in-class, and of course, use the
software that would inevitably have been
developed by Indian software companies.

If there is one area where Indians are already
ahead of their US corporate brethren, it is SMS.
Sitting in a plane at Newark airport in New Jersey
one morning and busy sending and receiving
messages to and from my office in Pune, it was
wonderful to watch the amazement on the face of

my American neighbour witnessing this wireless
transaction happening across thousands of miles. 

This technology transformation is not just
restricted to the telecommunications arena—in
field after field, from information to education to
entertainment, the rapid proliferation of
technology is enabling animated movies to be
produced in just months instead of years. It is
enabling educators to move from chalk and talk.
From teachers to facilitators of computers and
Internet-enabled learning, it is happening and
spawning a new set of cartoons such as the recent
one with the smug face of an American kid saying,
“Thank God I’ve found a way to outsource my
homework to India”.

On a more serious note, though, the great
Indian Software Industry, which has found the
magic mantra of low cost and high quality to move
huge quanta of IT and Business Process work to
Indian centres, are themselves preparing for a new
paradigm, when programs will be generated by
technology rather than human programmers, and
many professionals would have to learn new tricks
to continue to be ahead of the world. 

What does this mean for the Indian software
industry? A generation of programmers for
whom artistry in Java has been the path to the
holy grail of dollar salaries will have to retool

themselves to become true architects—a
challenge akin to the humble bricklayer or
plumber or mason who suddenly takes on the
role of an architect. This will cause a true
paradigm shift, where analysis of business
problems and creation of efficient designs will
enable automated code factories to be set up even
in expensive countries, thereby bringing the
entire Indian success model of large campuses in
low-cost economies into question. 

Is that, then, the end of the dream promised
by even the finance minster P Chidambaram in
his Budget speech, where he promised the
creation of over 70 lakh jobs in the IT sector by
the end of the decade?

Not really, because there is enough innovation
in the Indian industry and India’s youth to seek
new opportunities to demonstrate the strength
and quality of Indian initiative and intelligence.

In sector after sector, city after city and
generation after generation, we have seized
opportunities that have come our way and
will continue to do so. It will definitely
need a strong partnership between the
industry, the academic institutions and all
the State and Central governments to
identify opportunities early and capitalise
on them, and our technology-friendly youth
will have enough openings to build their
own new global dreams. 

“The concept of ubiquitous computing that makes
wireless so attractive is also being extended to GPS
technologies, wireless cash registers, and RFID systems”[

[
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Your ultimate dream
home and workplace
comprises gadgets that
talk to each other
making life a push
button experience...
How far away are we
from this? Looking at
the gadgets already in
existence and those that
will make it to the
marketplace soon, not
too much.
The following pages
could give you a good
idea of how you can
totally digitise your
home, your office 
and your life
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Want to control multimedia 
applications on your PC using your TV
tuner’s remote? Try SlyControl

Remote-Control Your PC 
Applications!



SlyControl
brings the
comfort 
and
convenience
offered by
the Media
Center PC 
to your
computer

card by plugging the IR photo
module to the line-in jack.

Here, we will only talk about
using SlyControl in conjunction
with your TV tuner’s remote—
whatever brand you may have,
SlyControl will probably work
with it. The software costs $26.89
(approximately Rs 1,170).

When you start
SlyControl, the configu-
ration window opens.
Here, you are presented

with a multitude of remote
control plugins to choose from.

Select the appropriate plugin
that corresponds to the TV

remote installed on your system.
If you click the ‘Setup’ button at
the top of this window, you can
view the remote control button
assignments. Click ‘Apply’.

In this step, you can
enable WinLIRC server
emulation by simply
clicking ‘Apply’. 

Also, you might want to

enable WinLIRC server emula-
tion in case you have
programmes such as ProgDVB,
BSPlayer and LightAlloy. These
programmes are supported 
by WinLIRC, and can be
supported in SlyControl if you
use WinLIRC emulation.

Now, let’s configure your
sound card mixer. You
can set up the sound to
automatically un-mute

at the start of a TV or radio
programme, and mute
when it’s over (applicable
only if you are using a TV
tuner remote control, and
not the other devices that
we have mentioned). 

Click the ‘Mute Tuner’
and then the ‘Unmute
Tuner’ buttons in order to
adjust these settings. Click
‘Apply’ to proceed.

Jayesh Limaye

T
he comfort and conven-
ience offered by the
Windows XP Media
Center PC is worth drool-

ing over—all you need is the
remote, and you can do almost
whatever you want!

A remote is a good thing. And
if the Media Center PC is not
something you’re keen on
buying, there’s an alternative way
to control PC applications using a
remote—your TV tuner’s remote
control, to be precise.

You can get the SlyDiman’s
SlyControl software at http://
snipurl.com/ez29. It allows you
to run and remotely control any
Windows application, such as
Winamp, PVR software, FM
Radio, Windows Media Player,
and much more. 

You can also remotely log off,
reboot or shutdown the system.
SlyControl achieves this by using
the remote from a TV tuner card
package, or through other
devices such as joysticks.

SlyControl supports several
devices including IR remote
controls of TV tuners using the
BT8x8 and Philips chips, the
Creative Live! Drive, the ATi
Remote Wonder, the Generic
DCD (LIRC) and Serial
(UIR/Irman) devices, WinLIRC,
uICE, and also through a sound

SlyControl up and running

Choose the right corresponding
remote control plugin 

Configuring the sound card mixer

Set default action for ‘Mute’ function

Enable WinLIRC server emulation
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This step allows you to
select the various appli-
cation plugins depend-
ing on the kind of appli-

cations you wish to control
using SlyControl. 

When SlyControl starts,
only these application plugins
will load, and the correspon-
ding applications will be avail-
able for control. Click ‘Apply’ to
go to the next step.

At this point, you choose
the applications you
wish to use for playing
audio, video, TV and FM

radio. You can choose only one
application for each of these.
Click ‘Apply’.

This is the last step—you
can configure miscella-
neous options such as
enabling Test-To-Speech

(TTS), disabling the SlyControl
icon in the system tray, and
using ZSoft Lupa for the
Zoom/Fullscreen button. 

This button is equivalent to
the magnify feature in
Windows’ Accessibility menu.
Click ‘Apply’ to finish the config-
uration, and start using
SlyControl!

To learn about the keys used
to launch the various applica-
tions, refer to the help provided
with SlyControl. There is
another way to find out: after
SlyControl is up and running,
click the ‘Script’ tab, and click
the tab of the particular applica-
tion, the controls of which  you
want to learn.

SlyControl plugins are
frequently updated, and hence
there is a great chance that you
may find new plugins that
support your model of the TV
tuner remote.

jayesh_limaye@thinkdigit.com

You can 
use your
favourite
application
for playing
audio,
video, 
TV and 
FM radio

Select the existing scripts for applica-
tion control

You may configure some more options 

View the remote control buttons used in
each application

Didn’t like SlyControl or want to try something different? Well, there are more
options available for you. Here’s a list of software that are similar to SlyControl.
uICE: Available from www.mediatexx.com, this software is in every respect as good
as SlyControl except that it supports fewer devices. The control provided by uICE is
very good, and its interface and OSD (on screen display) are much better 
than SlyControl.
ARC2000: It is an Advanced Remote Controller with a Scheduler and HTTP Server
for your computer. It can be configured with plugins and remote modules. It has a
very small skinnable interface and can be minimised to the system tray. A free-
ware, it can be downloaded from http://snipurl.com/ez34.
Girder: Girder is a very good software that lets you control and automate your
computer. Girder opens up almost unlimited possibilities, from home theatre
automation, PC-based media player, business applications, and IT functions to
home applications. There are hundreds of plugins available for Girder. Girder is
available for $19.99 (around Rs 867) at www.promixis.com.

More Alternatives

You can select your favourite
multimedia application



Good acoustics make for a good aural experience.
Speaker placement also plays a big part. Read on 
to learn more...

Turn On The Volume!
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We show
you how to
set up your
speakers
the easy
way
without
breaking
your head

your room, you should try and
stay close to the defined angles.
This should be taken as a rule of
thumb for users with a 5.1 setup.

Connect Right 
Once the new speakers arrive,
the first thing you must do is
connect them properly to the
sound card. Most new
motherboards have support for
5.1 speakers, and connecting
them to the integrated sound
card can be done in a jiffy. This is
easy if the cables are colour-
coded. However, if they are not,
you will need some time to get
the configuration right. 

First, let’s take a look at the
back panel connectors of the
PC. You will see three distinct
colour-coded audio jacks—
green, blue and pink. The
audio jacks have  two roles. 

In the general onfiguration,
a green jack is meant to be the
audio line-out, perfect to
connect a stereo or a 2.1 set of
speakers (most 2.1 speakers
don’t  come with a separate sub-
woofer connector). The blue
audio jack acts as the line-in,
and is used to connect devices
such as a walkman to the PC for
recording from the walkman. 

The pink one serves as a
microphone jack. This is the
general configuration (image
A). While the placement of
audio jacks may differ amongst
motherboards, their colours
essentially denote the same
functions as mentioned above.

Remember to switch off the
PC first, and then connect the
speaker wires. You may
invariably disturb or unplug any
other cable when you are
fiddling on the back panel of a
powered on computer. If the
power cord gets unplugged, you
could end up losing a lot of data.

The speakers we used for
this workshop had colour-coded
audio connectors at both ends
which let us easily plug in the
cables to the audio jacks on the
back panel of the connector. 

For a 5.1 setup on an
integrated sound card, here’s
what you should do:

The green or front channel
speakers go into the green jack
(image B). The rear speaker
connectors go into the line-in or
the blue jack on the back panel
of the computer (image C).
Finally, the subwoofer connector
goes into the microphone or the
pink jack on the back panel of
the computer (image D). 

The final assembly of speaker
cables on the back panel of the
computer is shown in image E.

Bhaskar Banik

A
fter having read the
Digit May 2005 speaker
comparison test, you
must be eager to get

your hands on a good set of
speakers. Irrespective of what
you desire, it is imperative that
you install the speakers right.
Why? Because even if you get the
best set of speakers, and play a
song or a film on your PC, it
won’t sound right if the speakers
are not placed properly. Read on,
and we will help you place your
speakers right.

The Surroundings 
The acoustics of the room in
which you intend to keep the
speakers are important. Even if
you get high-end speakers, if
the acoustics of the room are
not up to the mark, your
investment is likely to suffer. 

Curtains, carpets, wood
and/or metal furniture, all
ultimately add to the room’s
acoustics. So, before you actually
get down to screwing the
satellites to the wall, check
thoroughly at different angles.
Of course, not all of us are
audiophiles or movie freaks, but
a slight exercise in installing the
speakers will go a long way in
getting a good aural experience.

One aspect is the angles at
which you set the speakers.
Depending on the dimensions of

A. Colour-coded integrated audio
jacks on the back panel of the PC

An ideal placement of speakers in a room

B. Inserting the front speakers 
connectors to the back panel of PC

C. Inserting rear speakers connectors
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Once this is done, connect
the other colour-coded audio
cables to the back of the
subwoofer (image F). Since the
jacks are labelled, you are spared
the guessing game! 

Once the speaker cables are
connected to the back panel of
the computer, we can
concentrate on the speaker
itself. For most part, we shall
deal with the subwoofer. 

All multimedia PC speaker
satellites connect to the
subwoofer by means of a
connecting wire. These wires may
or may not be colour-coded and
labelled. Generally, they are not,
but if they are then it is definitely
a plus for easy installation of

speakers. The image G depicts
connecting a single satellite
connector to the subwoofer. 

The final assembly of cables
on the back of the subwoofer is
shown in image H.

This completes the hardware
connections part for speakers.
Next, we move into the driver
configuration for speakers.

The Driver Deal
After connecting the speakers,
it’s time to configure the
drivers. For most motherboards,
integrated sound solutions are
based on the Realtek AC6XX
chips. High-end motherboards
have ALC8XX chips. 

However, some
motherboards such as the Asus
A7N8XE-Deluxe are based on the
Nforce 2 chipset, which uses the
extremely good SoundStorm
audio solution. Newer
motherboards such as the MSI
P4N Diamond SLI have the
Creative Live! 24-bit chip as the
on-board audio solution. 

Since Realtek is the generic
chip that most motherboards
have, we will stick to that. You

can access the driver
configuration panel by either
going to Start > All Programs,
and locating the name of the
program, which could either be
Realtek or Soundmax, and
clicking the Control Panel. 

Alternatively, double-click the
System Tray icon at the bottom
of the screen for opening the
driver configuration panel.

Once you have opened the
driver configuration panel, you
will see that the default option
is chosen as ‘stereo speakers’.
So we will have to change the
default option to ‘5.1 speakers’.

With that done, we need to
test if each channel is properly
configured. Press the ‘Test’
button at the bottom of the
configuration panel, and choose
the default settings.

Now, click the ‘Play Test
Noise’ button. This will play
the noise from each of the
speakers including the sub-
woofer. If everything sounds as
it should then you are done.
The next step would be to put
up your feet and relax! 

bhaskar_banik@thinkdigit.com

Configuring
sound card
drivers is
important
when
setting 
up the
speakers

F. Connected audio cables on the
back panel of the subwoofer

G. Connecting the satellites

H. The final Subwoofer assembly

I. Changing the speaker options

E. The final assembly on the back
panel of the computer

D. Inserting the subwoofer speaker
connector to the back panel of the PC

J. Click the ‘Play Test Noise’ button



A little care in maintenance will go
a long way in increasing your
laptop’s life

Laptop Maintenance Tips
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The bane 
of most
laptop
users is the
lack of
really long
battery 
life

data on it. Make sure your
laptop is at least 13 cm away
from any electrical appliance
that generates a strong
magnetic field—such as a
microwave oven.

Give It A Breather
If you have just shut down your
laptop, give it 30 seconds
before you start it up again.
This ensures that the hard
drive has spun down, and is not
subjected to sudden switching
on and off.

Data Backup
Always back up your data.
Laptops are mobile devices, 
and are susceptible to
breakage. Also, it’s possible
that the hard disk simply
crashes. Remember, you can
never back up too frequently.

Laptop Battery Care 
The bane of most laptop 
users is the lack of a really 
long battery life. There are
three main types of laptop
batteries: 

Nickel-Cadmium (Ni-Cd)
Nickel Metal Hydride 

(Ni-MH)
Lithium Ion (Li-ion). 

Nickel-Cadmium
This type of battery must be
fully discharged and then 
fully recharged every few

weeks. If you don’t do this, it
will quickly lose battery life
due to what is known as the
‘memory effect’. 

The memory effect means if
you don’t follow the above
procedure, your battery will
only charge up to the
percentage of the last charge.
For instance, if you discharge it
to 30 per cent, it will only
charge up the remaining 
70 per cent.

Do this repeatedly, and the
30 per cent will become
unusable, giving you an
effective 70 per cent charge
even though the indicator will
still show a 100 per cent charge
each time you charge it.

Nickel Metal Hydride
Ni-MH batteries are similar to
Ni-Cd batteries, although they
are less susceptible to the
memory effect. They also have
a higher capacity.

Lithium Ion
These are the latest type of
batteries, and have no real
problems as far as the memory
effect is concerned. 

The problem with these is
that they lose their
effectiveness if overcharged or
left for a long time with a full
charge. Always discharge these
batteries if you’re going to be
storing them away.

Varun Dubey

L
aptops are expensive
gadgets made for
mobility. Generally, they
are not very tough, and

are not known to take too well
to being mishandled . 

If you do end up messing
your laptop, even the smallest
of repairs will set you back
by thousands of rupees. Read
on to learn how to care for
your laptop. 

We have also included some
important pointers you need to
stick to before, during and
after using your laptop.

Clean It Right
Since your laptop is such an
expensive gadget (falling prices
notwithstanding), be extremely
careful while cleaning the
screen. Make sure the cloth
is very soft, and has no
imprints or monograms 
on it, as these may scratch 
the screen. 

Also ensure that the cloth is
lint-free, else it will leave fibres
on the screen, and make the
display unclear. Make sure you
don’t spray any cleaner directly
on the screen. Instead, spray
onto the cleaning cloth, and
allow the cloth to capture the
dirt and contaminants.

Choosing The Spray
The screen is the most
expensive component of your
laptop. Adequate care must be
taken while choosing the
cleaning spray. Harsh sprays
could turn the screen yellow,
and may even cause cracking.
Use plain water or vinegar to
clean the screen.

Placing The Laptop 
Hard drives work on the
property of magnetic flux, so
any electrical field may
damage the hard disk and the
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Keep Your Battery
Healthy

Before the first use, charge
the batteries for 12 hours or
the minimum charge time, as
mentioned in the manual.

For daily use, charge the
battery to capacity, then run
the laptop on battery power
until it is completely drained
(for Ni-Cd or Ni-MH batteries,
this prevents the memory
effect) or almost drained. (For
Li-ion batteries, this can help
prevent overcharging). 

Don’t leave your battery
unused for long periods of
time. Even if you use AC power
most of the time, use the
battery regularly to keep it in
good condition. Switch off 
your AC adapter when the
laptop is not in use. This
prevents overcharging.

To extend battery life,
you can try decreasing the
LCD brightness while
using your notebook. You
can activate the ‘Standby’
and ‘Hibernation’ power-
saving modes, too, for
better battery life.

Battery Storage
If you do not use your

laptop for extended periods
of time—a week or more—
remove the battery pack
from the laptop, but only
after discharging it fully.

The batteries should be
stored in a cool dry place,
removed from heat,
humidity and dust as well
as metal objects.

Use A Laptop Case
It is advisable to spend a couple
of thousand rupees and get a
sturdy carry-case for your laptop. 

The case should ideally be
hard from the outside and soft
on the inside, while being a
comfortable fit. It should be able
to absorb shocks and carry your
laptop accessories.

Keep Eatables Away 
Obviously, no eating and drink-
ing near or around your laptop.
The least bit of water could
short-circuit some sensitive
laptop circuits, and render 
it useless.

No Hard Booting
You may sometimes be tempted
to turn your laptop off by

simply holding down the power
button until it powers down.
Although quick, this method is
harmful to the laptop and
could cause data loss. 

A hard reboot should only
be used as a last resort.
Sometimes this is inevitable,

for instance,  when Windows
hangs. But this should not be a
regular practice.

General Tips
Shortcuts To Success
Create shortcuts to your

most commonly used applica-
tions, folders and files on the
desktop. This way, you can access
them quickly. If you like your
desktop clutter-free, you can also
create custom toolbars in
Windows XP. 

To do this, right-click on 
the Windows taskbar, go to
‘Toolbars’ and click ‘New
Toolbar’. Next, choose the drive
or folder you want to access
using the toolbar. You can create
different toolbars for different
drives and folders. 

This is expecially useful for
sales executives who want easy

access to presentations, proposals
and other information they use
on a day-to-day basis.

Clean Up The Junk
Uninstall applications you

don’t use. Apart from saving
on disk space, you’ll also
prevent your notebook from
slowing down.

Be resourceful—keep backups
of the OS, drivers and commonly
used applications on a secondary
partition so you can do some re-
installing on your own if you face
any issues when travelling. Carry
driver CDs and recovery disks.

Laptop Security
Don’t Be A Jerk
Don’t subject your laptop to

jerks and shocks. This will help
avoid damage to your hard drive.
Preferably, power the notebook

off before moving it from
one place to another.

Dusty Notebooks Don’t
Impress

Protect your laptop from
dust. Ensure vents are clean
to enable good air flow.

Drinks And Laptops A
No-No

Don’t place any containers
filled with beverages (hot or
cold) near your notebook,
to prevent accidental spills.

Power Saving Tips
Let Power Be Managed
By The Pros

Set the device to switch
off the LCD screen, and

hard drive after fixed intervals
of time.

Disconnect
External peripherals and

accessories such as external opti-
cal drives, PC cards and USB
keyboard lights draw power from
the notebook. Disconnect such
devices when not in use.

Suspend Your Notebook
Booting the notebook

when it is not connected to a
power source draws a lot of
power from the battery. 

Instead of shutting down
your laptop in the middle of a
meeting, choose the ‘Suspend’
mode if you wish to use it
again after just a short interval.
This will save battery and help
you restart your work faster. 

varun_dubey@thinkdigit.com

A hard
reboot
should only
be used as
a last
resort



Save costs and work faster with all-in-one laser-based MFDs
that can print, copy, scan and fax

Do It All With 
Laser MFDs 
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identical copies of the data on
the same page. For instance, if
you want  four copies of a
receipt—by using the Clone Copy
option, you can fit this on one
page, and cut the page to get the
four copies. 

Again, this mode works only
when you manually place the
document on the glass, and not
in the ADF. You can do so in the
same manner as mentioned
above in Autofit copying, but
instead of looking for ‘Autofit’
when you access the menu,
choose the ‘Clone’ option.

Collation Copying
Collation Copying is an
extremely useful feature. In this
process, you can get a set of
documents collated and sorted
automatically as per your needs. 

For instance, if you want to
copy a five-page document, sort
the pages in a manner in which
they have to be copied, place
them in the ADF, and then press
the ‘Special’ button. Next, access
the menu, go to the ‘Collation’
option. Then press ‘Enter’ to
choose that menu, and start the
copying process to get accurately
sorted sets of the number of
copies you had specified. 

Two-Sided Copying
This option is present on some
MFDs. It’s useful for copying
information from smaller sheets

of paper and showing them on
the same page. 

Consider business cards that
have printed data on both sides.
A card can be kept on the glass
document scanner, and both
sides of the card can be copied
onto a single sheet of paper on
one side. 

In order to get to this menu,
follow the same path as given
above for ‘Autofit Copying’. All
you need to do is look for the ‘2-
Side’ option in the menu. Then
press ‘Enter’ and start copying.

2-Up Or 4-Up Copying
This is another useful mode, if
you want to compare two
documents, or want a copy of
two different documents on the
same page. You can also choose
to have four documents fitted
onto a single sheet of A4-sized
paper—good enough for
comparing four documents on a
single sheet. 

There will be a reduction in
the size of the printed text when
you choose this mode. This mode
can only be accessed when 
you are manually copying
documents, and not using 
the ADF.

Poster Copying
This is a special mode that lets
you expand a single document to
a poster. Poster copying is only
possible when you are manually
copying a document. It’s a good
technique for blowing up a
single image on one page to
multiple pages. Choose the
‘Poster’ option from the menu
and start copying.

Faxing
Faxing is available on most laser-
based MFD models. Generally,
you can use the MFD to receive
faxes using the preset settings. 

However, if you are worried
about confidential faxes falling
into wrong hands, you can
configure the MFD to not

Bhaskar Banik

M
ost workgroups and
departments
consisting of 25
people or thereabouts

generally use a laser-based MFD
solution. This is not only
because a laser-based MFD is far
cheaper courtesy the laser
printing functionality, but it’s
also faster. And that leads to
improved productivity.

Some models of laser-based
MFDs have special features that
remain largely unused, since
most users are unaware of them.
Here’s looking at some of these
features to help you get the most
out of your MFD.

Copying
The copy button is one of the
most-used buttons on the MFD.
Generally, copying is done at
default or preset settings.
However, in some models, you
can tweak this. Here’s a small
list of such tweaks.

Autofit Copying
This is a copying mode that
works when you manually place
the document on the glass and
not on the Automatic Document
Feeder (ADF). Next, you can
press the ‘Special’ button on 
the MFD and then, using the
‘Scroll’ button, locate the
‘Autofit’ option. 

Pressing ‘Enter’ will save the
selection, and you can start the
copying process. This is
especially useful in scenarios
where you need to spread a
small amount of data over a
page. This gives the page a
professional appeal.

Clone Copying
Clone Copying is another
technique that spreads a small
amount of data over the whole
page, and instead of just
spreading the data, it creates

Control panel of a laser-based MFD
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provide a printout for the faxes.
This is called the secure
receiving mode, wherein all
incoming faxes are stored in the
MFD’s memory. You can later
access the MFD, and print the
faxes by punching in the
password you provided earlier
when configuring the MFD.

For system administrators,
such MFDs can also provide
detailed prints about fax usage
on the particular MFD. You can
get a report about the phone
numbers stored in the MFD’s
memory, a sent-fax report,
received-fax report and more. 

Some MFDs also have a
power failure report generator
that automatically generates a
report after restoration of the
device from a power failure.

Similar to e-mail spam,
there are people who randomly
send  junk faxes to other fax
numbers. If your fax
machine receives junk faxes
regularly, use the junk fax
barrier feature through
which you can specify upto
10 fax numbers as junk. 

Any incoming faxes
from these junk numbers
are blocked from being
printed, and are included
in the generated received-
fax report. 

These were some of the
features available on most
high-end laser-based MFDs.
The manner in which you
access them will vary for
various MFDs.

Take Your Pick
Laser-based MFDs can be
broadly classified into three
distinct categories—Personal,
Workgroup and Heavy Duty,
and cater to a specific segment.

Personal MFDs contain
devices that are sheet-fed, and
have limited scanning abilities.
Most are monochrome scanning
devices restricted to 256-colour
grayscale scanners. 

Some are actually fax
machines, with laser printing
and scanning capabilities built
around them. They are best
suited for very low print
volumes, as the cost per page
is high. 

Workgroup MFDs utilise a
laser-printing engine. The
consumable used is a unified
toner cartridge. The toner life is
usually 3,000 pages, and a drum
is said to last for 7,000 pages. The

toner and drum are in a sealed
cartridge, so when your toner is
used up, you have to replace the
entire cartridge including the
half-used drum. 

Heavy-duty MFD technology
is the same as copier machines,
which are quite rugged. Here,
the toner is stored in a separate
cartridge from the drum; so you
only replace what you use up.
Typically, a drum is rated to last
for 50,000 pages, and the toner
lasts for about 5,000 pages. So, a
copier-based MFD actually works
out cheaper in the long run.

Personal MFDs 
In small offices, devices with a
smaller footprint are preferred
over huge machines. Due to the
absence of a flatbed scanner,
sheet-fed MFDs score in terms of
space, and do the same job as
their bigger counterparts. 

Such MFDs are
recommended for work
environments where space is at
a premium, and also for
professionals who carry work
home. A small footprint and
greater usability make these
devices a good option for
getting work done faster.

Workgroup MFDs
For a low to medium volume of
printing and copying, MFDs
based on laser printer engines
are preferred. These are
generally deployed as shared
resources in departments. These
MFDs can handle a fair amount
of work-load and also provide
fast-paced printing and copying.

Heavy-duty MFDs
Heavy-duty MFDs are good for
high volumes of printing and
copying, have low running

costs, are rugged and offer
longer duty cycles. They are
costlier and  generally meant
for large firms. 

These MFDs are the best in
the laser-based category, and offer
a host of additional features.

The MFD Buying Guide
Before Buying An MFD
Consider your usage pattern: if
you print and copy a lot, choose
a copier engine-based MFD. If
you print more and copy less,
opt for a printer engine-based
MFD. If fax is your main concern,
opt for a specialised laser fax
that doubles as a laser printer
and scanner.

Look for handy features  such
as paper capacity, buffer
memory, duplex printing, and
toner save. Ensure that the MFD
can print on the type of paper

products you use, say,
envelopes or index cards.

Consider upgradeability
and scalability, as these
options will extend the life
of the device. Being bulky,
lugging laser MFDs around
is not feasible. Make sure
your model is covered by an 
on-site warranty. 

Try the console
interface to figure out how
to operate the device.
Examine the control panel.
It should have a good LCD
panel to display status
messages and warnings.

Some More Functions
You can scan multiple
documents in batch processing
mode or optionally, use Optical
Character Recognition to convert
scanned documents and faxes
into text documents for editing. 

On some MFDs, you can save
the received fax on the PC and
print only the required faxes. 

If your machine is out of
paper, or the ink cartridge is
low, faxes will be stored in the
‘fax memory’. When the paper
tray is refilled or the cartridge is
replaced, then the stored faxes
will be printed. Some MFDs can
store up to 500 pages. 

Use the ‘PC Faxing’ option
if you would like to send faxes
directly from your computer’s
modem without having to
print the document and
feeding it manually into the
fax machine. 

bhaskar_banik@thinkdigit.com



Using an inkjet MFD, you can take your photographs and
convert them into digital memories—and also make copies
for family and friends as well

Print Photos Using Your
Inkjet MFD
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Imaging Atul Deshmukh
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Typically, you should
buy photo paper that is
around 270 gsm—‘gsm’ or
grams pre square metre is
the density of the paper,
and as a general rule,
determines the quality of
the paper. A 15-sheet, A4
size, 270 gsm bundle costs
about Rs 200. Also, most of
the top manufacturers have
their own set of papers that
are optimised for their
devices, and it’s recommended
you opt for those. 

Once you’ve connected
your MFD to your
computer and installed

all the software and drivers that
came with it, you’re ready to get
prints of your own!

Place the photograph(s)
that you want to scan on
the scanner bed of your MFD.
If you are placing multiple
photographs at the same
time, make sure you leave
a small gap between them
so it becomes easier to
separate them when you’re
editing them.

Most MFDs come with
bundled image-editing
software that will satisfy
most of your basic needs.
However, we’ll use the most
popular image editing

Varun Dubey

H
as there recently been
a function you
neglected to attend?
Or one you forgot to

carry your state-of-the-art
digicam to?

Perhaps one of your friends
was present, and therefore has
photographs you would love to
add to your collection. But he
can’t find the negatives for
reprints, and he definitely isn’t
going to give his copies to you!

In this age of digitisation,
photographs are one of the few
things people prefer to have
hard copies of.

We show you here how you
can copy photographs from
friends and, perhaps,
magazines using your inkjet
MFD. You can also enhance
them to make them look better
than the originals!

What You Need
An inkjet MFD, some photo-
quality paper, and let’s not
forget the photographs you
want to copy! Choose the appropriate capture device

Preview the photo to be scanned

MFDs can make for a very useful investment—they let you scan and print your photos from the comfort of your home

Your MFD
can be the
single device
that
enhances and
prints your
digital photos
and does
more...
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software—Adobe Photoshop.
Open Photoshop
and go to File >
Import. Here, you
will see a list of

the image acquisition
devices that are installed
on your computer.

Select your MFD’s
scanner from amongst
these. It will probably be
listed as something like
‘WIA-xxxxxx’, where
‘xxxxxx’ is your scanner
name; or it will be listed
as ‘xxxxxx TWAIN’ (an
industry standard for
scanning), where again,
‘xxxxxx’ is your scanner’s
name. If both are listed,
select the TWAIN source.

Clicking on that will
get you to the driver
interface for your
scanner. Now,

depending on your driver’s
abilities, you can adjust the
scan size, quality settings,

image size, scan size, etc. If
you want to print a large
image, it’s recommended
that you scan at a higher
resolution and then resize or
crop, if required.

Once you have
imported the image
into your image editing
software, you can tweak

it to your heart’s content.
You may want to adjust the
colour, brightness, and
sharpness, or even apply cool
filters and effects to your
image. If your image has the
red-eye problem, correct it!
If it’s overexposed or
underexposed, correct that

too! In fact, refer to the Fast
Track book on digital
photography that was given
with the March issue of Digit.
There are plenty of Photoshop
tips and tricks in there.

Play with the menus and
settings in Photoshop,
and when you are pleased

with the results, continue
to the next step.

Once you are done with
the editing part, simply
go to File > Print. You
will see the print dialog

box, where you can select
the printer you want to
use (if
you have a printer
installed in addition to
your MFD). Then, click the
‘Properties’ button.

This will open the
printer driver’s
interface, and
allow you

to tweak various image
settings, such as image
quality, paper quality,
landscape or portrait
mode, etc. Make sure you
set the printer to print at
high quality, and set the

correct paper size, else you will
mess up your photo paper!

Finally, just click ‘Print’,
and watch as your tweaked
photograph is printed! You now
have your very own copy,
which, may be better-looking
than the original.

varun_dubey@thinkdigit.com

We’ve told you what you need to do to scan, edit and print
a photograph. What if you do not want to edit it? If you
simply want to copy it, and feel that the effort required—
however minimal it may be—to scan and then manually
click ‘Print’ is too much for your taste, all MFDs will let you
copy images at the touch of a button!

To copy your image, simply place it on the scanner bed
and press ‘Copy’. The device will first scan the image and
then print it.

But hang on! Before you go and starting wasting
paper, keep a few things in mind. Just pressing the ‘Copy’
button may not give you the best image quality. It’s fine if
you just want to copy text and are going to use your device
more as a Xerox machine than as a photo printer, but
for photographs, you may need to tweak your printer
settings a bit.

Most MFDs have an LCD screen—and some have a

colour LCD screen—where you can view and change
settings.

Navigate to the printer settings on your device and
select ‘Photo Quality’ from the print quality settings. Then
navigate to the page setup and make sure your page size is
set to the same size that you will be printing the picture on. 

Note that if you have a 4 x 6 size paper, and an image
much larger in size, you should also select the ‘Scale to page’
option. This will ensure that your photograph is resized, and
that the print sizes of the image and the page match.

Some MFDs, such as the Epson RX630, come with
memory card readers—so you can just take your memory
card out of the camera and plug it into the MFD. You can
view the LCD to edit and print the image! Some other MFDs
also let you do basic image editing, such as cropping, rotat-
ing, resizing, and even increasing and decreasing
brightness and contrast!

Copying An Image

Tweak your images in Photoshop

The Epson Stylus PHOTO CX1500



LCDs can be mounted on walls for different
purposes and use in public places

Wall Mounting An
LCD Panel

Photograph Jiten Gandhi
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Courtesy
wall
mounts,
LCDs can
now be
used in
airports,
showrooms,
and hotels,
and do not
mess up the
décor as
CRTs did
earlier

Disconnect The
Panel
If the panel is in use,

you will first need to
disconnect it from the PC by
plugging out the video cable
and power cord, and if possible,
detaching both these cables
from the panel as well. 

Remove the panel from its
current stand and place it face
down, gently, on a flat, dry and
smooth surface. Make sure
there is nothing in the way
that could damage the screen.

Hole Spacing
In the LCD manual,
check out the VESA

wall mount page to find out
the spacing between the holes.
There are two standards; the
75mm and 100mm. This
spacing will decide the type of
wall mount you need to buy.

Various Wall
Mounts
There are several types

of wall mounts available, such

as the one in the form of an
arm, which gives you the
flexibility to move the panel
and face it in all directions. 

You also get non-flexible
types. Make sure you make the
right choice, since once it’s bolted
on to your wall, there’s not really
much you can do
to change it. 

Fix The
Wall
Mount

Once you know
the size
between the
threaded
holes, get
the wall
mount of your choice and
get prepared to bolt it to
the wall. First of all, fix
the sheet metal back plate
of the wall mount to the
LCD panel.

This back plate has
four U-shaped pegs, which
fit exactly into the
provided groove on the
wall mount. 

Drilling Holes
Now it’s time to
drill holes in the

wall as per the size and
diameter mentioned in the
manual, so you can fix the
second plate. This is the plate on
which the panel, along with the
arm, will be fastened.

Arm Assembly
Fix the arm assembly on
to the wall plate with

the help of the provided nut and
bolt. Make sure that the arm
assembly is secured tight
enough to take the load and

Aliasgar Pardawala and
Varun Dubey

L
CD panels have gained
popularity primarily
because of their small
footprint and low power

consumption. These factors
have made a lot of people turn
a blind eye to their
shortcomings such as their
restrictive viewing angle. 

Due to this popularity,
manufacturers took LCDs a step
further by introducing a
wall mount. Since an LCD
panel doesn’t weigh much,
it is easy to mount it on an
adjustable arm that’s
fitted on your wall. This
meant that LCDs could
now be used in places such
as airports, showrooms,
hotels and restaurants,
and not mess up the décor
as CRTs did before. 

However, none of the 
panels available in India
come with the Video
Electronics Standards
Association (VESA)
compliant wall mount.

This
is done to
decrease costs,
as India is a
very price
sensitive
market. 

If you
would like
to get a
wall

mount, you will need to buy it
separately from your vendor.
Here, we have elaborately
explained how you can fit the
panel in the wall mount.

Wall mount VESA arm

PPM63h3 63-inch Samsung Plasma TV

Two mounting
plates

Wall mounting design map
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occasional jerks that it will
be subjected to. 

Mount Your
Display
Fasten the arm  with

screws to the plate that you
fixed on the back of your
LCD panel earlier, and check
for tightness. That’s it. The
panel is mounted on a VESA
wall mount and ready for
use. All you have to do is
reconnect the wires! 

TV Or PC Monitor 
Or Both?
Some LCD monitors come
with the neat feature of having
an inbuilt TV tuner. These
devices have a regular port for
connecting to your PC or laptop,

and also have a socket to plug in
your cable. The inbuilt TV tuner
then scans and stores all the

channels available, letting you
operate your monitor as a
regular flat screen TV! Moreover,
you don’t even need to have

your PC switched on in order to
watch your favourite TV show!

Apart from the
aforementioned video inputs,
LCD monitors feature the whole
gamut of connectors for
attaching your
DVD, VCD or
other video
input sources—
such as
handycams—as
well. They
generally
support various
screen aspects

(16:9; 4:3). They will also let
you zoom into the image!

This is where it gets
really cool. Some of them
also support the PIP
(Picture-in-Picture) function
wherein if you want to
watch a show but have a
pressing deadline at work,
you can start working on
your presentation and 
have the TV program run
as a small window on 
the screen.

The beauty of this
function is that the
window need not remain
small. You can resize it to
whatever size suits you,

and you can also place it
anywhere on the screen! 

aliasgar_pardawala@thinkdigit.com
varun_dubey@thinkdigit.com

Since an
LCD panel
doesn’t
weigh
much, it can
be easily
mounted 
on an
adjustable
arm fitted
on your wall

DLP (Digital Light Processing): A technology by Texas
Instruments, it uses a Digital Micro Mirror, which consists of a
million small mirrors that reflect light and hence create the
image. DLP is touted to be the best digital picture you can get
because of a better fill rate. The fill rate is essentially the ratio
of the frame making up the image to how much of the frame
lies between the elements. For DLP, the fill rate is a massive 
88 per cent!
D-ILA: Digital Direct Drive Image Light Amplifier is a type of
LCD display that was developed by JVC. Unlike LCD, its
elements reflect light twice before letting it pass through the
lens. D-ILA offers a 93 per cent fill rate.
LCoS: LCoS stands for Liquid Crystal on Silicon, and is Hitachi’s
version of D-ILA.
Plasma: A plasma screen is different from the regular screens
as it contains millions of small compartments filled with stable
noble gases Argon, Xenon and Neon. To turn a pixel on, an elec-
tric current is passed through the compartments, thus charg-
ing the gas, and hence producing red, green, or blue colour.
Rear Projection: The size of a rear-projection television gener-
ally ranges between 40 and 80 inches. The front projector proj-
ects the image onto a mirror, which then reflects it onto the
display screen where we finally see it. 
Front Projector: This is a two-piece unit similar to the stuff
they use in movie theatres. With this kind of a setup, you will
have two parts to your TV: the projector and the display screen.
It can be made from any of the above mentioned display types,
namely LCD, CRT, DLP, D-ILA, or LCoS.

Two-Piece Rear Projection: This is similar to a front projector,
except that the image is projected onto the screen from behind,
instead of from the front (unlike in a theatre where the projec-
tor is placed at the front of the screen). 
High Definition Television (HDTV): Regular NTSC TV signals
will provide you with 525 lines of resolution, and as a thumb
rule, the higher the
number of lines,
the higher the
resolution. HDTV
gives you five times
those many lines,
and thus, the clar-
ity and sharpness is
simply outstand-
ing. Moreover, the
aspect ratio of
HDTV is 16:9
(widescreen) as
opposed to 4:3,
which is the regular
television format
these days.

The flip side is that since it has such high resolution, the
transmission of signal requires a massive amount of bandwidth
which makes it almost prohibitively expensive. HDTV receivers
are on an average 30 per cent more expensive than their
conventional top-of-the-line counterparts.

HLP6163 61-inch Samsung Rear
Projection TV

Swivel arm assembly

Mounted display

HC-P4741W 47-inch Samsung
Widescreen HDTV Monitor

Display Technologies



Adding Effects 
To Your Home Videos
Your home videos no longer need to be bland and
boring. Make your own movie with a title and credits
at the end... Here’s how

Photograph Jiten Gandhi
Imaging Atul Deshmukh
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Adding
effects to
your home
videos that
can make the
videos look
professional,
and make
you look
good

are listed. The area at the
bottom are the ‘Storyboard’ and
‘Timeline’ areas, where you will
be able to monitor how your
video progresses. 

While ‘Storyboard’ displays
the videos and transitions you
are using, the video effects, text
effects and audio items can only
be added to the ‘Timeline’ view. 

In the ‘Storyline’ view, these
items appear as symbols below
the video.

Click on the first blue
button below the ‘My
Media’ files to browse
and select the video

clips to be added to the
compilation. A browsing
window will be opened and you
may choose as many video clips
as you want. Now, just click
‘Open’. Almost all popular video
formats—except Real Media—are

supported. The video clips
added will be visible in the ‘My
Media Files’ list.

For transition
effects to be
added, you need
multiple clips to

add transitions in
between. Hence, it is
recommended to have as
many clips as possible. 

But, if all your videos
are just one file, you can
also insert transition
effects into the video. 

Right-click on the
video in the ‘My Media
Files’ list and click on
‘Detect Scenes’. Scenes will
then be automatically
detected and displayed.

Detected scenes can be
added to the project by
dragging and dropping
them to the ‘Storyboard’

and ‘Timeline’ areas. 
Then, click on the ‘Display

Transition’ tab, which is the last
tab above ‘My Media’ files.

Here, you will find a host of
transition effects, which are
further classified into 3D,
Wipes, Others and Fades. 

3D effects consist of many
three-dimensional effects such
as Exploding Cubes, Horizontal
Spinning Strokes, Spherise,
Tunnelise, and so on. 

‘Wipes’, as the name
suggests, consists of several
wipe effects such as Circles,
MeltDown, Paper Roll, Wipe
Left, Right, Up or Down, etc. 

‘Others’ has Move In and
Move Out while ‘Fades’ consists

Jayesh Limaye

S
o you’ve finally managed
to store the memorable
videos you captured
during your holidays last

year. And now you even have it
on your computer’s hard drive.
What next? 

You could add some
transition effects to your videos
to give it a professional feel. 

You might have frantically
searched the Internet looking
for tools that might let you do
this, and probably found that
everything available is either
shareware, or whatever is
freeware, has very few features. 

Most of you might not be
aware that Ahead, the makers
of Nero Burning ROM, has
developed a tool—NeroVision
Express 3—that lets you do all
the editing you want.

NeroVision Express 3
can also be downloaded
from http://nero.com,
where it is also updated
quite frequently.

This utility not only
supports adding transition
effects to captured video,
but also lets you capture
video using your TV tuner
card, video capture devices
and DV cams.

To start off, open
NeroVision Express
from the Nero
program group.

Now, click on ‘Make

Movie’, located on the left
of the window. 

A new ‘Untitled Project’
window will open up. In
this window, you will
have a preview pane on

the left, while on the right, you
will be able to view the ‘My
Media’ files, in which the
videos selected by you for the
addition of transition effects

Nero Version Express 3

Movie Project Window

Detected scenes are displayed

Scene Detection Window

Movie Project Window after choosing
video clips
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custom, you can specify the bit-
rate and resolution for the
output video. 

In the ‘Sample Format’ drop-
down menu, you can specify the
interlacing method. It is best to
set this as Automatic. You can
also specify the Encoding

mode—choose between ‘Fast’
and ‘High quality’. Finally, you
can specify the audio format—
you can choose between Dolby
Digital (AC-3) 2.0 and Stereo.
Choose ‘Stereo’. 

You can also view the
duration of video that can be
accommodated on one disc. This
video format requires the
highest amount of space.

When you choose VCD,
the output video is created
in MPEG-1 format. Resolution

for PAL is 352 x 288
at 25 fps.

In the ‘Custom’
template, if you select
MPEG format, then
you can also specify an
aspect ratio of your
choice. If you select AVI,
you can select the
compression codecs for
video and audio. You
can also specify the
video format such as
PAL, NTSC or Custom. 

When ‘Custom’ is
selected, the frame
rate and resolution
can be specified. Once
you do this, choose a
location of your choice
for your output file

and name the file. 
When you click ‘Export’, the

final file with the transition
effects you added is created. It’s
as simple as that. 

jayesh_limaye@thinkdigit.com

Digital camcorders with 10X and 20X optical zoom that can really let you get
‘into’ the thick of things!of several effects such as

Additive Blend, Blinds,
CheckerBox, Blur Fade, and
many more. 

These transitions can be
added between the scenes by
just dragging and dropping
them in the desired place.

Once you have
added all the effects you
want, click on
‘Export’ to bring

up the window of the final
stage, where you can
specify various settings
regarding the video file to
be output.

Here, you may select an
export template from DVD,
SVCD, VCD, or Custom, if
you wish to specify the
format of the output video
file. In file types, the
options available are
MPEG-1, MPEG-2 and AVI. 

In the ‘Export
Template’, when you select
DVD, it essentially means
the MPEG-2 video
standard. This standard is
known for its high video as
well as audio quality. 

If you choose NTSC, the
video resolution chosen is 720 x
480 at 29.97 frames per second
and the bit-rate is 5,073 kbps. 

If you wish to choose the PAL
standard, the resolution
becomes 720 x 576 at 25 frames
per second with the bit-rate
remaining the same. You can
configure the different settings
by clicking the ‘Configure’
button. In the ‘General’ tab, you
can choose the video standard
according to your country or
between PAL and NTFS. 

In the DVD-Video tab, you
can choose the aspect ratio from
between 4:3, 16:9 and
Automatic. In quality settings,
you can choose from Automatic,
High, Standard, Long Play,
Extended Play, Super Long Play
and Custom. If you choose

After adding the transitions in between
the scenes

AAddoobbee  AAfftteerr  EEffffeeccttss  66..55::  This is a high-end tool for video editing and motion
graphics. It has stunning 2D and 3D transition effects that create professional-
quality videos. It is available in Standard Edition, which costs $299 (approx Rs
13,000) and Professional Edition, which costs $999 (approx Rs 43,450). Additionally,
the Professional Edition has flexible Motion Tracking, powerful scripting, precise
keying and matte tools, advanced visual effects and much more. These are some
features the Standard Edition does not have. 
MMaaiinnCCoonncceepptt  MMaaiinnAAccttoorr  vv55::  This tool grants you high-end power at entry-level price.
It has all the necessary features for good quality video editing, plus a dynamic inter-
face. The demo version can be downloaded from www.mainconcept.com. The retail
version is available for $199 (approx Rs 8,650).
WWiinnddoowwss  MMoovviiee  MMaakkeerr  22..11::  Windows Movie Maker 2.1 is included in Windows XP SP2
and Windows XP Professional x64 Edition. This tool can capture—as well as edit—
videos from various devices including DV Cams. You can create home movies and give
them a professional look from the 130 new titles, effects and transition options that
are available with this software.

Other Software You Could Try...



Back Up Using A
Portable Drive
It’s easy to use Windows XP’s inbuilt backup
software to always have a backup of your
data at-hand

Photograph Jiten Gandhi
Imaging Atul Deshmukh
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You can
choose the
type of
backup:
Normal,
Copy,
Differential, 
Incremental
or Daily

guided tour of the advanced
feature set.

Backup
Click on the backup
tab, and you will be

taken to a split window akin to
a file explorer. Here, you can
check the boxes next to the
folders on the left pane (if you
want to back up the entire
folder or drive). After you select
folders, the entire contents
(including files) are displayed.
Select the files or folders you
want to back up.

Once you’re done, select the
location to where you 
want to back up, and also what
name you would like to 
specify for the backup, from
the drop-down menu below.
Now click ‘Start Backup’.
Remember, it’s a good practice
to keep a date and data-
indicative nomenclature.

When you click ‘Start

Backup’, you will be presented
with a backup ‘Job
Information’ window where
you can modify the name and
description of the backup.

Now you have two options:
you can either append the
backup to your existing
backups on the media, or you
can wipe out other backups
and create a new one by
selecting ‘Replace the backups
in the media with this backup’.

Advanced Options
Clicking on the
‘Advanced’ tab will get

you to a backup options
window where you can choose
to verify the data after backup,
or back up data onto remote
storage. You can also choose
the type of backup, as
mentioned below.
Normal: A regular backup. 
Copy: Simply backs up the
selected data, but does not
mark anything as backed up.
Incremental: Backs up the
selected files only if they have
been created or modified since
the last backup.
Differential: The same as
incremental, except that it
does not mark the files as
backed up.
Daily: Backs up the files
created or modified only today.

When you click ‘Schedule’,
you will be prompted with a
warning that says you should
save your backups before
scheduling. Click ‘Yes’, and
you will be prompted to set
up a password for security
reasons. Just enter a password
and confirm it, and you will
be ready.

You will be taken to a
window where you can give
this schedule a name, and
using the options button,
configure options such as
‘don’t backup if running on

Varun Dubey

S
o you have a sprawling
MP3 collection, a whole
lot of movies, and, of
course, important

documents and contacts,
addresses and the like.
Wouldn’t you sleep a whole lot
better at night knowing that
you have a secure and safe
backup of all your important,
and possibly critical, data?

We give you step-by-step
directions to back up your data
to an external drive. In fact,
you can back it up to pretty
much any drive using the
instructions given here!

What You Need
A drive to back up your data on
(any USB or FireWire external
HDD). The software we will be
using is Windows XP’s inbuilt
backup software.

Accessing The
Software
To launch the software,

go to Start > All Programs >
Accessories > System Tools >
Backup. If you don’t have 
the software installed, you 
will have to add the feature
from your windows XP 
installation CD.

The software starts with a
wizard. If you just use the
wizard, it is fairly simple to
carry out routine backups, but
we will take you through a

Choose from the various backup types available

The backup software starts with a wizard

Enter the name of the backup file
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battery’ (in case it’s a laptop),
the time that the backup
should show, and of course,
you can also configure when
you want to schedule the
action. You don’t want your
work to be disturbed because
of backing up going on in the
background. You can choose to
back up on weekends,
when you won’t be using
the machine; at system
startup, if you’re a little
paranoid; when the
system is idle, so you have
a backup ready when
you’re done with a work
session—
and so on.

Once all this is
configured, you can
finally start your backup.
The backup file is saved
with the .bkf extension.

To restore your backup,
simply fire up the
software, and if you are in
‘Advanced’ mode, click on
the backup file you want 
to restore, and click 
‘Start restore’.

Digit Tip!
Are you synchronisation-
phobic? Well, you aren’t alone!
We offer you our heartfelt
sympathies—we know that
synchronisation isn’t the
easiest of things. Add to that
the trouble of remembering to

synchronise and back up, and
all the cables—and it makes
you wonder, “Isn’t convergence
supposed to make life easier?
Isn’t that what we have
‘standards’ for?”

Efforts are on, but true
plug-and-playability is still
some way in the future.

But we have a really neat
solution for all your data
synchronisation between
office and work.

Most motherboards today
support booting via an
external USB drive. What you
can do is, format and partition

your external
storage drive.

While
connected to
your office PC,
install the OS
on the first
partition.

Once all the
drivers have
been installed,
migrate your
data to that
partition.

When you get home, boot up
your PC and install your OS on
the second partition. Migrate
all your work-related
documents from your home PC
to the second partition.

Now this portable drive has
essentially become your

laptop—sans the screen
and CTS-inducing
keyboard! 

The reason you need 
to install two OSes is
because different
configurations will have
different drivers that will
be loaded, and doing it off
the same operating system
will lead to system
instability.

Now, depending on
where you are—home or
office—boot up using the
appropriate partition, and
you will never need to
synchronise data to carry it
back and forth: it would all

be stored and worked upon from
the USB drive.

If you have installed the
same OS on both partitions,
the dual-boot option will give
you the same name, so how
will you know which one
to use? Simple...

The name that appears is
configurable. To configure it,
right-click ‘My Computer’,
and select Properties >
Advanced > Startup and
Recovery > Edit.
In the window that opens,
look for the text in quotes
stating with “Microsoft
Windows XP…”
You can type whatever you
want within the quotes, and
that will get displayed as the
boot option.

varun_dubey@thinkdigit.com

The reason
you need 
to install
two OSes is
different
configs will
have
different
drivers that
will be
loaded, and
doing it off
the same
OS will lead
to system
instability

The settings for a scheduled backup

A choice of OSes shows up at bootup... ...Rename these to anything you like! 

Restoring a file from your backup



It’s very tempting to just use Auto
mode on your digicam all the time, and
that’s just the fear of the unknown.
Here’s how to overcome it!

Understanding Manual
Camera Configurations

Photograph Jiten Gandhi
Imaging Atul Deshmukh
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With
manual
control, you
can
experiment,
and capture
what the
Auto mode
will not

sensor) and the depth of the
photograph.

This setting works in tandem
with the shutter speed, so if you
want shots of something moving
fast, you should increase the
aperture size and increase the
shutter speed to minimise the
blur. In fact, if you get the
balance right, you can even get
brilliant blur effects—like the
ones you see on F1 posters!

Aperture Priority
You can select the desired aper-
ture and the camera will automat-
ically select the best shutter speed
for it. (Some cameras will let you
set both independently, but these
are mostly professional cameras).

AE Lock
Automatic Exposure Locking is
the ability to lock the aperture
and shutter speed (and hence,
Exposure) settings for a series of
images. That is, for every image

in the series, the aperture and
shutter speed settings will be
the same. This is extremely help-
ful if you are trying to merge
multiple images together (while
creating a 3D walkthrough, for
example, or during the creation
of a panoramic image).

Exposure Compensation
In Auto Mode, the camera basi-
cally selects a part of the image
to determine the correct expo-

sure value. Sometimes, though,
it selects the wrong part, and
your photo may turn out over- or
under-exposed (depending on
the selected area). To counter
this, most cameras today let you
change the wrongly-calculated
exposure value using the EV
(Exposure Value) compensation
feature. The camera usually
provides you with a slider oper-
ated by the ‘navi’ keys, and the
EV compensation values range
from -2 to +2 with incremental
steps of 1/3.

Flash Output 
Compensation
Some cameras even allow you to
determine the power of your
flash. This means you can
control the amount of light the
flash emits when you shoot. This
is helpful when, due to confus-
ing light conditions, the flash
metering (calculated automati-
cally) goes awry.

ISO 
The ISO setting on your camera
basically tells you how sensitive
the camera sensor is to the light
falling on it. Now, for regular
film cameras, the ISO rating is on
the film roll, but in digicams, the
setting is related to the camera’s
sensor. As a thumb rule, the
higher the ISO setting, the faster
the shutter speed required. So, if
the ISO setting is too high, you
will start seeing a lot of noise and

Varun Dubey

A
re you one of those who
would love to get friend-
lier with your digicam
but find that the menus

and acronyms are just too
confusing to bother with—and
simply use the Auto setting on
your camera? Many people do
not realise the true potential of
their camera and tend to do
this.

It’s true that most of the
default settings in cameras
these days work just fine, and
the hassle of tweaking puts
people off of the manual
controls. But with manual
control, you can experiment,
and capture what the Auto
mode will not—especially when
it comes to things such as shad-
ows, lighting effects, black and
white photography... Read on
and find out how you can tweak

those settings to get the best out
of your digital camera.

Aperture Settings
The aperture is the size of the
opening in the lens, which
determines how much light
received falls on the camera’s
sensor (in the case of digicams)
or film (in the case of conven-
tional cameras). This setting
affects the exposure (the
amount of light received by the

An under-exposed image on the left vis-à-vis a correctly-exposed image on the right
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the image will become grainy.
You therefore need to maintain
the correct balance between ISO
and shutter speed and aperture,
as well as the exposure setting.

Macro Mode
Macro mode is used for extreme
close-ups. When set in Macro
mode, the camera will assume
that the subject is extremely
close, and will adjust the settings
accordingly. Most prosumer
cameras today let you shoot a
photograph as close as 4 cm from
the subject.

Metering
The “metering” in a digicam basi-
cally scans the entire scene,
calculates the amount of light
and then calculates the appropri-
ate exposure value. There are
three types of metering modes.

In the automatic mode, you
just select the type of metering,
and the camera will calculate the
rest. The various methods of

metering differ from
each other
depending o the
way the scene is
scanned for the
determination of
the exposure
value.

Matrix or
Evaluative
Metering
In this kind, the
scene is divided

into different zones (like a
matrix) which are then 
evaluated individually for 
the light availability and 
exposure requirements. Then
the algorithm, which differs
from camera to camera, calcu-
lates the correct amount 
of exposure.

Centre-Weighted
Average Metering
This is the most common meter-
ing method, and is implemented
in pretty much every digital
camera. In this method, the
camera scans and calculates the
exposure for the entire scene, but
the centre of the photograph is
given a higher weightage than,
say, the edges.

Spot (Partial) Metering
In Spot Metering, only a small
area of the whole frame is
metered and the exposure of
the remaining frame is
ignored. This is helpful when
shooting portraits or close- ups
of people.

Shutter Priority
This is similar to Aperture Prior-
ity except that in this case, you
can select the shutter speed 
and the camera will automati-
cally select the appropriate
aperture setting.

Shutter Speed
This is the duration for which the
sensor of the camera receives

light. If you keep the shutter
speed high, the camera sensor
will receive light for a lesser time,
and vice-versa.

Time Lapse
Some cameras can be
programmed to take multiple
photographs over a specified
interval of time with a set time
gap between each shot. This is
mostly used for photography in
astronomy, or for special photos
like capturing the opening of a
flower bud.

White Balance
In digital cameras, white
balancing is done on a per
photo basis. The camera decides
the white balance for each
photograph by scanning the
image and taking a portion of it
as a reference point.

This system can easily be
fooled if the image is domi-
nated by a single colour. For
example, if you are shooting a
room, and there’s a bulb throw-
ing yellowish light on a white
wall, the camera will assume
the wall to be white and calcu-
late everything else based on
that—and would get it wrong.
So, the cameras of today let you
change the white balance for
such circumstances. The basic
available modes include
Sunlight, Tungsten (A and B),
Indoor, Fluorescent light 
and others. 

varun_dubey@thinkdigit.com

Most
prosumer
cameras
today let
you shoot a
photograph
as close as
4 cm from
the subject Incorrect white balance leads to incorrect colours in the left image. The image on the right shows the image using the

correct white balance, and therefore the correct colours



Drive Your Graphics
In this brief primer, we tell you a
little about graphics card
features—so you can get the 
most out of your card

Photograph Jiten Gandhi
Imaging Atul Deshmukh
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There are
two APIs
using which
games are
developed.
The first is
DirectX,
and the
second,
OpenGL

DIRECT3D
Bump Mapping
This feature—when enabled—
allows textures to show
depth. Tiles on the floor, or a
tiled stone wall, will actually
appear bumpy. This feature
was introduced in DirectX 6
and thus, most current-
generation games support
this feature by default.

When enabled for older
games, it will improve image
quality, but reduce
performance. This, again,
depends on the game, and
whether the game supports
this feature. Games these days
use two types of bump
mapping—EMBM (environment

mapped bump mapping), and
DOT3 bump mapping.

EMBM can generate
the bump mapping
effect with intricate
details such as the pock-
marked surface of
bricks, scratches on a
metallic surface,
realistic reflections on
water ripples, and
more. This was
introduced in the
Matrox G400 graphics
chip for the first time
back in 1999.

DOT3 bump
mapping, also known as

Aliasgar Pardawala and
Jayesh Limaye

G
raphics card drivers are
software that help the
card work seamlessly
with the rest of the

system, and can enable better
performance. Graphics card
vendors usually release updated
versions of these drivers on a
regular basis, so you can get
that little extra from your card. 

Many features and
enhancements depend on the
way drivers are written. Some
games are specifically optimised
for certain versions of drivers,
and vice-versa. Here are some
critical features to get more
performance from your games.

There are two APIs
(Application Program Interface)
using which games are
developed. The first is
Microsoft’s DirectX, of which
Direct3D is a critical
component. The second is
OpenGL—Open Game Language.

Games developed using either
of these APIs use different sets of
features, which can be enabled or
disabled to improve quality
and/or performance. We’ve
classified the various features
under ‘Direct3D’ and ‘OpenGL’.

Anti-Aliasing
This is a technique that removes jaggedness at the edges of
an object. Since it eats up lots of GPU cycles, a higher setting
will lower the frames per second that you can get. Most cards
are set by default to the lowest setting of 2x, and the
‘Application Preference’ option lets you define the setting
from the game.  

Anisotropic Filtering
This filtering technique—when enabled—lets you see distant
objects clearly. A good example is a straight road. With this
setting enabled, you will be able to see the texture even at the
farthest point clearly. Similar to Anti-Aliasing, the lowest
setting is 2x, and there is also the ‘Application Preference’

option. A higher setting of, say, 8x, will dramatically improve
image quality, but will also adversely affect the output frames
per second.

Texture Compression
This is a technique, using which, a compression algorithm built
into the hardware of the graphics processor compresses and
decompresses the texture data, which results in an increase in
the effective bandwidth of the graphics data path between the
graphics chip and the CPU.

This was developed by S3 for OpenGL applications, and
was known as S3TC. It was later adopted by Microsoft and used
in DirectX, and became known as DXTC (DirectX Texture
Compression). This feature requires that the hardware be
capable of supporting it.

Graphics Jargon

Adust the Anisotropic Filtering in the nVidia
control panel

This image shows how bump mapping
is used to create the emboss effect on
the kettle
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per-pixel lighting, allows you to
add high detail to surfaces or
objects without increasing the
number of polygons.

Dither Mode
This is a mode setting for ATi
drivers that works in tandem
with Alpha Blending. It is
instrumental in deciding the
wave pattern created by water
bodies and other similar
effects. Alpha blending, on the
other hand, is used to impart
the transparent look to water
or glass.

When enabled, this will hit
performance, but will make
game scenes on a beach or
when swimming look very real. 

Pixel Shader Version
The latest generation cards
from ATi support Pixel
Shader 2.0, while those of
nVidia support 3.0. However,
by default, the setting is
‘Driver Default’. There are
other options such as 1.0,
1.1, 1.2, 1.3, 1.4, 2.0 and 3.0
also available.

A higher version of
Pixel Shader can only be
selected if your hardware
supports it and if you have
installed the latest version
of the display drivers and
the  appropriate version of
DirectX (e.g., Pixel Shader
3.0 is supported only in
DirectX 9.0c ). You can
even lower the setting to
get better performance,
albeit at the loss of
image quality.

Vertex Shader Version
This is similar to Pixel Shader,
and choosing a lower Vertex
Shader version will offer
better performance.

TCL Back Face Culling 
When you select this function
from the driver, objects that
are not visible to you are
removed. This frees up a lot of
bandwidth, which improves

performance. This means better
performance at no decrease in
graphics quality!

OPENGL

3DNow!/SSE and SSE2 
3DNow from AMD and SSE2
from Intel are optimisations
built into the processors.
Enable this feature to reap its
benefits when playing OpenGL-

based games—you’ll get
increased performance. 

AGP Textures
If you haven’t upgraded to
a PCI-Express-based
graphics card yet, and are
still using an AGP
interface-based graphics
card, you should enable
this setting. It provides
OpenGL-based games
access to your system RAM
to store texture
information when
necessary. This option
should be used if the card
has about 64 MB of
onboard RAM, and you are

playing texture-heavy games
such as Doom 3 or Far Cry.

Video Memory Textures
When enabled, this only uses
video RAM, and doesn’t transfer
texture information to system
RAM. This feature should be
enabled if your graphics board
has more than 128 MB of RAM.
However, cards with lower
memory will experience a
drop in performance if this
feature is enabled. 

Force 16-bit Texture
When enabled, this feature
forces down colour depth from
32-bit to 16-bit. This improves
performance but makes textures
look flat. 

aliasgar_pardawala@thinkdigit.com
jayesh_limaye@thinkdigit.com

With TCL
Back Face
Culling,
objects not
visible to
you are
removed.
This means
better
performance
at no
decrease in
graphics
quality

The above image is an example of how anisotropic filtering has been used to
clearly display the floor tiles even at a long distance

Adust Anti-Aliasing in the nVidia
control panel

Adust the image quality here in the
nVidia control panel



Hang your projector from a ceiling 
to save space and project better

Ceiling-Mounting 
A Projector

Photograph Jiten Gandhi
Imaging Atul Deshmukh
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If you feel
the screen
size of a
plasma
display or a
rear-
projection
television
doesn’t
justify the
price tag,
the best
answer is 
a projector

Aliasgar Pardawala

H
ome theatres are all
the rage now, as prices
of the plasma displays
and sound systems

have dropped to affordable
levels. But if you feel the screen
size of a plasma display or a
rear-projection television
doesn’t justify the price tag,
what alternative do you have?

The best answer is a
projector. Projectors are
compact compared to rear-
projection televisions or plasma
displays, and the screen hangs
on a wall—hence not occupying
any floor space. 

The only problem is the
position of the projector: it has
to be in front of the screen.
This will leave you with the
option of either sitting behind
the projector or beside it. 

Sitting behind the projector
can be troublesome because of
the noise of the fan and the
bright light from the lamp. 

You can free
the table space
and reduce
cable clutter by
fixing the
projector on 
the ceiling. 

This will
eliminate the
problems that
you might have
faced, had the
projector been

A typical ceiling mount attachment

placed on the centre table or in a
bookshelf. Also, mounting the
projector on the ceiling will help
in better air flow, but this will
depend on the design of the
mount as well. 

A bad design might block the
air flow and damage the
components or reduce the lamp
life, and lamps are expensive.

A ceiling mount for a
projector is also useful in
boardrooms where you need to
have a fixed projector for
presentations. Here, we help
you to perform the mounting
task all by yourself.

At present, there are no
specific standards on
adhering to dimensions
for the ceiling mount.

You will have to get one that
will work with your projector.

The right place to enquire
for your model-specific ceiling
mount is, of course, the vendor
from whom you purchased the
unit. Since ceiling mounts are
not readily available, there may
be a waiting period before you
can get one. 

The ceiling mount is
not a single unit. In
most cases, it is either
in two (or a maximum

of three) pieces—two plates 
and an arm. 

The first plate with the
drilled hole will exactly match
the four drilled and taped holes
at the bottom of the projector.

If the mount is
brand and model-
specific, be rest
assured—you will
get a smooth fit.

If you get a
universal ceiling
mount, you will
need to adjust
the plate to
match the
mount holes 
at the back 

of the projector. There are
several designs available, for
example, a single plate with
many drilled holes so that it
can match a wide variety of
projector models. 

Alternatively, use four
flexible arms instead of a
plate, so that you can move it
to the position exactly over the
mount holes on the projector
and fix it. 

Fix another plate on the
ceiling securely, as this plate is
the one that will bear the
weight of the projector and 
the mounting arm.

Fix one side of the
flexible arm first to the
ceiling plate, and then

Some considerations to bear in mind
when selecting a projector
LLCCDD  vvss  DDLLPP

Differences are minimal for most
educational uses 

Better contrast ratios of DLP may
be better suited for high ambient
light situations 
IImmaaggee  ffeeaattuurreess

Check the brightness first and then
the contrast ratio 

Match the resolution of projector
to that of the computer 

Consider short throw distance and
keystone correction as extra features 
CCoonnnneeccttiivviittyy

Wireless connectivity is the latest
new feature in projectors 

Wireless is useful for rapidly
switching between multiple inputs 
SSiizzee

While smaller projectors 
provide flexibility, it is at the cost 
of some advanced features and
physical security 
EEdduuccaattiioonnaall  ffeeaattuurreess

Blackboard mode helps
compensate when projecting without
a screen 

Bundled document cameras can
project paper and 3-D objects 

Copy-boards can be used for
annotating and saving images 

Buying Tips

A projector with ceiling attachment
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fasten the projector with the
mount plate to the other end
of the arm. Once this is done,
you are through with the
fixing part.

Switch on the
projector. We’re
assuming you have
taken care of the

cabling part, as you will
need a longer cable—both
video and power—to plug
in your video source (such
as a DVD player) to the
projector and power it up.
Since the projector is
ceiling-mounted upside
down, the first time you’ll
see the company logo or a
wallpaper upside-down on
the screen. 

To correct this, click the
menu button on the
projector and go to

‘Options’. Here, you will see an
option that reads similar to
‘Desk/Ceiling Mount’. By
default, this is set to ‘Desk’;
change it to ‘Ceiling Mount’. 

You will now need
to adjust the focus
and the zoom for
image sharpness,

and also perform keystone
correction such as trapezoidal
and rotation corrections. 

Since the flexible arm can 
roll, pitch and yaw (swivel in
three dimensions), you can use 
it to correct keystone
discrepancies. In fact, you can
also use software to achieve the 
same effect.

Now, you view your
favourite movies large and
clear, without having the
projector as your 
immediate neighbour! 

aliasgar_pardawala@thinkdigit.com

You can use
the flexible
arm to
correct
keystone
errors

Different kinds of ceiling
mount attachments

Epson EMP-SiH
Align the screws of the ceiling mount exactly with the
drilled holes at the back of the projector

Some dos and don’ts of buying a projector:
LLCCDD  OOrr  DDLLPP:: If your usage is more document-oriented rather
than multimedia-oriented, you won’t notice much difference
between DLP and LCD projectors. The higher contrast ratios
offered by DLP make it much more convenient to use your
projector in less-than-ideal light.
BBrriigghhttnneessss:: The brightness is an extremely important aspect of
a projector’s performance. As a thumb rule, the brighter the
projector, the better the image. In most cases, for a regular
room, a 1000-lumen projector will work just fine. For a larger
room or a larger size of the projected image, a brighter projec-
tor is required, because the larger the image, the dimmer it
appears. Conversely, as your room grows dimmer, the image
projected becomes brighter and clearer. 

If you cannot buy a brighter (read: more expensive) projec-
tor, then investing in a high-quality screen with high reflectivity
is advised, as this will reduce the dimness of the image to a
large extent. If you plan to use your projector primarily for
PowerPoint presentations and for watching movies, you really
don’t need a really bright projector, as the amount of detail
required to be shown here is fairly low. 

However, if you plan to use it for graphics and Excel spread-
sheets that require a higher amount of detail, you need to get a
brighter projector. As a general rule, the higher the brightness,
the lesser the life of the projector. Almost all projectors will let

you adjust the brightness, as a lower lumen value can signifi-
cantly enhance the lamp life. 
CCoonnttrraasstt  RRaattiioo:: A higher contrast ratio allows you watch your
movies with ease even in less than optimal light conditions.
Also, a higher contrast ratio will improve colour shading. A low-
end projector can make up for its relative lack of brightness by
having a higher contrast ratio.
RReessoolluuttiioonn: The higher the resolution, the higher the price. The
most common projector resolutions are 800 x 600 and 1,024 x
768, but you do get 1,280 x 1,024 and 1,600 x 1,200 projectors
that are very expensive and meant for specialised uses.
TThhrrooww  DDiissttaannccee:: The further you move a projector from a wall, the
larger the screen area is. However, some projectors are equipped
with wide-angle lenses that provide large image projections even
if they are at a small distance from the screen—useful in places
where there isn’t too much space available. 
WWhhaatt  YYoouu  CCaann  CCoonnnneecctt  IItt  TToo:: It is advisable to have as many
additional inputs as possible. Modern projectors incorporate
multiple video and audio inputs such as digital input, HDTV
input, S-video and composite inputs. Apart from these, if your
projector has WiFi connectivity, so much the better.
SSiizzee  MMaatttteerrss:: These days, you can get projectors as light as a
laptop, though much thicker. It is, of course, advisable to get a
projector that can be easily carried, but the smaller and more
powerful the projector, the more expensive it is.

How To Buy A Projector



Did you know you could configure a
simple Wi-Fi card as an Access Point?
It’s very easy with Windows XP—here’s
how to do it

Setting Up Wi-Fi Cards

Photograph Jiten Gandhi
Imaging Atul Deshmukh
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It’s easy to
get an
Access
Point or
router and
set up a
connection,
but that
can be
pretty
expensive

PCI slot. Plug in the Wi-Fi card.
Close the cabinet and attach the
detachable antenna to the card.

Since Wi-Fi uses radio
signals, line of sight is not an
issue—but at the same time,
make sure that the antenna is
not in a corner; this might
affect performance.

Installing The
Drivers
Boot the system, and
the card will be

detected. Install the driver and
utility that comes on the CD.
You might have to restart the
machine depending on the
driver’s requirements. 

The Configuration
Utility
The utility installed for
the card is where you can

do most of the setup from. Since
different manufacturers design
their utilities differently, you will
have to look at the  different tabs
on your card’s utility to get the
hang of it. It’s pretty simple with
most cards—you can initialise
the configuration/monitoring
utility from the ‘Start Menu’ or
from the Taskbar.

Create A New
Profile
In the utility, you will
need to create a new

profile. Give it an appropriate
name, and under the SSID field,
type in “New SSID”, or anything
else. Leave the channel to its
default value, which is 11 in
most cases if you have just one
Wi-Fi setup. Save this profile and
exit the utility.

Producing An
IP Address
You will need to give
the network an IP

address. To do this, go to the
‘Control Panel’ and click the
‘Network Connections’ tab.
Select ‘Wireless Connection’
and right-click it.

In the window that pops up,
click ‘Properties’. This will
open a new ‘Wireless Network
Connection Properties’ window,
where you’ll see a TCP/IP field.

Highlight it and click the
‘Properties’ button. This will
open a window where you can
assign the IP address, subnet
mask and DNS server.

Aliasgar Pardawala and
Varun Dubey 

D
on’t you wish you could
access stuff on your PC—
and indeed, your
broadband connection—

from your laptop, without going
through the hassles and the
mess of metres of wires?

It’s very easy to get an
Access Point or router and set
up a connection, but remember
it can be pretty expensive.

The following is a step-by-
step explanation of how you
can turn your Wi-Fi card into
an Access Point, and thus share
data and an Internet
connection over it.

What’s more, this is no
tougher than taking time out
on a lazy weekend to go
shopping for an expensive and
wholly unnecessary device!

Setting Up A Wi-Fi Card
As An Access Point
Access points cost over
Rs 5,000—an investment that
doesn’t make sense for a very
small setup of, say, two PCs.
There are cheaper alternatives
that will be easier on your
pocket. By ‘cheaper alternative’,
we mean Wi-Fi cards, which can
be PCMCIA-based for laptops, or
PCI-based for desktops. 

In the following steps, we
take you through the process
of configuring a Wi-Fi card
as an Access Point to which
wireless clients can connect—
and subsequently share an
Internet connection and access
shared resources.

We used the SMC2802W PCI-
based Wi-Fi card plugged into a
desktop PC. It was configured as
an Access Point to which Wi-Fi
clients connected.

Installing The Card
Switch off your system
and remove the side
cover. Locate an empty

Configuring your Wi-Fi card

Creating a Wi-Fi profile

View your network properties
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Give an appropriate IP
address and click on the
subnet mask field once. This
will fill the empty field with a
subnet mask. Click ‘OK’ and
exit the Control Panel.

If all the settings are
correct, you should be able to
see the SSID—the one you
typed in—highlighted in the
utility after it scans for an
available network.

When you see the SSID
highlighted, your Wi-Fi card
has successfully been set up as
an Access Point! 

aliasgar_pardawala@thinkdigit.com
varun_dubey@thinkdigit.com

The
technique
of ‘driving’
around
town
looking for
Wi-Fi
hotspots is
termed as
‘war
driving’ 

Check your IP information

NetStumbler is a neat tool made for the purpose of
network scanning, and is a great addition to the arsenal of any
network administrator worth his salt. This freeware utility
is available for download from www.stumbler.net. It scans the
surrounding area for available wireless connections within reach.

Note, however, that just by scanning, you cannot expect to
log on and surf using that connection.

Using the utility is fairly simple. Install and run the utility,
and click on the button on top that’s shaped like a ‘play’ button.
This will start the ‘Scan’ mode for NetStumbler, and it will start

scanning and recording data. 
The information

provided is quite descriptive.
It tells you about the
signal strength, and whether
or not any encryption (WEP)
is used. The SSID, too,
is displayed.

The display of the signal
strength is particularly helpful for network administrators, as
you can go around with a laptop and locate and mark dead
spots or areas of poor signal strength.

In fact, the advent of pocket PCs prompted the author of
NetStumbler to come out with a version that works with hand-
held PDAs that have Wi-Fi built in. This is called MiniStumbler,
and can also be downloaded from www.stumbler.net.

Windows XP can natively display signal strengths, but the
information is not as accurate as that provided by NetStumbler.

With NetStumbler, you also have the option of using GPS.
If you have a Wi-Fi card with GPS capabilities, then you can run
NetStumbler, enable
GPS, and it will
pinpoint the location
of the Access Point!

The device
requires absolutely no
user input (apart from
the click at the start!)
and you can keep it
running in the back
seat of your car while
you drive around the
neighbourhood scouting for Wi-Fi hotspots.

The technique of ‘driving’ around the neighbourhood look-
ing for Wi-Fi hotspots is termed as ‘war driving’. Whether war
driving is ethical is an ongoing debate: say you leave your
house door open—intentionally or unintentionally; are you thus
inviting people to take what they want from inside?

War Driving

NetStumbler’s default view

The signal strength graph

Available active APs show up

Your network SSID
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Basic Keyboard Shortcuts
[Ctrl] + [Spacebar]
removes all style

formats from highlighted text
Superscript: [Ctrl] + [=]
Subscript: [Ctrl] + [Shift] + [=]
Small Caps: [Ctrl] + 
[Shift] + [K]
[Ctrl] + [Shift] + [F] accesses
the font menu, the arrow
keys select what you want,
and [Enter] changes the
selected text to that font
[Ctrl] + [Shift] + [P] accesses
the font size menu, the arrow
keys select the size, and
[Enter] enables the change
[Ctrl] + [Shift] + [>] increases
the font size by half a point
[Ctrl] + [Shift] + [<] decreases
the font size by half a point
Move between the current
page view and actual size
view: [F9]
Check spelling: [F7]
Copy formatting: [Ctrl] +
[Shift] + [C]
Paste formatting: [Ctrl] +
[Shift] + [V]
Return character formatting
to the current text style: 
[Ctrl] + [Spacebar]
End one line and begin
another without starting a
new paragraph: 
[Shift] + [Enter]
Begin a new paragraph:
[Enter]
Nudge to the left: [Alt] 
+ [Left Arrow]
Nudge up: [Alt] + [Up Arrow]
Add a page after the current
page: [Ctrl] + [Shift] + [N]
Move between the
background and the
foreground page: [Ctrl] + [M]
Go to page: [F5]

Changing The Page Size
You can start a new
document of any page

size, and even change an
existing document to any
page size you like. All you
need to do is go to File > Page
Setup, and under ‘Choose a
Publication Layout’, select
‘Special Size’. 

Under the option ‘Choose
a Publication Size’, select
‘Custom’. You may then enter
the physical dimensions of
your printed piece making
sure the orientation is
correct. Once you finish, 
click ‘OK’.

The Nudge Option
In order to achieve a
high degree of control

over the positioning of
objects on the page, use the
‘Nudge’ option. Just select the
object you need to move and
use [Alt] + [Arrow key] (up,
down, right, or left), and your
object will move one pixel for
each keystroke. Use Arrange >
Nudge to change the
increment of movement.

Add a Reply Form To 
A Publisher 2000
Publication

Reply forms make it
easy for your readers to

respond to a survey, sign up
for an event, or place an
order. Add a reply form from
the Publisher 2000 Design
Gallery to your brochures,
newsletters, catalogues, 
Web sites, or other 
similar publications. 

In order to add a reply
form to your publication, go
to Insert > Design Gallery
Object. Under ‘Categories’,
click ‘Reply Forms’. Now,
double-click the reply form
you want. Drag the reply
form to the desired position
in your publication, and
resize if necessary. Be sure to
replace any placeholder text,
such as “First Question” and
“Answer A”, with the
appropriate text.

Use The Design Checker
To Check For Missing Text

Missing text often
occurs when you resize

a text frame after inserting
text, or when you add a
graphic that pushes text into
an adjacent text frame.
Adding a continued notice to
a text frame can also cause
missing text. Publisher
indicates that text is missing
by showing the text in the
‘Overflow’ symbol at the
bottom of a text frame when
the frame is selected. Use the
Design Checker to check your
publication for missing text.
It analyses your publication,
stops at every text frame that
contains text in the overflow
area, and also suggests
possible solutions.

To run the Design
Checker, go to Tools > Design
Checker. To check your entire
publication, click ‘All’; or, to
check specific pages, click
‘Pages’, and then type the
page numbers in the ‘From’
and ‘To’ boxes. Click ‘OK’. 

Publisher checks the
design, and displays a dialog
box if it finds a problem. If
you want to fix the problem,
go to the publication, and
make your changes; you don’t
have to close the ‘Design
Checker’ dialog box. When
you’ve finished, click
‘Continue’ to have Publisher

continue checking your
publication. If you don’t want
to fix the problem, click
‘Ignore’ or ‘Ignore All’, and
click ‘Continue’. Click ‘OK’.

Get Your Publisher 
Files Together

When you take your
publication to another

computer, you can be sure it
looks the same on the other
computer as it does on yours
by including the fonts and
graphics you used in your
publication with the files you
save. When you use the Pack
and Go Wizard to pack your
files, Publisher can include
both fonts and graphics with
your files. 

If you are taking your
files to another computer on
disk, Publisher automatically
compresses and splits your
files so they fit on multiple
disks. Publisher also includes
a program to unpack your
files on the other computer.
To start the Pack and Go
Wizard, go to File > Pack and
Go, and then click ‘Take to
Another Computer’. The Pack
and Go Wizard takes you
through each step of the
packing process.

Keep An Object’s Centre
In The Same Place

To keep the centre of an
object in the same place

in your publication while you
resize the object, click the
object, then hold down [Ctrl]
while you resize the object.
Release the mouse button
before you release [Ctrl].

Apply Text And Graphics
Formatting Multiple Times

If you have ever wanted
to make several non-

sequential words stand out by
using a special font, or have
ever wanted to change certain
solid lines to dotted lines in
graphics created with the
drawing tools, you might not
realise how easy it is.  

Instead of clicking the
‘Format Painter’ button on
the Standard toolbar every
time you want to apply the
new format, you can take
advantage of the button’s
‘sticky’ feature. 

First select the item
whose format you would like
to copy. To copy the selected

MS PUBLISHER
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format to several items,
double-click the ‘Format
Painter’ button. The button
stays selected, or ‘sticky’.
Select the text or graphic
where you want to apply the
new format. When you have
finished applying the format,
click the ‘Format Painter’
button again or press [Esc].

Change How Text Wraps
Around A Graphic

You can adjust the
amount of whitespace

between text and a piece of
clip art, scanned
photographic image, or any
other graphic in Publisher. 

To change how text wraps
around a graphic, click the
graphic. On the Format
menu, click ‘Picture Frame
Properties’. Click ‘Picture
Only’. Click ‘OK’. On the
Formatting toolbar, click the
‘Edit Irregular Wrap’ button.
Grab the picture handles that
surround the graphic until
the space between the text
and the graphic is the way
you want it.

To add additional Adjust
handles, hold down [Ctrl] and
click where you want the new
handle to appear. To delete a
handle, hold down [Ctrl] +
[Shift] and click the handle.
Once that is completed, click
anywhere on the page.

Make Alignment A Snap
Align objects in
Publisher without

hassling over your mouse.
Click Arrange > Rules guides
and choose either ‘Add
Horizontal Ruler Guide’ or
‘Add Vertical Ruler Guide’. To
move the guide, hold [Shift]
and drag the guide to the
position you want. Click
Tools > Snap to Guides. Now
any object you move near the
guide will snap to the grid
and be automatically aligned.

Close Some Panels
Dreamweaver by default
comes with all the

panels (or ‘palettes’) open,
taking up all the space on
your screen, and making the
program hard to use. Since
you need only a few of these
panels, open the panels listed

below and close all others (all
panels are listed in the
Window menu. You can
always open them again later
through the Window menu).
So, keep the following panels
open: Objects, Properties, Site
Files, CSS Styles, History.

HTML Styles
Don’t use ‘HTML Styles’.
HTML Styles aren’t real

stylesheets; they are good
only for one-time formatting.
If you use real style sheets—
CSS (Cascaded Style Sheets)
Styles—you can change a style
anytime you want and the
change will be automatically
applied to every instance 
of the style.

Add An Extra Space
Between Items

To add an extra space
between items in a

bulleted list, place your
cursor at the end of the item
and press [Shift] + [Enter]
twice. This adds two <BR>
tags after the list item instead
of adding another <LI> tag.
Or, if you are familiar with
CSS, control the spacing in
your style sheet.

Break Out Of A List
Pressing [Enter] when in
a list gives you a new

bullet instead of a plain
paragraph. With your cursor
at the unwanted bullet, go to
the ‘Properties’ panel, and
deselect the bulleted list
button. Also, deselect the
numbered list button for
numbered lists. 

Add Space Around Items
In A Table

Select the whole table
(the easiest way is to

click on the <table> tag in the
bottom of the Dreamweaver
window). With the table
selected, go to the ‘Properties’
panel, increase the cell
padding and cell spacing
until the table looks the way
you want it to appear.

Break Only To The 
Next Line

Unlike a word processor,
Dreamweaver inserts

‘two paragraph spaces’ (two
lines) when you press [Enter],
as Dreamweaver is writing
HTML as you type, and HTML

works a little differently.
Pressing [Enter] creates a
paragraph (<P>) tag, leaving a
blank line after the preceding
paragraph. To break to the
next line without creating an
extra line space, press [Shift]
+ [Enter], which creates a
break (<BR>) tag.

Controlling The Size Of A
New Window

A new browser window
is usually the same size

as the original browser
window containing your site.
This can be confusing for
some novice Web users. 

To make navigation as
simple and straightforward as
possible, you may want to set
the new browser window to a
smaller size. You can do so
using the ‘Open Browser
Window’ behaviour. To use
the behaviour, choose
Window > Behaviors to
display the ‘Behaviors’
palette. Then, select the link
in your HTML document. 

Next, select ‘Open
Browser Window’ from the
‘Behavior’ menu. In the
resulting dialog box, enter
the URL of the link and set
the desired width and height
of the new window. Click
‘OK’. At this point, when the
user clicks the link, a small
window opens with the
linked page.

Allowing The User To
Resize A Window

Dreamweaver makes it
very simple to set the

new window so the user can
resize it. Simply use the
‘Open Browser Window’
behaviour. To do so, choose
Window > Behaviors. In the
‘Behavior’ palette, choose
‘Open Browser Window’. 
In the resulting dialog box,
now select the ‘Resize
Handles’ checkbox.

Viewing The Head Section
Dreamweaver places a
Title and a Metatag

element in the Head section
of an HTML document. These
elements are normally
invisible while you view the
page in Dreamweaver
WYSIWYG (What You See Is
What You Get) mode. 

However, you can set
Dreamweaver to display

elements in the Head section
of your HTML document. To
do so, choose View > Head
Content. Dreamweaver
creates a frame in the page
window and displays the
items in the Head section.
Now, you can add, modify, or
delete these items. 

To modify an item, first
choose Window > Properties
to display the ‘Properties’
palette. After that, select 
the ‘Head’ object and modify
the values displayed in the
‘Properties’ palette.

Cleaning Up Word 
HTML Documents

Microsoft Word can save
documents in the HTML

format. However, the HTML,
XML, and CSS code that Word
generates is geared more to
format and display
documents in Word than to
display the HTML file in a
typical Web browser. Because
of its complexity, it’s a good
idea to clean up the Word-
generated HTML code.

Moreover, Dreamweaver
can instantly remove the
extraneous Word-generated
HTML code. To do so, launch
Dreamweaver and choose File
> Import > Import Word
HTML. In the resulting dialog
box, select your Word-
generated HTML file and 
click ‘OK’. 

At this point, you can
choose to customise the
cleanup process by selecting
options from a series of
checkboxes that Dreamweaver
displays in the ‘Clean Up
Word HTML’ dialog box. 

When you are ready, 
click ‘OK’. Then,
Dreamweaver scrubs the
imported Word HTML
document clean of the Word-
generated HTML code.

DREAMWEAVER

Make Text Wrap Around
An Image
Place the image just before
the text (whether you want
the image to sit on the left
or right of the page). Then,  
select the image. In the
‘Properties’ panel, select
either ‘Align Left’ or 
‘Align Right’.

Bet You Didn’t Know
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RSS stands for Really
Simply Syndication,

and allows you to do just
that—distribute headlines
and other Web content. 

A family of XML file
formats for Web
syndication, RSS is used by
news Web sites and Web
slogs. With Firefox
clocking nearly 50 million
downloads and
incorporating native RSS
feed support, no Web site
or blog owner can afford
to ignore the power of RSS
(kindly ignore any
political connotation)!

There are many Web
sites (for instance,
www.feedforall.com) that
do it for you for free. But
if you are the do-it-
yourself technology buff
(we know you are dear
reader!), we will teach you
how to create your very
own RSS feed from
scratch! As they say, no
pain, no gain! 

The Essentials
You need to have a
simple text editor,

(even notepad will do the
job), and of course, a Web
site or a blog! 

The Code
There is no need to
feel apprehensive

at the mention of the
word ‘code’, it’s extremely
simple and if you know
HTML, it’s ridiculously
easy! Here is a sample of a
simple RSS Script—

<rss version=”2.0”>
<channel>
<title>Nutswork:Latest

Stuff</title>
<link>http://www.nuts

work.net</link>
<description>Ferrari

News</description>
<image>
<title>Ferrari

News</title>
<url>http://www.nutsw

ork.net/logo.gif</url>
<link>http://www.nuts

work.net/</link>
</image>
<item>
<title>Imola Race

Results</title>
<description>The Race

Results for the 2005 San
Marino Grand
Prix</description>

<link>http://www.nuts
work.net/f1/2005/imola/rac
e.html</link>

</item>
</channel>
</rss>

Understanding
The Tags
The first tag is the

<rss> tag, where you specify
the standards of coding to
which the script
conforms. We will be
using the latest
standard—‘2.0’. 

The second tag is
<channel>. This tag
incorporates all the
data of your RSS feed.
The <title>, <link>
and <description>
tags tell the feed
reader the topic your
feed pertains to, and
the Web site with which the
feed is associated.

All tags discussed so far
are mandatory but the
<image> tag is optional. If
you don’t put this in your
RSS file, you will simply get
a text-only feed, which is ok
but it’s better to have your
Web site icon on the feed!

We now come to the
part you will be editing
frequently—the headlines
you want visitors to notice!
Every headline in your 
feed is wrapped inside the
<item> tag. 

Inside, you have the
<title> tag. Whatever you
put in here will be seen by
subscribers to the feed. If

you have used the RSS feed
reader in Firefox, then it’s
the content in this tag that’s
visible when you click on
your bookmarks.

Next, you have the
<description> tag. This is a
brief description of the
article that the <title> tag
links to. Then of course, you
have the <link> tag, the link
of the article. Finally, you
have the closing tag for the
headline as </item>. You can
also repeat the <item> tag
for as many items as you
want, to get as many
headlines you require.

Every time you would
like to add a new headline,
just add a new <item> tag
on top of your earlier <item>
tags. See to it that you don’t
add too many headlines
without removing the

earlier ones as this could
make your feed too big and
slow it down.

Optional
Elements
So far, all the

aforementioned elements
are required for your feed to
work properly. There are
quite a few elements that
you can add. Consider,
<author>. You can put your
email address in this tag.

Similarly you can have
<pubDate> to signify the
publication date. At the
same time, keep in mind
that the date must conform
to the time specifications of
RFC 822, i.e., it should be in

the following format:
Sun, 22 Aug 1983 00:00:01
GMT

Adding It To 
Your Web Page
Since RSS is

essentially an XML
(eXtensible Markup
Language) file, we need to
tell the RSS reader as much.
Hence, you should add the
following as your first and
foremost line in the
document:
<?xml version=”1.0”
encoding=”utf-8” ?>
Note: This tag is not closed
in the end i.e., there is 
no </xml>

Next, you need to save
this file with an xml
extension. Say, myfeed.xml 

Now that your feed is
ready, your next goal is to
tell Web browsers that it
exists! So you need to
incorporate the following
lines into the <head> tag of
your Web page—
<link rel=“alternate” type=
“application/rss+xml” title=
“My RSS Feed” href=
“http://www.nutswork.net/m
yfeed.xml”>
Whatever you put in the
title= “ ” field is displayed
when someone clicks on
your subscribe button.

That’s all there is to it
really! Your RSS is ready to
roll! Or should we say, you
can now Roll Your Rss! 

If you have incorporated
it in your Web page header,
then you need not worry as
compatible browsers will
detect it automatically. 

However, for users of IE
(since IE does have an in-
built RSS reader), you need
to show them your feed. 

To do this, you can
download any of the
available RSS or XML images
available online, and put the
location of your RSS file as
the image link.

varun_dubey@thinkdigit.com

Creating Your Own RSS Feed 
With a program that reads RSS feeds you can add more traffic to your portal or blog 

‘Live bookmarks’: Automatic RSS feeds
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Sort By More Than 
Three Columns

Excel’s sort feature only
allows it to nominate up

to three columns to sort by.
The key to this is sorting by
the last key first and working
back to the first key. Say your
data is in Columns A:E, and
you want to sort by A, B, C, D
then E. Select all the columns
A:E. Go to Data > Sort > Sort
by C then by D then by E.
Click ‘Sort’. Now again with
Columns A:E selected, go to
Data > Sort > Sort by A then
by B. Click ‘Sort’.

Entering Named Ranges
Into Formulas

When you write a
formula, sometimes you

want to use a Named Range
as one of the arguments for
the formula, but you cannot
remember the name. 

In these cases, simply
press [F3] when you reach the
argument that you want the
Named Range in, and Excel
will display the ‘Paste Name’
dialog. Click the name you
want, and click ‘OK’.

Catching Formula Errors
Whenever typing one of
Excel’s functions,

especially nested ones, into a
cell, use lowercase. This way
when you press [Enter], Excel
will capitalise only the names
of the functions you have
entered correctly.

Transpose Formulas
Without The Reference
Changing

In cell A1 of sheet 2, put
“=Sheet1!A1”. Copy this

a maximum of 255 rows. Now
with the formulas selected,
go to Edit > Replace, and
Replace “=” with “#”. Now
select and copy cell B1, go to
Edit > Paste special, and
choose ‘Transpose’. Delete
column A, and with row 1
selected, go to Edit > Replace,
and Replace “#” with “=”.

Display Or Hide Scrollbars
Go to Tools > Options >
View. Select or clear the

‘Horizontal scroll bar’
checkbox and ‘Vertical scroll
bar’ checkbox.

Add Colour To Sheet Tabs
First select the sheets
you want to colour. On

the ‘Format’ menu, point to
‘Sheet’, and then click ‘Tab
Color’. You can also right-
click on the sheet tab and
then click ‘Tab Color’. Click
on the colour you want and
click ‘OK’.

Four Conditional
Formatting Options

Conditional formatting
in Excel allows for three

conditions. However, by
setting up conditions
correctly—from least to most
restrictive—you can really
allow for four conditions,
when the default formatting
of the cell is considered.

For example, say you
want to add colour to your
data in the following
manner. You have four
ranges, with fill colours Red,
Yellow, Green and Black
respectively. The four ranges
are “Less than or equal to -
25”, “Between 0 and -25”,
“Between 0 and 25”, and
“Over 25”. This can be
achieved by doing 
the following.

First select your range of
cells. Click ‘Conditional
Formatting’ on the ‘Format’
menu. Under ‘Condition 1’,
in the first two boxes, choose
‘Cell Value Is’ and ‘less than
or equal to’ respectively.
Then type the value “-25” in
the third box. Now click the
‘Format’ button, choose a red
fill colour from the ‘Patterns’
tab, and click ‘OK’. Click
‘Add’. Under ‘Condition 2’,
choose between in the
second box, type the values
“0” and “-25” in the third
and fourth boxes, and then
choose a yellow fill format.
Click ‘Add’ again. 

Under ‘Condition 3’,
choose ‘Between’ in the
second box, type the values
“0” and “25” in the third and
fourth boxes, and then
choose a green fill format.
Click ‘OK’ to close the
‘Conditional Formatting’
dialog box. Finally, while
your range is still
highlighted, choose a black
fill from the colour palette.
Your range is now pseudo-
conditionally formatted to
cover all four cases!

Change Cell
Background Colour
Using VBA

To modify the
background

colour of a cell using
Visual Basic for
Applications (VBA), 
you need to use the
‘Interior’ property of
the cell, and then you
can use ColorIndex (to
use one of the 56
‘preset’ colours in
Excel) in this way, 
for example:
ActiveCell.Interior.ColorIndex
= 36 Instead of ‘ColorIndex’,
you can use ‘Color’. In this
example, you are colouring
cells A1 through A6:
Range(“A1:A6”).Interior.Color
= RGB(200,160,35)

View Multiple Sheets 
Or Workbooks

To view multiple sheets
or workbooks at the

same time, open the
workbooks you want to view.
To view multiple sheets in the
active workbook, click ‘New
Window’ on the ‘Window’
menu. Switch to the new
window, and then click a
sheet you want to view.
Repeat for each sheet you
want to view. On the
‘Window’ menu, click
‘Arrange’. Under ‘Arrange’,
click the option you want.

In order to view sheets in
only the active workbook,
select the ‘Windows of active
workbook’ checkbox.

Change The Colour Of 
Cell Gridlines

Select the sheets on
which you want to

change the gridline colour.
Go to Tools > Options, and
then click the ‘View’ tab.
Under ‘Window options’,
click the colour you want 
in the ‘Color’ box. To use 
the default gridline colour,
click ‘Automatic’.

Change The Hole Size In 
A Doughnut Chart

Click a data series in the
doughnut chart you

want to change. On the
‘Format’ menu, click ‘Selected
Data Series’, and then click
the ‘Options’ tab. In the
‘Doughnut hole size’ box,
type a value between 10 

and 90 to specify the
diameter of the hole.

Change The Plotting
Order Of Data Series

Click a data series in the
chart you want to

change. To change the
plotting order of data series
in a surface chart, click a
legend key. On the ‘Format’
menu, click ‘Selected Data
Series’ or ‘Selected Legend
Key’, and then click the
‘Series Order’ tab. 

In the ‘Series order’ box,
click the series you want to
move. To place the series in
the order you want, click
‘Move Up’ or ‘Move Down’.

Change The Cell Range 
A Chart Is Based On

Click the chart you want
to change. On the

‘Chart’ menu, click ‘Source
Data’, and then click the
‘Data Range’ tab. Make sure
the entire reference in the
‘Data range’ box is selected. 

On the worksheet, select
the cells that contain the
data you wish to appear in
the chart. If you want the
column and row labels to
appear in the chart, include
the cells that contain them in
the selection.

Display Non-consecutive
Dates

The Outlook Calendar
displays dates

consecutively—usually in
single week or month view.
But sometimes it’s useful to
see several non-consecutive,
key dates at a glance. For
example, if you met with the
same client on January 12

MS OUTLOOK

MS EXCEL

Changing gridline colour in Excel



165DIGIT JUNE 2005

Tips & Tricks 4 Years Of Tech

and 19, March 31, and April 4,
you might want to view those
dates in a single pane, giving
you easy access to meeting
summaries, attachments, and
lists of attendees.

To view non-consecutive
dates, on the right side of the
window in the Date Navigator
(the small calendar that
displays the current month),
click the first date you want
to view. Then, while holding
down [Ctrl], click any other
dates you want to view. To
remove a date, click it again. 

You can display up to 14
non-consecutive days.

Save Multiple
Attachments
Simultaneously

When you receive an
Outlook message

containing several attached
files, you don’t have to open
and save each file separately.
You can save multiple
attachments to the same
location in a single step. 

Click ‘Save Attachments’
on the ‘File’ menu. When the
‘Save All Attachments’ dialog
box opens, click OK. Then
select the folder where you
want to save the files, and
click ‘OK’. 

When you use this
shortcut, you must save all
the files to the same folder.
To save each attachment to a
different folder, you will need
to save them individually.

Calendar-Viewing
Shortcuts

In Outlook Calendar, do
the following:

Press [Alt] + [-] to display
the current week.

Press [Alt] + [=] to display
the current month.

Use vCards
Outlook supports the
use of vCards, the

Internet standard for creating
and sharing virtual business
cards. By adding a vCard to
your e-mail signature, you
can easily include your
business contact information
with every e-mail message 
you send.

If you receive a vCard and
would like to save the
information it contains,
simply double-click it, and it
will open as a contact item

that you can easily save to
your Contacts folder. 

To include a vCard with
your e-mail signature, go to
Tools > Options, and then
click the ‘Mail Format’ tab.
Under ‘Signature’, click
‘Signatures’, and then click
‘New’. Select the options you
want, and then click ‘Next’.
Under ‘vCard options’, select
a vCard from the list or click
‘New vCard from Contact’.

Get Rid Of Space-Stealing
Files In Outlook

When it’s time to clean
up their mailboxes,

most people have trouble
finding and deleting the
messages that take up the
most space, such as those
with large attachments.
Here’s a fast way to expose
the space stealers hiding in
your Outlook folders.

To create a customised
search file in Outlook, go to
Tools > Advanced Find, and
then click the ‘More Choices’
tab. In the ‘Look for’ box,
click ‘Messages’. In the Size
list, click ‘greater than’, and
then type a number such as
500 (for files that are 500
kilobytes or larger). Select the
remaining search options you
want, and click ‘Find Now’.

When the search is
complete, you can save it as a
shortcut. Here’s how: click
‘Save Search’ on the ‘File’
menu of the ‘Advanced Find’
dialog box, and save it
somewhere you can find it
easily later, such as your
desktop. Then, the next time
you want to run this search,
just double-click the shortcut.

Colour-Code 
Your Calendar

In your Outlook
Calendar, you can use

colours to help you manage
your appointments. For
example, you can choose
colours with predefined
labels such as “Personal”,
“Needs Preparation,” or “Must
Attend”; or, you can create
your own labels. Here’s how. 

To colour an appointment
or meeting with a predefined
label, click ‘Calendar’. Right-
click an appointment or
meeting, point to ‘Label’ on
the shortcut menu, and then
click a colour-coded label in

the list. To remove the colour
from the appointment or
meeting, in the ‘Label’ list,
click ‘None’.

To create your own
coloured label, click
‘Calendar’. Right-click an
appointment or meeting,
point to ‘Label’ on the
shortcut menu, and then
click ‘Edit Labels’. Pick the
colour you want to rename,
type in your new label name,
and click ‘OK’.

Find Related Messages 
In Outlook

Do you end up scanning
Outlook folders to find

messages previously sent or
received as part of an
extended e-mail conversation?
Outlook can find and display
these messages, if they are
part of the same conversation
string: select one of the
messages in the e-mail
conversation. On the ‘Actions’
menu, point to ‘Find All’, and
click ‘Related Messages’.

You can also use a
shortcut to find related
messages. When you open an
e-mail message you have
already replied to, a yellow
information bar indicates the
date and time you replied to

the message, and provides a
link you can use to find all
related messages. Click the
information bar to view
related messages. In Outlook
2002, the bar also indicates if
the sender is currently
online, and if that sender is
an Instant Messenger contact. 

Return Meeting
Responses To The 
Right Person

Most administrative
assistants have

permission to send meeting
requests from their bosses’

accounts—but sometimes,
responses to those meeting
requests end up in their
bosses’ mailboxes. Here’s a
way to return responses to
the administrative assistant.

You can grant someone
permission to send e-mail
requests for you by using the
‘Delegate Access’ feature: go
to Tools > Options, click the
‘Delegates’ tab, and click
‘Add’. With that done, it’s
easy to specify that responses
be returned to that person as
a delegate. 

To return responses to
delegates, go to Tools >
Options, and then click the
‘Delegates’ tab. Select ‘Send
meeting requests and
responses only to my
delegates, not to me’.

Open, Dismiss, Or Snooze
Multiple Reminders

Did you know that you
could act on more than

one reminder at a time in
Outlook 2002? Your
reminders are listed in the
‘Reminders’ window, which is
accessible from the ‘View’
menu. From there you can
open, dismiss, or ‘snooze’
multiple reminders with a
single click.

To work with multiple
reminders, first select the
first reminder. Hold down
[Ctrl]. Select any additional
reminders. Click ‘Open Item’,
‘Dismiss’, or ‘Snooze’.

Making Auto-Fit Text Stop
Auto-Fitting

To turn this feature off,
go to Tools > Options,

click on the ‘Edit’ tab, and
uncheck ‘Autofit text to 
text placeholder’.

MS POWERPOINT

About Using More Than
One Guide
If you like using guides, and
wish there were more, you
can create additional guides
by simply holding down [Ctrl]
while dragging on an existing
guide. This will create a new
guide. To get rid of guides,
just drag them off the edge 
of the slide.

Bet You Didn’t Know

Using a message in a thread, you
can find all related messages
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So you got yourself a brand new
camcorder? And you need to share
your videos with family by burning
VCDs and distributing them? We get
into the nitty-gritty of WMM so you
can do just that—rest assured, 30
minutes of familiarisation is all 
it’ll take!

What You’ll Need
A camcorder, a TV tuner card if you
have an analogue camera, and
Windows Movie Maker (WMM),
which comes pre-installed with
Windows XP. You may want to
download WMM2, which is the
updated version, from
www.microsoft.com/windowsxp/dow
nloads/updates/moviemaker2.mspx

Note that WMM2 comes bundled
with XP Service Pack 2. The key
difference between WMM1 and
WMM2 is that WMM2 allows you to
burn a CD in the WMV or 
HighMat formats. 

However, HighMat does not enjoy
widespread support, so you’re better
off burning a simple VCD using
third-party software such as Nero or
Easy CD. The other difference is the
added effects. Everything else is 
essentially the same.

Firing Up Movie Maker
To start the program,
navigate to Start > All

Programs > Accessories > Windows
Movie Maker.

Configuring The
Audio/Video Devices
To configure your video

device in the software, you may click
‘Change Device’, and you will get a
configuration window where ‘Video:’
will show the various video capture
devices available (if you have multiple
TV tuners or FireWire ports. 

In the latter case, you will need to
have the camera connected to it,
otherwise the FireWire port will 
not show up.)

Choose the appropriate video and
audio devices and the correct line-in
settings if you are using a TV tuner (as
opposed to a FireWire connection).

Encoding     
On clicking ‘OK’, you will
return to the previous screen

where you can make adjustments to
the quality. If after setting the quality
to High Quality you are not satisfied,

we recommend you click ‘other’ 
and select ‘Video for broadband 
NTSC (768Kbps)’.

The automatic clip creation
feature works really well. What it
essentially does is, it detects scene
changes, and saves each scene as a
separate video file, or clip, so you
need not cut out different video clips
or leave too much gap in between the 
different recordings.

Now you need to play the
video file on your camcorder
(if you connected via an S-

Video cable or a regular A/V cable). 
In case, you’ve connected via

FireWire, you’ll get the controls on
the software itself—now you can 
play and record the movie 
from there.

Once you’ve got all the
contents onto the clip area,
and you can see the various

clips, you are ready to create your
movie. Browse through the various
clips and drag and drop the suitable
ones onto the timeline area below.
The neat thing about the timeline
and clipping is that you can entirely
change the order of the video!

After you have the various
clips on the timeline, you
can, if you want, edit out

unrequired stuff from the clips to
make the movie crisp and fast-paced.

After you’ve satisfactorily
nipped and tucked your
movie, you can preview the

entire thing by clicking the first clip
on the timeline and hitting ‘Play’ in
the preview area.

If all is well and you’re happy
with the results, you’re ready to save
the movie file.

Click on the ‘Save Movie’
button on top, and select the
proper resolution.

Remember, the higher the
resolution, the more time your

movie will take to save, and
obviously, it’ll occupy more space.

That’s all there is to it, your 
very own home video is ready! Now
just burn a VCD using your favourite
burning software, and share all
those precious moments!

varun_dubey@thinkdigit.com

Create Home Videos Using WMM
Use Windows Movie Maker to cut Oscar winners from your camcorder recordings!

WMM automatically generates clips for you!

Save your movie at the proper resolution

The configuration window for the video device
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Using Ctrl-Drag To Copy
You can quickly make a
copy of any object by

holding down [Ctrl] while you
drag on the object. You will
then ‘drag off’ a new copy.

Using Guides To Measure
Make the Guides visible
by clicking View >

Guides.  Then, hold down
[Shift] while you click and
hold a guide; the tool-tip for
the guide will display “0:00”.

As you move the guide,
the distance the guide covers
from the beginning of the
drag will be displayed in the
units of your ruler. In this
way, you can measure
distances between objects,
place guides at specific
places, and so on.

Selecting Small Or
Covered Objects

Hit [Esc] to ensure that
nothing is current

selected. Next, repeatedly hit
[Tab], which will toggle you
through a selection of all of
the objects on a slide. This is
useful to select very small
objects, or those objects
covered up by larger ones.

Change How A Linked Or
Embedded Object Appears

Select the linked object
or embedded object you

would like to change. On the
‘Edit’ menu, point to the
object, for instance,
‘Worksheet Object’—and click
‘Convert’. Follow any one:
If you want to display the
content, clear the ‘Display as
icon’ checkbox. 
If you want to display as an
icon, select the ‘Display as
icon’ checkbox.

Control How Linked
Objects Are Updated

Go to Edit > Links. Click
the linked object you

want to update. To select
multiple linked objects, hold
down [Ctrl] while you click
each object. Now do one or
more of the following:

(a) Change a linked
object’s setting to automatic
or manual updating: to
update a linked object each
time you open the file that
contains it—or any time the

object changes while the file
is open—click ‘Automatic’ or
‘Automatic update’. To update
a linked object only when you
click Update Now, click
‘Manual’ or ‘Manual update’.

(b) To manually update a
linked object when you
choose, click linked object,
then click ‘Update Now’.

(c) To break a connection
to a linked object, click ‘Break
Link’. After you break the
connection to a linked object,
you must reinsert it into your
file to reconnect.

(d) To reconnect a linked
object when the source file
moves or is renamed, click
‘Change Source’. In the ‘File
name’ box, enter the name of
the file to which you want to
reconnect the linked object. If
you don’t see the file you
want, select a different folder
in the ‘Look in’ box.

Using A PDF File
You cannot insert a PDF
file into PowerPoint as

an embedded object. You can,
however, link to a PDF file
from within a presentation
using hyperlinks: select the
text or object you want to use
to link to the PDF file. On the
‘Insert’ menu, click
‘Hyperlink’. Under ‘Link to’,
click ‘Existing File or Web
Page’. Select the PDF file you
want to link to, and click ‘OK’.

Draw A Curve
This tip is indicative of
how to draw in

PowerPoint. On the ‘Drawing’
toolbar, click ‘AutoShapes’,
point to ‘Lines’, and then
click ‘Curve’. Click where you

want the curve to start, and
continue to move the mouse
and click wherever you want
to add a curve. To end the
curve, double-click any time.

Add Or Remove
Arrowheads

Instead of pasting or
deleting arrowheads on

lines, change the line style to
reflect the format you want.
Select the line you want to
change. (You can only add an
arrowhead to a line or
connector line.) On the
Drawing toolbar, do one of
the following:

(a) To add one or two
arrowheads, click ‘Arrow
Style’, and then click the style
you want.

(b) To remove all
arrowheads, click ‘Arrow
Style’, and then click ‘Arrow
Style 1’.

Flipping An Object
This tip, again, is
indicative of how to use

the Drawing toolbar. Select
the AutoShape, picture, clip
art or WordArt that you want
to flip. Then on the Drawing
toolbar, click ‘Draw’, point to
‘Rotate or Flip’, and then
click ‘Flip Horizontal’ or 
‘Flip Vertical’.

About Grouping And
Ungrouping Objects

When you use the
Group commands,

under ‘Draw’ on the Drawing
toolbar, to group objects, you
combine them so you can
work with them as though
they were a single object. You
can flip, rotate, and resize or

scale all objects in a group as
a single unit. You can also
change the attributes of all
objects in a group at one
time—for example, you might
change the fill colour or add
a shadow to all objects in the
group. Also, you can select 
an item within a group 
and apply an attribute, 
without ungrouping.

You can also create
groups within groups to help
you build complex drawings.
You can ungroup a group of
objects at any time and then
regroup them later.

(a) To group objects,
simply select the objects you
want to group. Then on the
Drawing toolbar, click ‘Draw’,
then ‘Group’.

(b) To ungroup objects,
select the group you want to
ungroup. On the Drawing
toolbar, click ‘Draw’, then
click ‘Ungroup’.

(c) To regroup objects,
select any one of the objects
that was previously grouped.
Then on the Drawing toolbar,
click ‘Draw’, and then 
click ‘Regroup’.

Cool ‘Backward’ And
‘Forward’ Links

Say you have a Web site
with a series of pages in

a row. You could be showing
slides, for example. It would
be nice to have backward and
forward arrows on each page.
You can do it in FrontPage by
inserting a little text into the
HTML. It’s a simple JavaScript
trick. Use this code: 

<FORM>
<INPUT TYPE=”button”

VALUE=”BACK”
onClick=”history.go(-1)”>

<INPUT TYPE=”button”
VALUE=”FORWARD”
onCLick=”history.go(1)”>

</FORM>

Using Themes
What if you like the
idea of Themes but

don’t like the options
available? Most of the themes
that come with FrontPage
have a very standard look to
them. That just won’t do
with something as personal

FRONTPAGE

You cannot use a PDF file as an Embedded Object—but can link to one
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as a Web site. Your first
option—and this works with
both FrontPage 2000 and
FrontPage 98—is to buy 
a theme from a third-
party company.

If you don’t want to buy
one, you can always design
your own theme. FrontPage
98 came with a theme
designer program on the CD.
But one of the more exciting
options available in FrontPage
2000 is the ability to edit an
existing theme or create a
new one from directly 
within FrontPage.

You will notice there is a
‘Modify’ button at the bottom
of the ‘Themes’ dialog box.
Clicking it will open up three
options for editing: the
Colours, the Graphics, and
the Text. Modifying the
colours lets you either pick a
scheme for your theme, or
lets you pick colours for the
colour elements modified 
by a theme. 

The colour options are all
on an Internet-safe palette.
Modifying the graphics gives
you a chance to replace or
modify any graphic element
on the theme. You can create
your own elements in
whatever graphics program
you choose. The final option,
Text, lets you modify or
create the text elements 
of your theme.

Once you are done
modifying your theme or
creating a new one, you
simply click the ‘Save As’
button in the bottom of the
‘Theme’ dialog box, and give
it a name.

Note that with Office 2000,
themes are now used across
the tools—Word, PowerPoint,
Excel, and others. Consider
making use of your new theme
in everything you do.

Use Folders Effectively
Folders make your life
easier, and have the

added bonus of making
navigation easier for your
audience. It is easy to put
everything into the root
directory—and that is the
program default—but in fact,
you don’t have to, and there
will come a point where you
wish you didn’t.

Web sites have a
tendency to get large rather

quickly, and a little advance
preparation is always worth
the effort.

Create a folder for every
group of documents you’ll
have on your site. Put your
images in one folder, your
‘about’ information in
another, and your documents
in another. 

Label the folders and
directories in a way that
makes sense. There is simply
no need to ever have to say,
“Where did I put that file?”

Use sub-folders as deep as
you want if it makes sense.
Remember, FrontPage keeps
track of where every file is,
so if you move a file from
one folder to another, it will
make sure the paths are
correct. This is useful if you
are contemplating if
it would be worth it to
organise that out-of-control
Web site. 

Not only is this technique
good for you, it’s also easier for
the viewer. If your site starts to
make sense through the URL
structure, they will have
another navigation tool for
your site—always a good idea.

Quickly Find Clip Art
When you open the
‘Clip Art’ dialog box in

either FrontPage 98 or 2000,
there is an under-
documented button that can
make your life easier. Select
the ‘Clips Online’ button—
which, in FrontPage 98,
resembles the Internet
Explorer shortcut symbol in
the lower right hand
corner—to open up the Clips
Online Web Site. 

The Web site will first
ask you to agree to the
EULA. You’ll then be taken
to a Web site that is updated
on a regular basis, which is a
searchable database of
clipart, photos and sounds
that are all usable as part of
your FrontPage license.

You can view clips by a
number of categories or types,
but the real value lies in the
‘search by’ option where, you
can enter a term on which
you’d like to see some clip art.
Considering the size of this
database, you will surely find
something. Once you do, you
can either download it by
selecting the piece, or

checking each piece and
downloading a collection in a
shopping cart-type of format
when you finish looking.

If you select the piece
directly, you will see the
categories under which this
piece was listed. You can
select any of these categories
to find other similar items.
Use this feature if you are
looking for a collection of
similar pieces.

FrontPage does all the
work needed to transfer the
file type to something
readable on the Web, and
Microsoft updates this site on
a regular basis.

Make Sure Your Site Works
On All Browser Versions

New to FrontPage 2000,
and not well-

documented, is the ability to
choose the browser type and
version as well as the server
type that you wish to design
your site for. To use this tool,
open the ‘Compatibility’ Tab in
the ‘Page Options’ dialog box.
The browser’s drop-down
menu lets you choose between
Netscape, IE, and WebTV, and
combinations of the three. 

The ‘Browser Version’
drop down menu lets you
pick the browser version type.
The Server drop-down menu
lets you pick the type of
server you are designing the
site for. Below this are a
number of technologies that
are either going to be
supported or not depending
on if the box is checked. 

You can check or uncheck
any of these items. In case an
item is not selected, you will
not be able to create anything
that uses that functionality.
Not all browser types use the
technologies on this dialog
box. If you want to make sure
that your site is as viewable
on as my types of browsers as
possible, deselect all the
fancy options.

It is important to note
that this feature won’t
prevent you from entering
anything that uses these
types of functions directly
into the HTML.

HTML Formatting And
Optional Reformatting

You can tell FrontPage
2002 how your HTML

page should be formatted,
from how many indents
should come before each tag,
or whether or not to use
optional tags. 

By default, FrontPage
preserves the formatting of
existing HTML, but applies
new HTML formatting to
content you add to the
existing page. HTML
formatting is viewed in the
HTML pane. 

The formatting options
you choose will apply to all
pages you create in
FrontPage. New in FrontPage
2002 is the ability to take a
page that has been imported
into your Web site and
reformat it according to
your preferences.

In order to apply your
HTML formatting preferences
to a Web page, open it in
FrontPage 2002 and perform
the following: go to Tools >
Page Options, and then click
the HTML Source tab. Click
‘Reformat using the rules
below’. Then under
‘Formatting’, select the
options you want. 

For instance, if you would
like all tags to appear as
lowercase instead of
uppercase, select ‘Tag names
are lowercase’.

Under Tags, select the tag
and attributes you want. For
example, select ‘Body’, and
then change indent to 12
spaces. FrontPage will change
the HTML pages you create in
FrontPage to use these
formatting rules. 

Make Sure Your Colours
Can Be Seen
There are dozens of
different browsers out
there. Not all of them use
colour, but for those who do,
you need what is known as a
‘Web Safe Pallette’. 

When you select the
colour options anywhere
from within FrontPage, the
dialog box mentions ‘More
Colors’. Clicking that button
shows you several more
colours available—it opens
up the ‘More Colors’ dialog
box. Everything in that box
is a Web Safe colour. Any of
those will work on any
browser that displays colour.

Bet You Didn’t Know



170 DIGIT JUNE 2005

Copy Protected?

My PC’s configuration is a Pentium 4 1.9 GHz,
Intel 845G motherboard, 128 MB of RAM, Intel

82845G graphics chipset with 32 MB video memory.
I have a problem when copying CDs to my
hard disk. Whenever I try to copy, I get an
error message that reads: “Data Error (Cyclic
Redundancy Check)” and when I click ‘OK’,
the error procedure cancels, and I cannot
copy the data thereafter. How do I solve this
problem? I have tried reinstalling the OS, but
the error persists. I use Windows XP Home
Edition. The error appears in all versions
of Windows.

Gurmail Chand
Delhi

The error you are experiencing is
known as the CRC or ‘Cyclic Redun-

dancy Check’ fail error. This error occurs
when the data being copied appears to
have lost its integrity or is corrupt. In your case,
there may be two possible reasons for the error to
occur: either your CD media is damaged or your
CD drive has developed a fault. You may check if
it is the first by trying to copy files to the hard
disk on another computer. Or, get the CD drive
serviced at an authorised service centre.

Mute Computer

I have a Pentium III 700 MHz system with an
Intel 815 motherboard, 128 MB of RAM and a 20

GB hard drive with three partitions running Windows
XP Professional. My problem is that I don’t have my
sound card drivers for XP. I searched the Intel Web
site but found nothing. I have an AC 97 sound ALC100

integrated sound card. Windows XP has installed its
default drivers for my card, but the sound is very low
even at full volume. My speakers are fine. Please tell
me where can I get the drivers, and if possible, please
include the drivers on the CD with the next issue!

Bijesh K
Thane

The latest version of the driver for the
ALC100 sound card is 3.71. You can down-

load this driver from the RealTek Web site at
http:// snipurl.com/86p8. The size of these drivers
is 11,453 KB. After installing, you will be able to
access the extended features of your sound card
as well. Please install the latest version of DirectX
for smooth functioning of this sound card along
with the drivers.

Write Error, Wrong Error?

When I write CDs on my PC, after 90 per
cent writing is completed, a write error

occurs and the CD becomes unusable.
Although not consistent, this is a frequent
occurrence. This problem occurs once in three
to four write attempts. In the process column
it shows ‘Lead in’ and ‘Lead out’, and in the
action column, ‘Failed’ when the error occurs.
The problem occurs in Windows 98 and XP
Professional. My PC configuration is: ASUS CD
writer, AMD Athlon processor, 512 MB of RAM,
80 GB hard disk, and the software used was
Nero 5 and Nero 6 OEM version. I had also tried
reinstalling the CD-Writing software.

Mahendra Gajbhiye
Indore 

Your problem could be caused by a variety of
reasons. The most probable reason is that the

brand of media you use might have a compatibil-
ity issue with your writer. You could try using
another brand and confirm this. Another reason
is that your CD-Writer’s lens might have become
dirty. This may be cleaned using a CD cleaner disc.
If the problem is not solved, you might try upgrad-
ing the firmware for your CD-Writer. You may
find the latest firmware for your CD-Writer from
the ASUS Web site: www.asus.com/support/
support.aspx.

If your drive is very old, the laser calibration
could also have developed a fault. This is a result
of the aging process of the CD writer and cannot
be rectified.

Anti-virus In Hiding?

I own a Celeron 2 GHz Intel motherboard and 256
MB of RAM running Windows XP SP2. Recently, I

installed Avast 4.6 Home edition. But the Windows
security centre doesn’t detect my anti-virus and it
alerts me to install an anti-virus. Why does this
happen? How can I overcome this?

T A Ravishankar
Palghat, Kerala

Avast 4.6 Home Edition and other anti-virus
software are not recognised by the Windows

Security Centre. Hence, many anti-virus manu-
facturers have released newer versions of their

Your Questions, Our Answers

Edit the PowerOffActive key in the registry



products to make them compatible with
Windows XP SP2. You need to upgrade to the
latest version of Avast, which is 4.6.652.

Always On

I have a Pentium 3 733 MHz with 256 MB of
SDRAM, an Intel 810 motherboard and a

Seagate 40 GB hard disk. I use Windows XP. I have
not been able to completely shut down my computer
for the past few weeks. When I select try to shut
down, Windows shuts down but my PC does not
power down. Is there any way to re-enable my PC to
completely power down?

Parag Trivedi
Nashik

While starting your PC, enter the CMOS
setup. This may be done by pressing the [Del]

key on most PCs. In the BIOS, go to the ‘Power
Options’ page and enable ‘Advanced
Power Management’. Save the settings
and restart the computer. 

Now, run Regedit. Go to
H K E Y _ C U R R E N T _ U S E R \ C o n t r o l
Panel\Desktop. Edit the key ‘PoweroffAc-
tive’ and give it a value of 1. Do the same in
HKEY_USERS\.DEFAULT\Control Panel\
Desktop. Close Regedit and restart the
computer. Now your PC will completely
power down after you shut down Windows.

Hide Folder

I have a Celeron 1.2 GHz, Intel 815E
motherboard, 128 MB of PC100 SDRAM,

and a 20 GB hard disk with an nVidia Riva
TNT2 M64 32 MB display card. I have Windows XP
Professional with Service Pack 2 installed. I have
also installed WinZip 9 on my computer. In Windows
Explorer, the .zip files are still shown as folders. I
wish to turn this off. Is there any way to do this?

Supriya Khambatkone
Mumbai

The feature of Windows XP/ME Explorer
showing .zip files as folders is not affected

by installing WinZip. You can turn this feature
off by running a command as follows. Click Start
> Run, enter “regsvr32/u zipfldr.dll” in the dialog
box and press [Enter]. Restart Windows and you
will notice that .zip files are no longer viewed as

folders. To re-enable this feature, just run this
command at the command prompt: “regsvr32
zipfldr.dll”.

Windows—A Non-Starter

I have a Pentium 4 3.0 GHz, 512 MB of DDR RAM
and an 80 GB hard drive with Windows XP. I

have recently started getting an error message—
“NTLDR not found”—during bootup, and I am not
able to boot into Windows XP. Please help me as I do
not wish to reinstall Windows and lose all my data
and settings.

Ashutosh Rane
Panjim, Goa

You have not specified whether you have
FAT32 or NTFS on your boot drive. We shall

assume that you have FAT32 on your boot drive,
that is, the drive on which Windows resides. Just

boot with a Windows 98 bootable floppy.
Select the ‘Boot with CD-ROM’ support
option and hit [Enter]. Insert the Windows
XP CD into the CD-ROM drive. Copy NTLDR
and NTDETECT.COM files from the i386
folder of the CD to the root of the boot drive.

If your boot drive has been formatted
with NTFS, then first boot with the
Windows XP CD. At the first ‘R=Repair’
option, press hit ‘R’. Press the number that
corresponds to the correct location of the
boot drive. If Windows is installed in the C:
drive, this number is 1. Enter the adminis-
trative password when prompted to do so
and then enter the following commands: 
COPY X:\i386\NTLDR C:\
COPY X:\i386\NTDETEC.COM C:\

Bear in mind that you will have to replace the
letter ‘X’ with your CDROM’s drive letter. Take
out the CDROM and type “exit”. This should fix
your problem.

Clean Title Bar

I have Windows XP Home Edition with Service
Pack 2 installed. My Internet Explorer 6

window has title that goes like “Internet Explorer -
provided by XYZ company”. I wish to restore the
window title to the default.

Aarti Gupte
Indore

The Internet Explorer window title you are
referring to is sometimes used by OEMs to

brand their computers. You can easily get rid of it. 
Open Regedit. Go to HKEY_CURRENT _USER\

Software\Microsoft\Internet Explorer\Main, and
in the right pane, search for a string named
‘Window Title’. You will be able to view the OEM
branding next to this string. Delete this string
to get rid of the window title.

Where’s The Space?

I use an AMD Athlon XP 2000+ laptop with 512
MB of RAM and a 30 GB HDD single partition

running Windows XP Professional SP2. Of late, I
seem to be losing hard disk space on the sole parti-
tion of my laptop. Once, when I transferred a file of
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Catalogue CDs And DVDs Using XBaseCatalog 

Jayesh Limaye

It's only natural that as our burnt-CD or
DVD collection grows, we lose track of
what has been stored on what disk.

Remember when you searched for that very
special MP3 song you burnt a long time ago?
And didn't find it?

That needn't happen again. There are
software utilities that can index the contents
of your CDs and DVDs into searchable cata-
logues. OOBOX XBaseCatalog is one such soft-
ware—here, we take a look at how it can be
used to catalogue your disk collection.

The OOBOX XBaseCatalog Standard
evaluation version can be downloaded from
www.oobox.com. It can catalogue Zip disks,

floppies and digital tapes in addition to CDs
and DVDs.

The limitation of the demo version is
that you are allowed to create a maximum of
three volumes; contents of ZIPped files are
not indexed; MD5 authentication, which is
used to verify the authenticity of the files, is
not available; files cannot be compared with
files already present in the database; and a
nag screen is displayed every time you start
or exit the program.

The Standard version is available for
$19.95 (Rs 870), and the Professional version—
with even more features—is $49.95 (Rs 2,170).

The first step involves
creating a new volume
to be included in the
catalogue—the volume

of a CD or DVD is an index of the
files on that disk. To create a
new volume, click the Add
Volume button on the toolbar.
The Add new volume dialog box
will come up.

Place the disk to be
catalogued in the CD or
DVD drive, and select
that drive in the Add new volume

dialog box. Click Process Start to start the disk
scanning process. After the scanning is
complete, the Info window will indicate the

information about the media, such as the
volume label, total size and serial number.

Enter an ID in the ID field
to identify the CD or DVD
volume in the catalogue.
You can also add

comments to make it easy to iden-
tify the volume later. Now click
Add to add the volume created
from the just-scanned disk to the
database. Click Close to return to
the main interface. Here you will
be able to view details such as the
size, number of files, the serial
number, and the name and ID of the volume.

In the same way, you can scan and add
more such volumes to the catalogue.

To browse a volume,
right-click it and
select Browse this
volume. You will be

presented with a window that
shows the directory tree of the
volume with files and their
details such as size, date, etc.

You can also search
the database by click-
ing the Search button
on the toolbar. In the

Search dialog box, you may
search for a file based on name,
creation date, and size. Try
searching for a file, and you will

be pleased to see that the results are
displayed in no time!

There is also the facility to
export a volume (or all
volumes) in the database,
so it (they) can be backed

up for archival. Similarly, the import
facility can be utilised to export a
volume into the database.

jayesh_limaye@thinkdigit.com

Almost all of us who own CD and DVD-Writers have gone on a burning rampage over the
past couple of years. Here's how to organise the results

All files and folders have been scanned at this point

OOBOX XBaseCatalog interface

Multiple media in a catalogue

Browsing the media catalogue you created

Search the media catalogue

Adding new volume to catalogue
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700 MB via FTP, I encountered the error due
to insufficient disk space and I lost those 700
MB permanently and could not recover it. 

Another strange thing I have observed is
that my ‘Temporary Internet Files’ folder is
unusually large in size (961MB) and keeps
increasing. Windows says that it contains 14
folders but I can’t see even a single folder in it.
Since this is a special OS folder, I can’t even
delete it and recreate it. Please help me recover
my HDD space!

Nikhil Wason
New Delhi

Windows creates a lot of temporary
files during the course of its operations.

The sad thing is that it forgets to delete each and
every one of
these tempo-
rary files and
hence these
files go on accu-
mulating and
eating up your
hard disk space. 

Most of
these files can
be done away
with, though,
using the
provided ‘Disk
Cleanup’ utility.
But even this
utility cannot

delete all the unwanted files from the
hard drive and you have to live with these
files, since some of these are required for
the functioning of Windows. 

Alternatively, you may use third-
party utilities such as Cleanup! from
http://cleanup.stevengould.org and
System Cleaner from www.system-
cleaner.com to cleanup your system and
registry and free up some more space.
Since these third party utilities deal with
the registry and system files, use them
with a little caution. You may not be able
to view the folders inside your ‘Windows’
folders because these are system folders
and your Explorer might not be config-

ured to view hidden and system files and folders.
The other solution would be to do a clean install
of Windows XP on your hard drive. 

Return To The Game

I want to know how I can back up my saved
games in Grand Theft Auto Vice City, so I can

use them after I have reinstalled Windows.
Aamir Khan

Via E-mail

All GTA Vice City saved games and profiles
are placed under “GTA Vice City User Files” in

“My Documents”. Just copy these to a folder of
your choice. When you reinstall Windows and
GTA Vice City, just copy these to the original loca-
tion and you can access your saved games. 

E-mail us your computing
problems along with your
contact details to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we may answer them
here! Since we get more
mails per day than we
can handle, it may take
some time for your 
query to be answered.
Rest assured, we are
listening!

Get Help Now!

Divide And Rule!

My computer configuration is as follows: 2.40 GHz Intel
Celeron processor, 40 GB hard disk and 256 MB RAM. My OS

is Windows XP. I also want to run Windows 98 on my computer
and this is where the problem arises. I have only two partitions
on the hard disk. One (D :) is full of system recovery i.e., of 4 GB

while the other (C:) has Windows XP, taking up 36 GB. 
Here, nearly 10 GB of space is free. I want to make
another partition without backing up my data so as to
install Windows 98 there. Is there any software that
allows a partition out of the free space available on C:
while working on it? 

Another problem related to installing Windows 98
over XP. Will it replace the boot loader of Windows XP and
boot to Windows 98? If yes, what should be done to correct
the boot loader so as when I boot up my PC, it will prompt
me whether I want go for 98 or XP. I don’t want reinstall
Windows XP.

Sunil S Kewade
Nagpur

To create a partition in the free space of your hard drive
without losing any data, you will need to use a utility

known as Ranish Partition Manager from www.ranish.com
or Norton Partition Magic 8 from www.powerquest.com. It is
never 100 per cent safe to play with partitions and be
assured that your data will not be lost. Still it is advisable to
back up your important data before you begin the creation
of the partition.

In order to restore the Windows XP boot loader, you need
to follow these steps: Create a Win98 Startup Disk. Create a
text file with the following entries, exactly as shown:

L 100 2 0 1
N C:\BOOTSECT.DOS
R BX
0
R CX
200
W
Q
Save the file to the Win98 Startup Disk as READ.SCR. Boot
the computer with the Win98 Startup Disk and at the A:
prompt, type 
DEBUG <READ.SCR

These steps will create the BOOTSECT.DOS file needed to
boot Win98. You may need to use the ATTRIB C:\BOOT-
SECT.DOS -S -H -R command if BOOTSECT.DOS already exists.

Configure your computer to boot from the CD drive. To
do this, enter the CMOS setup which is usually done by
pressing Del key during booting. Go to the Advanced BIOS
Settings and here you will be able to change the boot
sequence of your computer. Boot from your Windows XP CD.
When you are presented with a choice of installing or repair-
ing an existing installation, choose repair. You’ll be asked
which XP installation you want to log into. Enter ‘1’. There
is usually only one installation. You’ll be prompted for the
Administrator password. For XP Home, the default password
is blank, so just hit [Enter]. For XP Professional, enter the
same password you did during setup for the Administrator
account. At the C:\Windows prompt, type ‘FIXBOOT’. You’ll
be prompted to confirm. 

When FIXBOOT is finished, remove the XP CD and type
EXIT and the machine will reboot. Reconfigure your computer
to boot from the hard drive if necessary. Now you will get the
XP boot loader with your choice of operating systems.

Question 

of the

Month

The Disk Cleanup utility in XP
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Icould blame it on the Greenhouse effect, but
I am not an environmentalist! Anyone who
uses a PC and claims to be an environmen-

talist is fooling himself. But I am digressing
even before getting to the point (and that is a
first even for me!).

Problem is, the heat is getting to me—and
the evidence is pretty clear. Which brings me to
this month’s topic—cooling solutions. 

I hate summers. The heat and humidity
drain me completely, and at times leaves me
wondering what life in Rajasthan would be like.
It is this time of year that I take the maximum
care of my PC too—a ritual I started because I’ve
lost too many PC components during the sum-
mers. My experience apart, lately, my mailbox
has been bombarded with requests for cooling
solutions, and I thought this was the best time
to address the heating problems so many face. 

In PCs, air is used as the medium for trans-
ferring heat from the components to the atmos-
phere. In fact, until some years ago, liquid cool-
ing for PCs was unheard of, and only recently has
liquid cooling emerged as an effective alternative
to traditional methods. 

To achieve maximum cooling efficiency, you
need to manage on the macro (system) as well as
micro (component) levels. The perfect synergy
between system and component cooling leads to
the best overall cooling of your PC. 

When it comes to system-level cooling, a lot
depends of the PC case (cabinet) you buy. I have
often received letters where users say they have
two-fan cabinets, but the cooling is not up to
the mark. The culprit is often the types of
fans and their placement in the case. 

Most cabinets in the market today
have provision for 80 mm fans—one at the
front lower bottom and other at the rear.
Instead of opting for such cases, consider a
case with provision for one 120 mm fan
at the rear. These fans run at a lower
speeds, but dispel a high vol-
ume of air and so, in general,
are more efficient than the
faster-spinning 80 mm fans.
Moreover, with the launch
of the new Prescott-core
Pentium IV processors, Intel
has recommended changes
in the case design, and these
cases are called 38 degree
cases. There are ducts on the
side panel that open straight on
the top of the processor and the
graphics card for better cooling. 

Not many vendors sell them
except for those made by Antec and
VIP. Cabinets from these brands are
expensive and not for the average user. 

However, commonly available brands such
as Mercury and iBox have also introduced
some good models. Mercury has two series—
the KOB and the KM. If you are buying a new
PC, I would recommend the new KM series; it
conforms to Intel’s recommendations. So
what if it does not have 120 mm fans?

iBox, too, has the i531 model specifically
made in keeping with Intel’s recommenda-
tions. Zebronics is a popular brand in south
India, and has some good models. Such cases,
though, will set you back by around Rs 1.5K.
Although manufactured conforming to Intel’s
specs, they work great with AMDs too! 

Gamers, though, with high-end processors
and graphics cards (nVidia 6800 GT), have no
option but to spend that extra cash on an
Antec  case. 

On the component level, the processor,
graphics card and PSU dissipate significant
amounts of heat as compared to the
other components.

Processors are generally provided with a
heat sink-fan combo (HSF), and can take care
of heating issues under standard working con-
ditions. However, if you overclock the proces-
sor, you might need some help keeping the
temperature under control.

For processors, three types of solutions are
available—the first is the standard HSF, but
with better heat conducting materials such as
copper in place of aluminium alloy. Such solu-
tions are available from Thermaltake, Cooler
Master, AVC and others, and are generally in
the range of Rs 1K to Rs 1.5K. 

To further improve thermal conductivity,
manufacturers introduced a heat pipe—a pipe
containing coolant—between the fins of the
HSF. Such solutions cost upwards of Rs 2.5K.

The third type are the liquid cooling kits
from Thermaltake and Cooler Master. Here, a
small pump drives water (or coolant) between
a copper block and a radiator. Liquids are
more efficient in conducting heat and hence,
better cooling is achieved via these kits. Such
a kit could set you back by Rs 8.5K.
Unfortunately, there are very few shops deal-
ing in such specialised products and hence,
the best way to get them would be by
importing them. 

There are liquid cooling kits available
for graphics cards too, but they are
extremely rare in the Indian market.

As for PSUs, just buy a good-quality
one—it will come with two fans that will

keep the heat under control.

Agent 001

The perfect
synergy between
system and
component
cooling leads to
the best overall
cooling of
your PC

Cooling Solutions
It’s summer, and like you, your computer, too, needs to stay cool!

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Shyam Shriram
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DVD Switch

I read the review of the Mitashi DIVX-555
DivX player, and was planning on buying it. I’d

like to know of a dealer in Kolkata. I am also
planning to buy a DVD-Writer, and would like to
know about the best one that would be available
around Kolkata.

Appusarkar

The Mitashi DIVX-555 player is available
through Mitashi Edutainment Pvt Ltd, a

Mumbai-based company. You can contact them
on 022-25006661 and find out about their
branch in Kolkata. As for the DVD writer, I sug-
gest you go for the Lite-On 1653S, which costs
around Rs 4K and can burn DVDs at 16X. It also
supports dual layer +R at 6X.

Print To CD
I want to buy a printer that can print directly on
CDs, that is, I want to print the CD face directly

on the CDs rather than printing it on paper and then
pasting that onto the CD. What model would you
suggest I go for? My budget is around Rs 8K.

Anil

There are quite a few models from
Epson and Canon that offer CD face

printing via an attachment. As far as Epson is
concerned, the printing quality is not as great
as Canon’s—I’d suggest Canon over Epson.
Canon’s new line of Pixma printers has the CD
face printing feature in their mid- and top-
range printers. 

Digit evaluated two of these—the Pixma
IP3000 and IP4000—both of which have the CD
printing feature. The IP3000, though, costs
around Rs 8,495 while the IP 4000 will set you
back by Rs 10,995. Speed and cosmetic
differences apart, the two models are virtually
the same, and you can safely settle for the
IP3000 model. Remember that for printing on
CDs, you need printable CDs that support
this feature.

MP3, FM Radio And Warranty
I am looking to buy an MP3 player that suits my
needs—a Flash-based device with 256 MB capaci-

ty and with FM radio. I would like a player that uses
normal batteries or one with rechargeable or user-
replaceable batteries. I don’t have any particular
brand in mind. Warranty, though, is a concern.

Nish Dave

I would suggest you go for Creative’s
MP3 players as they offer good features,

great performance and have good after-sales
support in place. Creative has a long line of
players to choose from; you can settle for the
MuVo TX FM model. This player runs on a single
AAA battery and offers decent battery life.
Capacities range from 128 MB to 1 GB; prices
vary according to the capacity. It also has a FM
tuner. The MuVo TX FM is priced at around Rs
8K for the 256 MB model.

Laptop With After-Sales
I am interested in buying a laptop in the range
of Rs 35,000-40,000. On inquiring in the mar-

ket I got to know about different models from vari-
ous manufacturers such as Compaq’s m2002, Acer’s
Sempron-based model and Zenith’s Salespro. I need
help with my purchase decision as I am confused
about quality, speed and after-sales service.

Lalit Jain

In your mentioned price range, you will
get laptops based on Pentium 4, Celeron

or Sempron processors, though I would still ask
you to shell out a little more and opt for
Centrino-based laptops. As far as raw speed is con-
cerned, Pentium 4 and Sempron will pose no
problems.  I would suggest you not to look at
Celeron processors as an option at all. 

Digit reviewed Acer’s Sempron-based laptop
and found it good in terms of performance, fea-
tures and price; since Acer is based out of
Bangalore, service won’t be a problem for you. 

As far as Compaq and Zenith are concerned,
Digit hasn’t reviewed them so I don’t have a con-
clusive opinion to offer. In general, though, they
will be good as far as quality and service is con-
cerned, while the performance will depend on
the configuration you choose.

Video Capture Cards
I am interested in buying PCI-based video cap-
ture cards. Does any such card offer TV tuning

capabilities? My budget is around Rs 8K, and I plan to
use it to record from a VCR and handycam.

Jithin Jayaram

There are some players in the video cap-
ture segment—Pinnacle Systems have

good products, but they are priced a little high-
er than the others. You can look out for
Pinnacle Studio 9, and external solution inter-
faces for your PC via the USB port, which cost
around Rs 14,500. 

Monarch Vision, an Indian company, also
has products tailor-made for the Indian audi-
ence. The MV5 and MV20 models are priced at
Rs 9K and Rs 14,800 respectively.

For printing on
CDs, you need
printable CDs
that support this
feature

Want a tech product, but
don’t know how to go
about buying it? 
Send an e-mail to
aaggeenntt000011@@tthhiinnkkddiiggiitt..ccoomm
to get your queries
answered

Ask Away

Ask Agent 001

Rs 
7,500
6,500
3,500
2,650
6,500

300
300
500

2,000
2,750
2,400

34,900

Mid-Range PC

AMD 939 pin Athlon64 3000+ or AMD
939 pin Athlon64 3000+ or 3200+ 
MSI RS480M2
512 MB DDR 400 Hynix
80 GB SATA Samsung/Seagate
17" Acer 715 CRT
Logitech 
Logitech optical mouse
Any cabinet you like
Antec / VIP 350 W power supply 
Lite-On / Sony combo drive
Creative Inspire 2.1

Make Cost (Rs) Mid-Range
CPU 
Motherboard
RAM
HDD
Monitor
Keyboard
Mouse
Cabinet 
Power supply 
Optical Drive
Speakers
Total

Last month we gave you details on
high- and low-end PCs. This month, we

take a look at mid-range PCs.
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The cryptic cries, grins and
gurgles of babies that

leave parents dumbfounded
could soon be deciphered, if
modern technology delivers
as it promises.

Three years after a
toymaker scored a smash
hit with the ‘Bowlingual’
gadget to interpret the warp
and woof of a dog’s life,
Japanese researchers may
have an even bigger
sensation—a translator for
baby babbling.

“We aim to develop a
device to read babies’
feelings,” says Kazuyuki
Shinohara, a neurobiology
professor at the state-run
Nagasaki University who
leads the research team.

Shinohara’s group has
been conducting
experiments involving
mothers and their babies by
monitoring the infants’

cries, facial expressions and
body temperature changes
in a project backed by the
government-subsidised
Japan Science and
Technology Agency.

“We are trying to read
babies’ faces numerically
such as the distance
between eyebrows and the
nose tip,” said Shinohara. As
for other clues on what

babies mean to say,
researchers are analysing
whether high or low
frequencies in the sound of
the cries show they want
specific things. 

The team is also
monitoring temperatures of
the babies’ bodies, mostly
the face, using thermo-
graphy. Shinohara says the
changes in temperature
indicate particular desires.

The professor, who
declined to elaborate on his
conclusions or the shape of
the gadget pending
patenting, aims to launch
the device by mid-2006.

The product would be
for use at medical
institutions and homes. The
professor would like to price
a home-use version below
¥10,000 (approx. Rs 4,100).

“You may lose confi-
dence as a parent if your
baby cries a lot. But your
child-rearing ability inc-
reases by trial and error,”
says Yuko Iguchi, clinical
psychologist at National
Children’s Castle in Tokyo.
Shinohara claims his device

could make bringing up
children more enjoyable for
parents. “It is cruel just to
tell them ‘You should
naturally know what your
baby wants’,” he says.
“There is no use scolding
parents. We want them to
have fun raising babies by
taking advantage of tech.”

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most 
eye-catching of them each month.

Shubhajit’s desktop makes good use of desktop tweaking
tools, cursor enhancements and player skins. We love the icons
and taskbar transparency. Congrats Shubhajit!

My Desktop

“Tamilnadu Infotech
THE WEB COMPANY”

That’s it. 
Huh? Well, that’s it!

Don’t get it? OK, let’s
explain a little bit: that
piece of information—that
Tamilnadu Infotech is “The
Web Company”—is all there
is on http://tamilnadu
infotech. com. It’s a
.jpeg logo. 

We tried clicking on the
logo, then, in frustration,
on random places all over
the page—to no avail. Then
we realised that we could
view the page source, and
there it was—one jpeg logo,
that’s all. 

We’d assume that the
site is under construction,
but wouldn’t an ‘under
construction’ logo or text
have helped? Without that,
we’re forced to conclude
that Tamilnadu Infotech
doesn’t have anything to
tell the world except that it
is “The Web Company”.

http://tamilnaduinf
otech.com

Linux Leader Quits 
Richard Seibt, one of the leading lights behind SuSE Linux
before it was acquired by Novell, has quit. Seibt’s resignation
comes just a week after Novell made Ron Hovsepian president
of worldwide field operations. Hovsepian and Seibt had been
public about their differing opinions about SuSE’s future.

Football Club On eBay! 
Dinel Staicu, owner of Romanian second division side
Universitatea Craiova, tried to give the club to his local
council. The council said they weren’t interested. Staicu then
said, “The only thing I can think of doing now is putting it on
eBay and seeing if I can find someone to take it over."

The winner
receives a copy
of Enterprise
Application
Architechure With
VB, MTS and ASP
By Joseph Moniz,
published by Shroff
Publishers & Distributors Pvt. Ltd.
This month’s winner is  
Shubhajit Maity

WHAT SAY BABY?

Scientists Working On
Baby Babble Translator 
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STOP THE GYPSY MUSIC

A Very
Selective
Virus

Anew computer virus
reported in Romania

deletes only electronic
gypsy music files. The
Win.32. Antiman.A virus
destroys audio and video
files containing ‘manele’
music. Manele is
traditional gipsy music
played in an electronic
style, which has become
very popular in Romania.
But it also has many
detractors who have
praised the virus as a
utilitarian blessing. 

Softwin, a Romanian
company specialising in
anti-virus software, said 
the worm works by
targeting files associated
with singers’ names.
Softwin spokesman 
Cosmin Mares said, “The
effects of the virus are an
increased usage of the
Internet bandwidth and
serious problems to
companies’ servers. All
these cost money and
someone has to pay.”

Vali The Blizzard, a
popular Manele singer,
said, “I don’t believe this is
a threat for us. On the
contrary they are doing us
a favour. This way our 
fans will have to buy the
CDs and not take the
music from the Internet
for free.”

PIXEL EYES

Artificial
Retina To
Help Blind
See Again

Scientists are helping the
blind see again, one pixel

at a time. If all goes well, an
artificial retina could be
commercially available
within three years. 

Artificial retinas have
been successfully implanted
in six patients, allowing
them to see light and detect
motion, researchers of the
Association for Research in
Vision and Ophthalmology
in Florida announced in May. 

Developed by researchers
from the University of
Southern California and the
Doheny Eye Institute, the
artificial retina pairs a tiny
electronic eye implant with
a video camera mounted on
a pair of sunglasses. 

The implant, a four-by-
four grid of electrodes,
connects to damaged
photoreceptors on the
patient’s retina. The
electrodes stimulate the
photoreceptors, which
transmit signals to the brain
through the optic nerve. 

The videocam translates
the field of view into
electrical impulses that are
transmitted wirelessly to a
microchip located behind
the ear. In turn, the
microchip is connected to
the retinal implant by wires
under the skin. 

The system, named
‘Argus’ after the Greek god
who had a hundred eyes,
works only with patients
with degenerated rods and
cones, a condition often

Dr Niklaus Wirth is
considered the creator

of the Pascal family of
programming languages.
Wirth earned a degree in
Electronics Engineering
from the Swiss Federal
Institute of Technology,

Zurich
(ETHZ), in
1959
followed by
an M.Sc.
from Laval
University,
Canada. He
completed

his Ph.D. from the
University of California,
Berkeley, in 1963.

In 1968, Wirth
returned to ETHZ as a
professor of computer
science. At ETHZ, Wirth
developed Pascal (1970),
Modula-2 (1979) and
Oberon (1988). Pascal
turned out to be a new
computer language as
well as a novel
programming paradigm.
It became an educational
tool that motivated
systematic and structured
ways of thinking.

From 1992 onwards,
his research has concen-
trated on digital design
tools as well as the use of
programmable devices. 

Wirth has received
several honorary
doctorates and awards,
including the Turing
Prize, the IEEE Computer
Society's Computer
Pioneer Award, and the
ACM SIGSOFT
Outstanding Research
Award in Software
Engineering.

Wirth retired from
ETHZ in 1999, after more
than 30 years of service as
a university professor. He
has published several
books that are considered
classics in the field.

Pascal
Pioneer

People Who
Changed

Computing

Dr Niklaus Wirth
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caused by disease. It will not
help people with damaged
optic nerves or other types
of blindness.

AL’S INTERNET CONNECTION 

Lifetime
Achievement
Award For
Gore

Failed presidential candi-
date Al Gore, who once

famously claimed to have
“invented the Internet,” is
to get a lifetime achieve-
ment award for services to
the Internet.

Gore was widely laughed
at for his comments in a
CNN interview that he “took
the initiative in creating the
Internet.” In fact, he was
only 21 when the Internet
was created out of a
Pentagon project.

However, the Webby
awards for online achieve-
ments said that Gore will
get a lifetime achievement
award for three decades of
service to the Internet.

The Webby awards say he
did “amazing work for three
decades as Congressman,
Senator and Vice President.”

Ironically, one of the key
founders of the Internet,
Vint Cerf, will give Gore the
award at a June 6 ceremony
in New York.

When Gore joined
Congress eight years after
the Internet was created, he
promoted high-speed
telecommunications for eco-
nomic growth and sup-
ported funding increases for
the Internet. He also coined
the term ‘information
superhighway’ when he was
vice president.

STAR-GAZING SUPERCOMP

Europe
Supercomp
To Process
Starry Data 

Europe’s biggest
supercomputer will

crunch data from
thousands of radio
antennae eavesdropping
on the history of the
universe, claims its Dutch
developers, the
Netherlands Foundation
for Research in Astronomy
(ASTRON) and the US
computer giant IBM. 

Based in Holland, the

supercomputer will process
signals from up to 13 billion
light years from earth, as far
back in time as the
beginnings of the earliest
stars and galaxies after the
formation of the universe.
“Unlike current observatories
that use large optical mirrors
or radio dishes to point to
distant galaxies, ASTRON will
harness more than 25,000
simple radio antennas,”
claims IBM and ASTRON.

Running on 12,000
PowerPC microprocessors,
the supercomputer can
execute 27.4 teraflops, or
27.4 trillion floating-point
operations, per second,
which makes it Europe’s
most powerful computer
in terms of sustained
performance. 

The new computer will
form the heart of a new
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“It’s been Four Years? Wow!” That’s
the reaction most employees of

Digit had. Time sure flies when you’re
having fun. 

It’s true, we admit it! Each and every
one of us loves our jobs. It’s not a crime,
is it? It’s hard to not love a job where you
get to interact with the latest technology
and the greatest technological minds on
a daily basis. And we don’t mean just the
employees, or the people we interview;
some of our readers have taught us a
thing or two thousand over the years.
And yes, we did end up hiring them!

That’s the beauty of the philosophy
of Digit; we’re an open forum, a
community magazine that’s, to
paraphrase, “of the reader, by the
reader and
for the
reader.”
Every
employee,
from the big

bosses to the lowly writers, still love
reading Digit. Some are so tired of
magazines disappearing from their
office desks, they’ve subscribed! 

While preparing this anniversary
issue, every employee took the
opportunity to drift down memory
lane, reliving their first story, their first
ordeal of burning DVDs, their first e-
mail from a reader, their first goof up,
our reader forums, Planet Digit, the
redesign, and a million other things. 

We’d like to thank each and every
reader and employee that stuck with
us through the good and then the
better. So, here’s to another great year
in technology with Digit, and we
promise to only deliver the best. With

apologies to
Frost, “We’ve
got promises to
keep, and miles
to go before 
we sleep...” 

Four Down, Many More To Go 

DIGIT JUNE 2005

Dreamweaver
How do you manage to look
intelligent when someone
throws Dreamweaver jargon at
you? Here’s a very brief primer.
““AAdddd  aann  iimmaaggee  sswwaapp
bbeehhaavviioouurr......””
Just remember that anytime a
user mouses over a menu item
and the item gets highlighted,
that's an “image swap”; and a
“behaviour” is jargon for
JavaScript codes that can be
built into a document. It’s “a
combination of an event and an
action". “Behaviour” is a term
you'll come across pretty often.
““CCSSSS  SSttyylleess......””
You're bound to hear that from
anyone who's building a Web
site. All you need to remember
is, “The W3C-approved method
for presenting and positioning
objects in a Web page is using
cascading style sheets (CSS).
Dreamweaver makes it easy to
define styles.”
““LLaayyeerrss......””
When someone mentions layers,
you’ll know what they're talking
about if you remember this:
“Dreamweaver uses DHTML to
make layers. DHTML is a
scripting language that allows
HTML to change even after a
page has been loaded into a
browser.” Of course, you've also
got to remember that layers are
a little bit like containers for
stuff on the page. You can
actually specify exact co-
ordinates and some other stuff
like hiding particular layers. You
can have many layers on one
page and hide each one until
required.
““JJuusstt  rree--uussee  tthhaatt  ssnniippppeett......””
Reusing code pieces, also known
as ‘snippets’, is supposed to be
“a great way to save time.”
And as for ““bbiinnddiinnggss””, we don’t
know what they are, so just
rote-learn the following: “The
Bindings tab of the Applications
panel holds dynamic content in
a safe place for you to easily
access and bind as you build
your documents.
For example, when you create
a recordset, it will be listed
under the Server Behaviors
tab, and accessible under the
Bindings tab. You will be able
to bind recordset columns into
your document.”
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radio telescope developed
by ASTRON, and gather
and analyse information
from ASTRON’s Low
Frequency Array ‘software
telescope’ network. 

SUCCESSOR TO THE PS2

PS3 Due
Next Spring 

May 16, Sony announced
that PlayStation 3, the

successor to the top-selling
PlayStation 2, will arrive
next spring.

Microsoft’s Xbox 360,
announced mid-May, is
slated for release this fall.
Microsoft thus has a head
start, and the Xbox 360, too,
is aimed at the living room,
with high-definition video,
music and movies. But Sony
boasts that the PS3 will have
twice its power.

The system will support
Sony’s high-definition
format—the Blu-Ray disk,
and all PlayStation and PS2
formats, in addition to
DVDs. It also will have built-

in wireless and broadband
capabilities.

The PS3 will not only
deliver high-definition video
games to HDTV sets, it also
will allow those who own
two HDTVs to create a single,
panoramic, ultra-wide
screen. A second screen such
as a PC monitor could also
be used to show tactical and
statistical game data or video
chat streams.

“This is allowing (users)
to merge the real and
virtual world together,” Ken
Kutaragi, largely seen as the
father of the Sony
Playstation, said.

The PS3 will use the cell
processor, created by IBM
with Sony and Toshiba,
which has supercomputer-
type performance 35 times
more powerful than does
the PS2. The nVidia
graphics processor in the
PS3 will be more powerful
than two high-end PC
graphics cards. 

Compiled by Aditya Kuber,
Mithun Kidambi,

Ram Mohan Rao and
Renuka Rane

Seriously. We've seen some stupid, corny and outrageous
stuff on the Internet, but this takes the cake. It's not actu-

ally a site, rather a blog called “Hulk's Diary That Is On The
Internet”. Supposed to be the Hulk's (the green cartoon mon-
ster character) diary (that is on the Internet, so we assume he
also maintains one offline), there is nothing but text that
seems to be written by people with sub-zero IQs or those who
have been drugged before they wrote it. Or maybe both!

The blog is run by someone called Puny Human Kevin (and
it seems he gets help from another Puny Human, Scott) and
they are the Hulk's flatmates. It has been in existence since
January 2001 and apparently, over 3,60,000 people have vis-
ited the site since. Incredibly (as much as the Hulk, perhaps), is
the fact that there seems to be a loyal following with sugges-
tions like “Hulk must drink Superdrink Red Bull”. What?

People are sending photographs and stuff they make to the
site and if not put up, they get mad and then, “Hulk apologise”.
What doesn't surprise us, though, is the fact that donations are

being accepted. For what? “To
buy Superdrink for Hulk”! 

It's ridiculous and after
reading through half the home
page, we were numbed at the
lack of intelligence of the entire
membership. How seriously can
you take a sham? Visit and you
shall know! 

P.S. Some stuff like the
Hulk’s song (!) are funny, and
make you snicker once.

whatweretheythinking.com

Educational Weblogs
http://weblogs.asp.net/jasonsalas
Albert Delgado

Shrook 2.2 - RSS newsreader

What's New: Full attachment support with iTunes and
iPod integration for podcasts Access to podcasts from
iPod Notes menu * Spotlight searching support *
Support for self-signed HTTPS certificates * Improved
feed: support * Various minor improvements and
bugfixes 
Requirements: Mac OS X 10.3 or later.

Simple Thoughts
http://blog.taragana.com/
angsuman

Thought experiment: Google Web Accelerator
and phpMyAdmin combo
What would happen when a GWA user uses
phpMyAdmin? 

It is not https connection, yet protected by
a password, which will be visible to Google.
With GWA's pre-fetching and disregard for
javascript confirmations, you have the prospect of
serious data loss (read database wipeout). Does
Google apply its caching ingenuity to password
protected pages?

Anyone up for the little experiment? Open
phpMyAdmin, while using GWA, and browse around
a bit. Let me know what happens. 

All about Technology
http://techupdates.blogspot.com
indian

Save Battery using Offline Mode in Ngage
I am a proud owner of Nokia Ngage. I am totally
satisfied with the quality and functions of this
beauty. One more feature of Ngage is that it can
save your battery and even can make you away
from annoying and disturbing calls.

Saving Battery: While roaming, if you haven't
activated roaming or there is no network, you can set
thepProfile of your phone to 'Offline'. Offline mode
makes your phone not reacheable to anyone and will
stop searching for new network, hence will save battery.

Eric Bowen’s .NET technology blog
http://scrappydog.com/blog/

I’ve become a VB hating C# bigot
I’m not sure quite when it happened, but I've gone
over to the dark side and become a VB hating C#
bigot. I've had a long career as a Basic programmer
going all the way back to my TRS-80 Model I Level II
in 1979, following by AppleSoft, QuickBasic, and then
every version of VB and Microsoft Access...

Last week I started a major new project for a
large corporate client that is using VB.NET, and I
just don't want to do it. Yes, intellectually I know
VB.NET and C#.NET are almost identical, and I'm
equally fluent in both, but I just don't LIKE VB.NET!
Moral of the story? None...

On using Google Web
Accelerator in
conjunction with
phpMyAdmin; an RSS
newsreader with
support for iPod
integration and more;
on saving battery on
the Nokia Ngage; and
a rant about VB
versus C#. That’s our
pick of blog posts
this month

HULK’S DIARY THAT IS ON THE INTERNET

http://incrediblehulk.blogspot.com
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FIFA Soccer 2005
FIFA 2004 was not a good game. Actually, that
was a huge understatement. OK, it sucked. Real
bad. I actually preferred to play FIFA 2003 instead
of FIFA 2004. Now EA’s come out with FIFA 2005.
Is it more of the same, or is it any good? Will it
be a waste of your money? Hell, no!

This Is The New Shit
FIFA 2005 is one helluva game. It comes with the
customary 350 licences, including 20 leagues, 40
national teams and over 15,000 players. All
rosters are also up to date, with all transfers up
to October 1, 2004 reflected in the game.

There’s an all new interface, which is a real
saving grace, because FIFA 2004’s interface… well,
the less said the better.

Also, for the first time since FIFA 2002, 2005
comes with a Creation Centre built in, so your
days of downloading them are gone. It’s detailed
to the core.

Another nifty feature is the EA Store. By
fulfilling certain objectives, you earn points that
allow you to unlock certain items. So you have
alternate kits, different balls, songs and stadia to
be unlocked—even celeb referee Pierluigi Colina!
All this is just the tip of the iceberg. What really
makes the game so darn good is the First Touch
model and ultra-realistic gameplay.

They Call It The Real Deal
EA has introduced, for the very first time, a First
Touch model that realistically simulates your
player’s first touch of the ball. The first touch
depends on how the player is positioned and the
angle at which the ball is played to him, giving you
the most realistic gameplay ever in any 
FIFA game.

Now you can plan your movements before you
receive the ball, ensuring that the opposition’s
defence can’t get anywhere near you. The game’s a
lot less monotonous, because it allows you to bring
variation into your play and lets you try out some
of those cool moves you saw on TV.

Everything about the gameplay has been
improved. Take the AI. I could swear they read your
mind sometimes, because the way they cut your
most disguised ‘through’ ball is just unbelievable.

Another very welcome improvement is the
player’s ball control at the touchline. If the ball has
just deflected off your defender and rolled to a
standstill just on the touchline, you and an

opponent will now race towards it. In 2004, you’d
kick the ball out if you ran at it because of your
momentum. In 2005, however, you have complete
control of the ball in such situations. Players will
even slide and try to keep the ball in play if it’s
rolling out. The game oozes realism, while still
being fun to play. 

Sweet Is The Fruit Of Patience
EA has also put in a whole new Career mode into
2005. This time around, your career lasts fifteen
seasons, instead of just five. There are five different
regions where you can begin your career, each with
its own major leagues.

So England comes under one region, Spain
under another, and so on. You start off at the teams
in the lowest leagues and have to build a
reputation to get a job at a top-level club. You have
to keep winning trophies and your Job Security
meter up.

Whoa, She’s Beautiful!
EA has had the best football title for a long 
time when it comes to graphics, and this time it’s
no different. The graphics are jaw-dropping. 3D
grass, accurate shadows, and the players 
look better than ever. However, audio is the 
one disappointing thing about the game.

One feature in FIFA 2005 that’s both 
realistic and annoying is player retirements. From
age 32 onwards, players start to retire and are
replaced by randomly-generated characters having
their names, skills and looks similar to those
they’re replacing. While this does make the game
more realistic, it also makes it very annoying,
because by the time you have enough managerial
prestige to get into a top club, the best players are
gone! Another irritating feature is the ‘Load Replay’
menu. You can save all the replays you want, but
the menu only lets you see 13 of them.

Basically, there are plenty of ways EA could
have improved FIFA 2005, but that still doesn’t stop
it from being one great game. It really is a must-
buy, especially for FIFA fans who gave up on the
franchise after FIFA 2004. Go get it now!
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FIFA Soccer 2005
Publisher Electronic Arts
Developer EA Canada
Web site www.easports.com/games/fifa2005
System requirements 700 MHz CPU, 256 MB RAM, 32 MB video card,
800 MB free hard disk space, DirectX 9.0b
Distributor Gayatri Impex Pvt Ltd
Price Rs 1,299

Courtesy SKOAR! Magazine
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The game oozes realism, while still being fun to play

2005 realistically simulates your first touch of the ball
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Need For Speed Underground 2
NEED FOR SPEED Underground (NFSU) was a
revolutionary game where you could mod almost
every part of your ride. The game was a little
monotonous because you just won a race,
unlocked stuff, and went to the Customise menu
over and over; NFSU2 throws in a whole city with
five distinct parts that you have to unlock while
following the storyline. You have the freedom to
choose your race and sponsors, you’ve got three
new modes, and many more cool features.

This is the first NFS game driven by a story. The
story picks up from where NFSU ended, depicting
you as a top-dog racer, when suddenly an idiot in
his 4x4 smashes into your ride one night. Once
you’ve recovered from the crash, Samantha (the girl
in NFSU) directs you to Bayview, where you need to
rise up back to the #1 position. Every few races, a
cutscene is played, which leads to the next stage of
the plot. The end objective is to find the person

who totalled your
car and give
him hell.

NFSU2 looks
splendid, and the
night-time races
add to the effect.
The game uses a
tweaked NFSU
engine. Motion
blurs and light
trails have been
fine-tuned to
perfection. The
effects when you
hit the nitrous give
you a sense of
speed hard to find
in any other game.
The cars are exact
replicas of their
real-world
counterparts.

As for those oh-
so-lame crash
effects, the
introduction of a

‘different’ camera angle still can’t make them look
any better. Due to the lack of damage modelling,
the only enjoyment you can get is out of the nice
sounds that shearing metal makes. Overall, the
game isn’t more graphically advanced than NFSU.

Car In The Big City
The races in NFSU2 can be completed in any
order. The city is split into five parts that are
unlocked in stages. Also, instead of a one-stop
modding menu, you need to visit shops scattered
across the city. You need to unlock these shops
by finding them, upon which they’ll be added to
your GPS map. Points where races will take place
are also displayed on the map, but some races
you’ll have to uncover.

The tweaking in itself is pretty exciting.
Almost every car part can be tweaked. Every
fancy addition earns you respect, increasing
the points you get as well the nitrous boost
you have. Your tricked-out car will also get
featured in magazines, earning you cash in
the process.

Basically, the game revolves around you
striking deals with sponsors and fulfilling your
contract. Race modes consist of the legendary
Drag, Circuit, Sprint and Drift races, with a
notable addition being Street X, a combination
of the Circuit and Drift modes. Then there’s the
Time Attack, where you have to complete certain
objectives in the given time.

More Sound Than You Want To Handle
Snoop Dogg’s remix of Riders on the Storm is the
best opening sequence we’ve ever heard. The
other tracks aren’t that good, though. Effects
such as engine sounds, crashes, nitrous boosts,
and various other ambient sounds have been
done extremely well.

Multiplayer in NFSU2 is as simple as it gets—
all single-player modes are available in
multiplayer. The servers are good—you can play
online even with a slow Internet connection (we
used a 33.6 Kbps modem).

The graphics are good, sound effects great,
music OK, but the voice acting needs a lot of
improvement. If you crave the need for speed this
game is definitely for you—it’s worth the money.
Until the next iteration, satisfy your speed
addiction through this game, not in the real
world. Drive safe.

TechCritique
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1. Need For Speed Underground 2
Rs 1,299
Gayatri Impex Pvt Ltd

2. Mafia
Rs 699
E-xpress Interactive Software Pvt Ltd

3. Harry Potter And The Prisoner
Of Azkaban
Rs 1,299
Gayatri Impex Pvt Ltd

4. Constantine
Rs 699
E-xpress Interactive Software Pvt Ltd

5. Grand Theft Auto: Vice City
Rs 1,299
E-xpress Interactive Software Pvt Ltd

The city is split into five parts that are unlocked in stages

Need for Speed Underground 2
Publisher Electronic Arts 
Developer EA Canada
Web site www.needforspeed.com
System requirements 933 MHz CPU, GeForce2, 256 MB RAM, 2 GB
HDD space
Distributor Gayatri Impex
Price Rs 1,299

Courtesy SKOAR! MagazineThe night-time races in NFSU2 are really well done
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Take a Crack 
and Win
Artificial Intelligence A
Modern Approach
By Stuart Russell and 
Peter Norvig
Published by Pearson Education
(Singapore) Pte. Ltd.

WINNER
There was no winner for last
month’s Take A Crack contest.

Rules and Regulations
Readers are requested to send

in their answers by the 15th of the
month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

So you still love FAT32 and
have a huge hard disk...
how would you go about
creating a FAT32 partition
larger than 32 GB on your
disk? Sound impossible?
Write in to
takeacrack@thinkdigit.com
with your solution

We are disappointed to say
that this month, there were
no winners for the ‘Take A
Crack’ contest. Most of those
who responded, sent in only
half the answer. We had
asked you to suggest a way
to disable the context
menu—or right-clicking—on
the entire Desktop, includ-
ing the Start Button,
Taskbar and the System
Tray. Most entries stated the
way to disable the context
menu only on the Desktop.

Anyway, here is the solu-
tion to last month’s problem.

You need to use the Win-

dows registry editor. Start
the registry editor by
going to Start > Run,
typing in “regedit” and
pressing [Enter].

First, navigate to
HKEY_CURRENT _USER\
Software\Microsoft
\Windows\CurrentVer-
sion\Policies\Explorer.
Right-click in the right
pane and create a new
DWORD value. Name
this DWORD key
“NoViewContextMenu”.
Double-click on this
DWORD and set its value to
1. Click ‘OK’. This step will
disable the context menu
for the Desktop.

Next, in the same reg-
istry key as above, again
right-click in the right pane
and create another, new
DWORD value. Name this
DWORD “NoTrayCon-

textMenu”. Double-
click on this DWORD
and set its value to 1.
Click‘OK’. This step
will disable the con-
text menu for the Sys-
tem Tray.

Finally, we’ll dis-
able the context menu
for the Taskbar. To do
this, navigate to

HKEY_CURRENT_ USER\Soft-
ware\Microsoft\Windows
\CurrentVersion\Explorer\
Advanced. Right-click in the
right pane and create a new
DWORD value as before.
Name this DWORD “Taskbar
ContextMenu”. The new
DWORD will have a value of
0—let it remain. That’s it—
you’re done.

Exit the registry editor.
Log Off and then log back
On for the new settings to
take effect. Now try right-
clicking anywhere—you won’t
be able to!

To restore the context
menus, repeat the above
procedures, and simply
change back the values from
0 to 1 and 1 to 0 as necessary.

Create a FAT32
partition
larger than 32 GB
on your hard disk

THIS MONTH’S CHALLENGE

Disable right-clicking anywhere on the DesktopLAST MONTH’S CHALLENGE

Win!

The default Windows XP Desktop

Disable right-clicking on the Taskbar

All steps involve creating a new DWORD value

Disable the context menu on the Desktop and in the System Tray



…That’s Why Digit Is No. 1
I was really very angry when I received my
April issue of Digit. Reason: the DVD
was unusable. Though I’m not a
subscriber, I am definitely a regular
reader. When I had read the DVD
contents in Digit, I was really eager to
lay my hands on the DVD. 

But to my horror, it didn’t work! It
was like separating a mother from her
baby; I tried all sorts of ways to execute
the installers, but no use. The DVD
didn’t have a single file that could run.
I decided I would definitely call Digit
and ask for a replacement. And I did. 

The lady in your Mumbai office
asked my phone number and suggested
I put my complaint on the feedback
section. I did as I was told, but I had
very little hope that I would get
another DVD. 

Two, five, 15 days went by, but
there was no response from your team

and I had lost
hope of
getting
another DVD.
But then came
the turning
point... the
May issue of
Digit, that
carried the
editor’s note
saying
newsstand
buyers, too,
could get a

replacement DVD by simply providing
their Patron Code. 

This was like a hero who rescues
the baby and helps it meet its mother!
Right now, I’m enjoying my DVD. I’m
greatly impressed by the care that 
team Digit takes of its customers, and
this is what makes Digit India’s No. 1
tech magazine!

Rishabh Jha
Vadodara

I was just thinking of sending you back
the DVD shipped with the April ’05
issue, since it did not autorun. I was
surprised to see the new DVD with your
May ’05 issue and your apology note.
Thank you so much for treating all
subscribers at par. You really deserve all
the thanks for it.

Kartik Kamdar
Via E-mail

Dear Rishabh and Kartik,
Nothing gives us greater pleasure than to
know that our efforts are being appreciated
by our readers. You don’t need to thank us
for sending another DVD… it was the least we
could do. Keep reading and let us know what
you think… that’s what helps us improve.

—Executive Editor

Who Moved My Contest?
I don’t know if I am a bit late in
sending this e-mail, but I had to… I also
don’t know whether my mail will be
published, because I am writing
something which concerns the
‘wrongs’ in the magazine. 

I bought my copy on May 7. I was
very happy to read in the magazine
about the Contest Carnival. However, I
was not able to take part (or couldn’t)
till May 9. 

When I finally sat down by May 10,
I entered the exact URL that had
appeared in the magazine in my 
Web browser
http://www.zdnetindia.com/digitcontest. 

A nice and functional page was
ready for me to browse, but it also said
“This Web page has been upgraded”,
and there was nothing in it that
concerned the Contest Carnival.

Let me also tell you that this was
exactly what happened when I tried to
view the results of the February contest
on March 15, as the site during that
contest said that the results would be
declared on March 15.

How could it be upgraded so soon?
But, thanks to Google and Yahoo!,
which opened some related sites, I got
access to the site which had the
February results. I also opened a few
other links provided by the search
engines, but it was of no use.

Finally, I reached the site that was
relating to the May contest. But, I was
surprised to see that the site already
had the winners name for the May
contest itself. 

This happened on May 12. Moreover,
the site was also not ‘/digitcontest’, but
‘/dcnew’ and something else as well!

And all this happens when I was
feeling unsatisfied by the April DVD
problem. I have been a regular reader
for the last nine months was very
satisfied by the software and other
utilities you have always provided. 

And yes, once I read that someone
wrote to you saying you can also
include full versions of old games such
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Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum

ACi laptop on Indiatimes for Rs 2,999

digen
Brainiac
Location: Belgaum
My bro has ordered it for himself. But the
mode of payment he has selected is
DD/Cheque. So, unless the payment is
received they won’t process the order. Maybe
I’ll just wait and see how it goes. Play Safe! I
seriously hope it’s not a typo man. Fingers
crossed, it’s too good to be true.
****************************************
Sourabh
Digitized Flooder
Location: LoSt
Well this thing is really bugging me now! They
called me up day before yesterday from
Gurgaon saying that the real price of the lappy
was Rs 29,990, and there had been a error on
the site so they would have to cancel the order.

I paid them then and there thru my ICICI
bank account, after some of their phone calls
and heavy scolding, they said higher officials
will get back in touch with u. 3 hrs from that
conversation, I got a mail to confirm my
order and shipping address, which I had to
reply to. After that I have seen a change in
my status of product from STATUS—NOT
SHIPPED to the present: 

Now I dunno what’s happening: I still
haven’t got my money back, no phone calls,
also the status in Indiatimes is absurd,
everything is blank so can’t figure out anything.

The error was there for almost 24 hours
and, about 45 guys booked it and still they
didn’t stop the product from being ordered.
Even after this whole deal had been addressed
they still had it on their site for a while for the
same absurd price. 

I feel that all they are doing this for is to
get more visitors on their site and hoping to get
more money from the extra traffic. 

I got a call from them almost 24 hrs after I
had made my payment, also they said that they
would return the money within 10 days to my
ICICI bank account. Does Indiatimes have
problems even for Rs 4k, that they will have to
take 10 days to deposit the money in it again? 
****************************************
go4inet
Resident Techie
Location: Chennai
They have updated their page now. Still there is
an error on their page : MRP: Rs.5,999 
Offer Price: INR: 34,999.00 USD: 795.40 
You Save: -4.8E+2%. Lol!



as the IGI, Max Payne and many
others. You can conduct a poll on
your site and find out whether
people really want them. I know that
probably most of the PC gamers would
have the games I mentioned, but as I
said, there are many other games and
you too, now, give more than 4 GB.

Ayush Dinker
Kanpur

Dear Ayush,
www.zdnetindia.com/digitcontest/

automatically forwards to www.zdnetindia.
com/dcnew/, which is the new address 
of the contest. 

It appears that you logged in at a time
when the pages were being updated, we
apologise for any inconvenience caused to all
our readers due to this.

Another possibility is that your browser
didn’t redirect, as it should, or was showing
older cached pages. To overcome any such
problems, all readers are requested to
empty their browser caches before playing
the contests.

The contest page is up and running, 
and can be accessed by going to
http://www.zdnetindia.com/dcnew/
(http://www.zdnetindia.com/digitcontest
still works as well). 

The contest closes on June 15, 2005, so
hurry up and start playing!

—Executive Editor

Thanks, But No Thanks
To, 
Customer Service,
Hotmail.com
I have the following issues with
Hotmail which need remedial action:

1. I have just 2 MB of storage space
compared to the 2.2 GB that your
competitor offers. This must have been
enough space five years ago, but today,
it seems a bit less. Don’t you agree?

2. Since you have made Outlook 
(POP access) restricted to subscribers
(which the average Indian cannot pay
for), I am stuck with deleting mails on
an hourly basis.

3. Like all my friends, I will have to
migrate to my other e-mail accounts
causing me great inconvenience. If I
were in the US, I would have sued you 
for billions.

Priyank Modi
Was prinks4u@hotmail.com for eight years

Dear Priyank,
We couldn’t agree more. For your
information, Hotmail offers 250 MB to its
North American users. Maybe you could
probably inconvenience yourself once and
switch over to Yahoo! (1 GB) or GMail (2.2 GB
and counting!). 

—Executive Editor

More Registry Tweaks, Please
I have noticed that in the Tips &

Tricks and Q&A sections, there are
many little registry tweaks or hacks. 

My suggestion is to devote one or
two pages of your magazine for a
different section, in which, you can
present some registry tweaks and
continue it in every issue. In fact, at
least 10 registry tweaks per issue 
would be great. 

You could also include only the
most useful ones to control space. Else,
you can use this as a topic for your
upcoming Fast Track book. 

Continue with your excellent work,
and hats off to the Digit team!

Shashank Rawoorkar 
Via E-mail

Dear Shashank,
That’s an excellent suggestion. We will
definitely try to implement it either in the
magazine or in the form of the book soon.
Why don’t you write in and let us know exactly
what you would like to see in this book?

—Executive Editor

Corrigendum
In the April 2005 issue of Digit, the
contact details of Esource Global in the
Motorola MPx review (page 56) were
incorrect. The correct contact number
for Esource Global is 9820822205. 
You may also visit their Web site at
www.esourceglobal.com. The error 
is regretted.

—Executive Editor

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages.
Letters may be edited for clarity.

For subscription queries, call the Help Desk at 
022-27629191/9200, Fax 022-27629224, or 
send an e-mail to help@jasubhai.com
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An Apple A Day...
First up, let me congratulate you for
bringing out yet another excellent
issue of Digit. Your article on the
future of inkjet printers was
especially praiseworthy.

However, I have a gripe. Your
coverage of Apple Mac OSX 10.4 Tiger
was treated as very inconsequential
in the computing world.

As you already
know, Tiger is the
most advanced OS
in the world with
features that won’t
even be present
in Windows’
upcoming Longhorn
operating system. 

In India, people do not have any
idea of the Mac platform and its
advantages. The release of Tiger
gives a great opportunity to bring to
the fore the advantages of this
platform. In my opinion, there
should have been a full story
dedicated to Tiger.

Moreover, people are also
discouraged to try out the Mac
platform by your magazine, which I
find very stupid.

In your Agent 001 section, Vinay
Anand has been advised to purchase
a Windows-based PC for high-end
multimedia applications;
something for which Macs have
been traditionally famous for.
Agent 001 also mentions that
Mac OSX is not popular with
developers and that “very few
professional applications are
available for Mac OSes”.

This kind of advice reinforces
the mindset that the MAC platform
is application-starved, which is
untrue, as all major applications
are supported. In the case of
some minor applications, some
are supported while there are
alternatives for others.

I have been using an Apple iBook
for the past one year and have not
felt deprived of any software
available for my PC counterparts.

While being a magazine of such
repute, you have given voice to a
rumour that is untrue.

Dr Sudeep Bansal
Via e-mail

Letter 

of the

Month
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Hotmail.com still offers a paltry 2 MB of free storage space



People And Events That Grabbed Headlines—For Better Or For Worse

Would you have
cybersex with
someone you met

through an online dating site?
Would you go on a date with
someone you met through a
cybersex chat room? HighJoy is
betting you will.

HighJoy is a fusion of a
dating database, a proprietary
chat client, and ‘teledildonics’—
the integration of telepresence
with sex.

Amir Vatan, CEO, describes
the company as something
between AdultFriendFinder
and Match.com. He sees
HighJoy as the logical next
step for those who enjoy
making connections online.
Now that we’re used to the
idea of meeting people

through personal profiles and
Internet communities, “people
are looking for an increased
level of interaction,” he says.

Members fill out profiles, in
varying degrees of detail. You
can search the database by
characteristic or member name,
contact people through
anonymous e-mail and have
private chats. A favourites list
lets you keep track of people
you’re most intrigued by.

And, of course, you can
invite someone to control
your vibrator while you
control theirs. 

For the monogamous,
HighJoy offers a ‘one-on-one’
membership that lets you sign
on to chat privately with each
other and control each other’s

sex toys, without access to the
community rooms and
profiles. You can’t contact
people through their profiles,
and they can’t see yours.

Seriously, this idea—
“something between
AdultFriendFinder and
Match.com”—strikes us as a
good idea, and as a sign of
the times.

An Australian
undertaker is offering a
hearse with its own

mini-bar, DVD player and
coffee maker. It is fitted with
chrome handrails, tinted
windows, pop-out cup holders
and atmospheric lighting.

The mint green hearse
can hold up to 12 mourners
and a coffin, reports The
Sydney Morning Herald.

Martin Tobin, of Tobin
Brothers Funeral in
Melbourne, said: “We already
know that this will not be for
everyone, and we are not
saying that this is the only
way to have a funeral.

“But for those who want
to be together and travel with
the deceased, particularly
those with large families, it is
a good option for them.”

The family funeral bus
costs £400 (Rs 32,600).

What’s with all these
funeral gadgets coming out
these days? Earlier, in this
space, we spoke about a
German inventor’s tasteless
invention that lets you talk to
the dead—a gadget you bury
in the ground along with the
body so you can call up the
body and speak to it.

And now this! Imagine
people dressed all in black,
sipping Foster’s and watching
their favourite DVDs in
between sniffles. Whatever
happened to good old-
fashioned mourning?

AWeb site is offering a
selection of products
celebrating the “Carly

Fiorina Years”. The items
available at www.cafepress.
com/carly_survivor include
mugs, shirts and other
paraphernalia, and carry the
logo “I survived the Carly
Fiorina Years”.

The site says the items
commemorate “your
survival, or not, through

Carly’s tenure as CEO” and let
you tell the world all about it.
Was she all that bad?!

Apparently. Some readers
might recall that Fiorina was a
controversial figure at HP,
partly because of the abrasive
manner in which the takeover
of Compaq was fought in 2001
and 2002. As a matter of fact,
HP shares rose 7.5 per cent
after the news of Fiorina’s
stepping down!
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4 Years Of Tech

Parents looking for a
punishment for their
wayward teens, which

does not involve beating or
locking them in the wardrobe,
should consider confiscating
their mobile phones: a study
by a South Korean advertising
firm shows that a mobile is a
Korean teenager’s most prized
possession, and that taking
them away from them is a bit
like social castration.

The Cheil Communications
survey found that of 13- to
15-year-olds, 77.5 per cent said
a mobile phone was a ‘must-
have’ item, while for those
aged 16 to 18, the figure
was 76.7 per cent, the
survey showed.

The survey indicated that
teens felt helpless without
their mobile, thus taking it
away from them would be a
really good punishment.

Yank That Cell Away

DVD For The
Mourners!

Was Carly all that bad?

HighJoy—very adult, very “with it” 

They Survived
Carly Fiorina!

Toying With Cybersex

Tabloid Tech




